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Safety Instructions

Safety Instructions • English

WARNING:	 This symbol, , when used on the product, is intended to 
alert the user of the presence of uninsulated dangerous voltage within 
the product’s enclosure that may present a risk of electric shock.

ATTENTION: This symbol, , when used on the product, is intended 
to alert the user of important operating and maintenance (servicing) 
instructions in the literature provided with the equipment.

For information on safety guidelines, regulatory compliances, EMI/EMF 
compatibility, accessibility, and related topics, see the Extron Safety and 
Regulatory Compliance Guide, part number 68-290-01, on the Extron 
website, www.extron.com.

Instructions de sécurité • Français

avertissement:	 Ce pictogramme, , lorsqu’il est utilisé sur le 
produit, signale à l’utilisateur la présence à l’intérieur du boîtier 
du produit d’une tension électrique dangereuse susceptible de 
provoquer un choc électrique.

attention:  Ce pictogramme, , lorsqu’il est utilisé sur le produit, 
signale à l’utilisateur des instructions d’utilisation ou de maintenance 
importantes qui se trouvent dans la documentation fournie avec le 
matériel.

Pour en savoir plus sur les règles de sécurité, la conformité à la 
réglementation, la compatibilité EMI/EMF, l’accessibilité, et autres sujets 
connexes, lisez les informations de sécurité et de conformité Extron,  
réf. 68-290-01, sur le site Extron, www.extron.fr.

Sicherheitsanweisungen • Deutsch

warnung:	 Dieses Symbol  auf dem Produkt soll den Benutzer 
darauf aufmerksam machen, dass im Inneren des Gehäuses dieses 
Produktes gefährliche Spannungen herrschen, die nicht isoliert sind 
und die einen elektrischen Schlag verursachen können.

Vorsicht:  Dieses Symbol  auf dem Produkt soll dem Benutzer in 
der im Lieferumfang enthaltenen Dokumentation besonders wichtige 
Hinweise zur Bedienung und Wartung (Instandhaltung) geben.

Weitere Informationen über die Sicherheitsrichtlinien, Produkthandhabung,  
EMI/EMF-Kompatibilität, Zugänglichkeit und verwandte Themen finden Sie in 
den Extron-Richtlinien für Sicherheit und Handhabung  (Artikelnummer  
68-290-01) auf der Extron-Website, www.extron.de.

Instrucciones de seguridad • Español

ADVERTENCIA:	 Este símbolo, , cuando se utiliza en el producto, 
avisa al usuario de la presencia de voltaje peligroso sin aislar dentro 
del producto, lo que puede representar un riesgo de descarga 
eléctrica.

ATENCIÓN:  Este símbolo, , cuando se utiliza en el producto, avisa 
al usuario de la presencia de importantes instrucciones de uso 
y mantenimiento recogidas en la documentación proporcionada 
con el equipo.

Para obtener información sobre directrices de seguridad, cumplimiento 
de normativas,  compatibilidad electromagnética, accesibilidad y temas 
relacionados, consulte la  Guía de cumplimiento de normativas y seguridad 
de Extron, referencia 68-290-01, en el sitio Web de Extron, www.extron.es.

Chinese Simplified（简体中文）

警告： 产品上的这个标志意在警告用户该产品机壳内有暴露的危险 

电压，有触电危险。

注意： 产品 上 的 这个标 志意在 提 示用户设备 随 附的用户手 册 中有 
重要的操作和维护(维修）说明。

关于我们产品的安全指南、遵循的规范、EMI/EMF 的兼容性、无障碍 

使用的特性等相关内容，敬请访问 Extron 网站 www.extron.com，参见 Extron  

安全规范指南，产品编号 68-290-01。

Chinese Traditional（繁體中文）

警告: 若產品上使用此符號，是為了提醒使用者，產品機殼內存在著 

可能會導致觸電之風險的未絕緣危險電壓。

注意	  若產品上使用此符號，是為了提醒使用者。

有關安全性指導方針、法規遵守、EMI/EMF 相容性、存取範圍和相關主題的詳細
資訊，請瀏覽 Extron 網站：www.extron.com，然後參閱《Extron 安全性與法

規遵守手冊》，準則編號 68-290-01。

Japanese

警告: この記号  が製品上に表示されている場合は、筐体内に絶縁されて 
  いない高電圧が流れ、感電の危険があることを示しています。

注意:	この記号  が製品上に表示されている場合は、本機の取扱説明書に	
	 記載されている重要な操作と保守(整備)の指示についてユーザーの

	 	 注意を喚起するものです。

安全上のご注意、法規厳守、EMI/EMF適合性、その他の関連項目に  
ついては、エクストロンのウェブサイトwww.extron.comより  

『Extron Safety and Regulatory Compliance Guide』 (P/N 68-290-01) をご覧ください。

Korean

경고:    이 기호 , 가 제품에 사용될 경우, 제품의 인클로저 내에 있는 
접지되지 않은 위험한 전류로 인해 사용자가 감전될 위험이 있음을 
경고합니다.

주의:     이 기호 , 가 제품에 사용될 경우, 장비와 함께 제공된 책자에 나와 
있는 주요 운영 및 유지보수(정비) 지침을 경고합니다.

안전 가이드라인, 규제 준수, EMI/EMF 호환성, 접근성, 그리고 관련 
항목에 대한 자세한 내용은 Extron 웹 사이트(www.extron.com)의 
Extron 안전 및 규제 준수 안내서, 68-290-01 조항을 참조하십시오. 

www.extron.fr
www.extron.de
www.extron.es


FCC Class A Notice
This equipment has been tested and found to comply with the limits for a Class A digital 
device, pursuant to part 15 of the FCC rules. The Class A limits provide reasonable 
protection against harmful interference when the equipment is operated in a commercial 
environment. This equipment generates, uses, and can radiate radio frequency energy and, 
if not installed and used in accordance with the instruction manual, may cause harmful 
interference to radio communications. Operation of this equipment in a residential area is 
likely to cause interference; the user must correct the interference at his own expense.

NOTE:	 This unit was tested with shielded I/O cables on the peripheral devices. Shielded 
cables must be used to ensure compliance with FCC emissions limits.

For more information on safety guidelines, regulatory compliances,  
EMI/EMF compatibility, accessibility, and related topics, see the “Extron Safety and 
Regulatory Compliance Guide” on the Extron website.

Specifications Availability
Product specifications are available on the Extron website, www.extron.com.

http://media.extron.com/download/files/userman/Safety-Compliances_68-290-01_I_012609.pdf
http://media.extron.com/download/files/userman/Safety-Compliances_68-290-01_I_012609.pdf
http://www/extron.com


Conventions Used in this Guide

Notifications the following are used:

DANGER:	 A danger indicates a situation that will result in death or severe injury. 

WARNING:	 A warning indicates a situation that has the potential to result in death or 
severe injury. 

CAUTION:	 A caution indicates a situation that may result in minor injury.

ATTENTION:	 Attention indicates a situation that may damage or destroy the product or 
associated equipment. 

NOTE:	 A note draws attention to important information.

TIP:	 A tip provides a suggestion to make working with the application easier.

Software Commands
Commands are written in the fonts shown here: 

^AR Merge Scene,,Op1 scene 1,1 ̂ B 51 ̂ W^C

[01] R 0004 00300 00400 00800 00600 [02] 35 [17] [03]

E X! *X1&* X2)* X2#* X2! CE}

NOTE:	 For commands and examples of computer or device responses mentioned 
in this guide, the character “0” is used for the number zero and “O” represents the 
capital letter “o.”

Computer responses and directory paths that do not have variables are written in the font 
shown here: 

Reply from 208.132.180.48: bytes=32 times=2ms TTL=32

C:\Program Files\Extron

Variables are written in slanted form as shown here:
ping xxx.xxx.xxx.xxx —t

SOH R Data STX Command ETB ETX

Selectable items, such as menu names, menu options, buttons, tabs, and field names are 
written in the font shown here:

From the File menu, select New.
Click the OK button.

Copyright
© 2012  Extron Electronics. All rights reserved.

Trademarks
All trademarks mentioned in this guide are the properties of their respective owners.
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Introduction 

This section describes this manual and the DMP 128, including:

•	 About This Manual

•	 About the DMP 128 Digital Matrix Processor

•	 Features

About This Manual
This manual contains installation, configuration, and operating information for the 
Extron Electronics DMP 128 ProDSP™ Digital Matrix Processor, software controlled digital 
audio processor. 

In this manual, the DMP 128 may also be referred to as “the mixer” or “device.”

About the DMP 128 Digital Matrix Processor
The Extron DMP 128 Digital Matrix Processor is a 12x8 audio mixer featuring 
Extron ProDSP, automixing, and I/O expansion capabilities, and is available with 
AEC - acoustic echo cancellation. The DMP 128 offers a configuration approach to DSP in 
order to simplify mixing, routing, conferencing, and room optimization. Quick and intuitive 
configuration using the DSP Configurator™ Software allows the DMP 128 to be installed in 
very little time, with easy-to-learn adjustments that can be heard in real-time. A digital audio 
expansion port allows two DMP 128 units to be linked together to expand input and output 
signal management and routing capabilities. The DMP 128 is ideal for presentation and 
conferencing applications in boardrooms, courtrooms, and conference centers that require 
advanced matrix mixing with DSP. 

The DMP 128 has no front panel controls. All configuration is performed using the 
Extron DSP Configurator™ program from a host computer via any of the communication 
ports, RS-232, USB or Ethernet (high-speed ports recommended). Signal presence and clip 
LEDs for the twelve input channels and eight output channels are on the front panel.

Features
•	 Two models with 12 mic/line inputs and 8 outputs:

•	 12x8 ProDSP processor

•	 12x8 ProDSP processor with AEC

•	 Inputs �— Twelve balanced or unbalanced mic/line level on 3.5 mm, 3-pole and 6-pole 
captive screw connectors

•	 Outputs �— Eight balanced or unbalanced line level on 3.5 mm, 6-pole captive screw 
connectors

•	 Eight channels of acoustic echo cancellation (AEC) �— The DMP 128 C models 
include eight independent channels of high performance AEC, as well as selectable 
noise cancellation. Extron AEC features advanced algorithms that deliver fast echo 
canceler convergence for optimal intelligibility in situations that challenge AEC 
performance, including double-talk, and the use of wireless microphones at the near 
end.
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•	 Digital audio expansion port for linking two DMP 128 units �— An expansion 
port allows any two DMP 128 models to be linked together via a single shielded 
CAT 6 cable. This allows eight matrix mixes of the inputs, plus eight virtual paths to be 
sent and received between units.

•	 Automixer with eight gate groups �— The DMP 128 features an automixer with 
advanced features for managing signal levels from multiple microphones. The 
automixer includes a gating mode that automatically gates channels on or off, as well 
as a gain sharing mode that maintains the overall system gain based on the number 
of active mics.

•	 ProDSP™ audio signal processing �— The DMP 128 features 32/64-bit floating 
point audio DSP processing, which maintains very wide dynamic range and audio 
signal transparency, to simplify management of gain staging while reducing the 
possibility of DSP signal clipping. 

•	 48 volt phantom power �— The DMP 128 is equipped with selectable 48 volt 
phantom power for the first eight inputs, allowing the use of condenser microphones.

•	 Studio grade 24-bit/48 kHz analog-to-digital and digital-to-analog converters 
�— Professional converters fully preserve the integrity of the original audio signal.

•	 Fixed, low latency DSP processing �— Input to output latency is low within 
the DMP 128 and stays constant, regardless of the number of active channels or 
processes. While latency increases marginally on channels with AEC enabled, overall 
latency remains low. Fixed latency processing keeps audio in sync with video, and 
prevents distractions to presenters or performers resulting from delayed live audio.

•	 DSP Configurator™ Software �— A powerful yet user-friendly PC-based software 
tool for managing all audio operations of the DMP 128. It enables complete setup 
and configuration of digital audio processing tools on the ProDSP platform, as well as 
routing and mixing. 

•	 Intuitive Graphical User Environment �— The DSP Configurator Software features 
a Graphical User Environment that offers a clear view of all input and outputs, audio 
processing blocks, routing, mix-points, and virtual routing in a single screen. This 
allows a designer or installer to quickly view an audio configuration without having to 
access multiple dialog boxes or menus.

•	 Device Manager enables configuration of multiple Extron DSP products 
�— Device Manager in the DSP Configurator Software enables easy configuration of 
multiple Extron DSP products, including two linked DMP 128 processors, by toggling 
between Graphical User Environments for each unit. Processors can be grouped into 
folders for organizing as separate rooms or buildings. Settings for multiple Extron DSP 
products in Device Manager can be saved to a single file.

•	 Flexible control options �— The DMP 128 can be controlled using the DSP 
Configurator Software and a PC connection to the Ethernet port, the RS-232 serial 
port, or the USB 2.0 port on the front panel. The DMP 128 can also be controlled 
through a control system with Extron SIS™ - Simple Instruction Set commands, and 
by accessing the internal Web pages.

•	 Copy and paste for processing blocks �— To help speed audio system design 
and setup, parameter settings can be quickly copied between individual processing 
blocks or identical groups of blocks within the Graphical User Environment, using 
conventional cut-and-paste commands. 

•	 Building Blocks processor settings �— A collection of pre-designed processor 
settings optimized for a specific type of input or output device, such as microphones 
and Extron speakers, with preset levels, filters, dynamics, and more. Flexible Building 
Blocks are available on each I/O strip and allow system designers to fully customize 
and save their own Building Blocks, further streamlining audio system design and 
integration.
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•	 Live and Emulate operation modes with configuration file saving �— Live 
mode allows integrators to connect to the DMP 128 and make live parameter 
adjustments while hearing or metering them in real-time. This avoids the need to 
compile and upload a configuration file to the DSP. Emulation mode allows settings to 
be configured offline, then uploaded to the DMP 128. The software also downloads 
configuration files from the mixer for archiving. Settings for two DMP 128 processors 
linked together can be saved to a single configuration file.

•	 32 DSP Configurator presets �— Using the DSP Configurator Software, any 
parameters for DSP processing, levels, or audio routing can be saved as presets. 
These settings can be saved for the entire system, or any selected group of inputs, 
outputs, mix-points, and DSP blocks. 

•	 20 digital I/O ports for remote control or feedback �— Twenty configurable digital 
I/O ports are provided, so that the DMP 128 can be programmed to sense and then 
respond to external triggers such as mic activation, muting, and recall of presets.

•	 Triple matrix design provides output, virtual, and expansion routing options �— 
Employs a triple matrix design that offers substantial flexibility in routing, mixing, and 
processing audio input sources. An output matrix allows any of the twelve inputs to 
be mixed to any or all eight outputs. If desired, any of the inputs can first be directed 
into a virtual matrix, which routes the inputs to eight virtual buses, before being mixed 
back into the output matrix. Virtual buses allow inputs to be processed together as 
a group. When two DMP 128 processors are linked together via the expansion ports 
over shielded CAT 6 cable, inputs and virtual buses of one unit can be routed to the 
other processor through an expansion matrix, for additional processing or matrix 
mixing into the outputs.

•	 Group masters �— The DMP 128 provides the capability to consolidate gain or mute 
control throughout the system. Gain or mute controls can be selected and added to a 
group master, which can then be controlled by a single master fader or mute control. 
Each group master can have up to 16 members, and up to 32 group masters can be 
created.

•	 Soft limits provide optimal group master adjustment range �— The group 
master volume range can be limited using soft limits to maintain optimal minimum 
and maximum levels when using external volume control. This prevents operators 
from over or under-adjusting levels when using digital I/O or RS-232 control. The DSP 
Configurator Software provides quick drag-and-drop adjustment of soft limits from the 
Group Controls screen.

•	 SpeedNav™ keyboard navigation �— SpeedNav enables user-friendly, keyboard-
based navigation of the DSP Configurator Software without the need for a mouse 
or touchpad. Using keyboard navigation keys and shortcuts, the user can access 
any input or output, mix-point, and all audio DSP tools. Using only the keyboard for 
software access can help expedite audio system setup and optimization while on-site 
using laptop PCs.

•	 Front panel input and output signal presence and clipping LEDs �— The 
DMP 128 provides LEDs on the front panel for each input and output, for real-time 
monitoring of signal presence. A separate LED illuminates as a warning whenever 
analog signal clipping is detected.

•	 Front panel USB configuration port �— Enables easy configuration without having 
to access the rear panel of the processor.

•	 Ethernet monitoring and control �— Engineered to meet the needs of professional 
AV environments, Ethernet control enables the DMP 128 to be proactively monitored 
and managed over a LAN, WAN, or the Internet, using standard TCP/IP protocols.

•	 Rack-mountable �— 1U, full rack width metal enclosure
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DMP 128 Application Diagram
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Installation 

This section describes the installation of the DMP 128, including:

•	 Mounting the DMP 128

•	 DMP 128 Models

•	 Rear Panel Features and Cabling

Mounting the DMP 128
The 1U high, full rack width, 8.5 inch deep DMP 128 Digital Matrix Processor can be:

•	 Set on a table, 

•	 Mounted on a rack shelf, 

•	 Mounted under a desk or tabletop.

For detailed mounting options and UL rack mounting guidelines, (see 
“Mounting the DMP 128” on page 153).

DMP 128 Models
There are currently two models of the DMP 128 available. Each model has a different 
feature set for various applications.

DMP 128 Model Matrix

The following feature matrix provides a breakdown of the various DMP 128 model 
variations. Where differences occur in operation, they are noted in the text.

Model Description

DMP 128 DMP 128

DMP 128 C DMP 128 with AEC
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Rear Panel Features and Cabling
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Figure 1. DMP 128 Rear Panel

a	 Power connector — IEC power connector 100 - 240 VAC, 50 - 60 Hz

b	 Phantom Power indicators — Green LEDs light when +48 V phantom power is 
placed on the corresponding mic/line input. Phantom power voltage is not adjustable 
and is only available to Mic inputs 1-8.

ATTENTION:	

•	 Condenser mics require phantom power. Dynamic mics do not require 
power. 

•	 Never set a dynamic mic to 48 V. Doing so may damage the mic. For 
condenser mics, verify the mic will operate safely at 48 VDC.

c	 Mic/Line 1-8 input connectors — Eight 3-pole 3.5 mm captive screw connectors 
accept balanced or unbalanced mono mic or line level signals. Mic/line inputs provide 
gain settings to accommodate consumer (–10 dBV) and professional (+ 4 dBu) 
operating line level sources, plus mic level sources. Up to eight mono mics or line 
inputs, balanced and unbalanced in any combination may be connected to these 
inputs. See the following diagram for wiring instructions.

Audio Output Wiring

Audio Input Wiring

Unbalanced Output

Tip

Sleeve
NO Ground Here

Balanced Output

Tip

Sleeve
Ring

Unbalanced Input

Tip
Sleeve

Balanced Input

Tip

Sleeve
Ring

Figure 2. Balanced or Unbalanced Mic and Line Input Wiring

d	 Mic/Line 9-12 input connectors — Four 6-pole 3.5 mm captive screw connectors 
accept balanced or unbalanced mono mic or line level signals. Mic/line inputs provide 
gain settings to accommodate consumer (–10 dBV) and professional (+ 4 dBu) 
operating line level sources, plus mic level sources. Up to four mono mics or line 
inputs (or two stereo line inputs), balanced and unbalanced in any combination may 
be connected to these inputs. 

e	 Mono output connectors — Four 6-pole 3.5 mm captive screw connectors provide 
up to eight balanced or unbalanced connections for mono line level output signals.Audio Output Wiring

Audio Input Wiring

Unbalanced Output

Tip

Sleeve
NO Ground Here

Balanced Output

Tip

Sleeve
Ring

Unbalanced Input

Tip
Sleeve

Balanced Input

Tip

Sleeve
Ring

ATTENTION:	 Connect the sleeve to ground ( ). Connecting the sleeve only to 
a negative (–) terminal will damage the audio output circuits.

Figure 3. Output Connector Wiring

 

DMP 128 • Installation 6



f	 Digital I/O output connectors — Four 6-pole 3.5 mm captive screw connectors 
each provide five configurable digital input or output ports allowing connection of up 
to twenty various devices such as motion detectors, alarms, lights, LEDs, buttons, 
photo (light) sensors, temperature sensors, and other devices. 

Digital I/O ports are used to monitor or drive TTL level digital signals. The inputs 
can be configured to operate in one of two modes: digital input or digital output. 
In OUTPUT mode, the device can source up to 250 mA at +5 V. In input mode, 
voltages greater than 1 V indicate a logic ‘high’ signal while voltages less than 1 V 
indicate a logic ‘low’.

All digital I/O ports are tied to a common ground (one common ground for each 
6-pole connector), but can be individually configured to operate in one of two modes: 
digital input or digital output 

NOTE:	 These ports can be configured via the DSP Configurator (see 
“Digital I/O Ports” on page 88).

Do not tin the wires!

(5 mm) MAX. 3 "
16  

1
2
3
4
5

Digital I/O Wiring
Figure 4. Digital I/O Wiring

g	 RS-232 connector — One 3-pole 3.5 mm captive screw connector, labeled RS-232, 
for bi-directional RS-232 (±5 V) serial control. Default baud rate is 38400. The RS-232 
port is not intended to be used for configuring the DMP 128.

Receive (Rx)
Transmit (Tx)

Ground (G)

Bidirectional

RS-232
Device

Ground (    )
Receive (Rx)
Transmit (Tx)

RxTx G

G

Do not tin
the wires!

Figure 5. RS-232 Wiring

h	 EXP port connector — One RJ45 jack for one additional DMP 128 connection.

RESET

DMP 128
Digital Matrix
Processor

LANEXP

Figure 6. EXP and LAN Connections

i	 LAN (RJ-45) connector — A standard RJ-45 jack (see above) accepts an RJ-45 
plug for Ethernet connection.

•	 A yellow (ACT) LED indicates data activity on the connection.

•	 A green (Link) LED indicates the jack is connected properly to the network. 
See “SIS Programming and Control” on page 113 for additional information 
on Ethernet cabling.

NOTE:	 A one foot shielded CAT 6 
cable is provided for the EXP 
connection.
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j	 Reset button and LED indicator — The reset button (see figure 6 on previous 
page) is used to return the DMP 128 to different tiers of default states and to place 
the unit into an event recording mode for troubleshooting. The LED flashes to signify 
the different tiers (see “DMP 128 Hardware Reset Modes” on page 152).

USB Configuration Port (Front Panel)
A front panel configuration port uses an Extron USB A Male to USB Mini B Male 
Configuration Cable, 26-654-06 for connection to a PC computer via the USB port. For 
USB driver installation details, see “Installing the USB Driver” on page 17 .

 

DMP 128 • Installation 8



Hardware Operation

This section describes the hardware operation of the DMP 128, including:

•	 DMP 128 Operation

•	 Front Panel Operation

•	 Rear Panel Operation

DMP 128 Operation
The DMP 128 does not have physical controls for configuration or operation. Both are 
accomplished using a PC running Windows XP or better and the DSP Configurator 
software (available on the included disc or at www.extron.com), an embedded web 
page using Windows Internet Explorer, or the Extron Simple Instruction Set (SIS™) using 
hyper‑terminal, DataViewer, or a control system. 

The DMP 128 has several front and rear panel operational indicators and a rear panel 
reset button for hardware resets outlined in the following pages.
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Front Panel Operation

DMP 128
DIGITAL MATRIX PROCESSOR

CONFIG

1 2 3 4 5 6 7 8 9 10 11 12

CLIP

SIGNAL

INPUTS
1 2 3 4 5 6 7 8

CLIP

EXP LAN SIGNAL

OUTPUTS

ACTIVITY

b d ea Ñ Ö

Figure 7.	 DMP 128 Front Panel

a	 Power LED — The power indicator blinks during power-up and lights solid when the 
DMP 128 is operational. 

b	 USB configuration connector — The USB 2.0 port uses a mini type-B connector 
to connect to a host computer for control. The DMP 128 USB driver must be installed 
prior to using the port (see “Installing the USB Driver” on page 17). 

NOTE:	 The DMP 128 appears as a USB peripheral with bi-directional 
communication. The USB connection can be used for software operation (see 
“Windows-based Program Control” on page 15), and SIS control (see 
“SIS Programming and Control” on page 113).

c	 Activity Indicators — Two green LEDs labeled EXP (Ñ) for the expansion audio port 
and LAN (Ö) for the standard Ethernet port

Ñ  OFF — Unit is not connected to a second DMP 128.

ON — Unit is connected to another DMP 128 and is currently configured as the 
primary unit.

BLINKING — Unit is connected to another DMP 128 and is currently configured 
as the secondary unit.

Ö	 Indicates activity on the corresponding rear panel Ethernet RJ-45 connections. 

d	 Input Indicators — Stacked red (signal clipping) and green (signal present) LEDs for 
inputs 1 through 12 . Each stack represents one input channel.

The green signal LED varies in brightness corresponding to the real-time input signal 
level. It begins to light at – 60 dBFS increasing in steps to full intensity as the signal 
level increases. When the signal reaches – 3 dBFS or above, the red clipping LED 
lights and remains lit as long as the signal remains above – 3 dBFS. When it falls 
below that level, the red LED remains lit for 200 milliseconds, after which the display 
resumes real‑time monitoring of the signal level.

e	 Output Indicators — Stacked red (signal clipping) and green (signal present) LEDs 
for outputs 1 through 8. Each LED stack represents one output channel.

The green signal LED varies in brightness corresponding to the output signal level. It 
begins to light at – 60 dBFS increasing to full intensity corresponding to signal level 
increases. When the signal level reaches – 3 dBFS or above, the red clipping LED 
lights and remains lit as long as the signal remains above – 3 dBFS. When it falls 
below that level, the red LED remains lit for 200 milliseconds, after which the display 
resumes real‑time monitoring of the signal level.
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Figure 8.	 DMP 128 Rear Panel

Rear Panel Operation

a c d e f g	 See “Rear Panel Features and Cabling” on page 6 for details.

b	 Phantom Power indicators (MIC +48V) — These green LED indicators light when 
+48 V phantom power is placed on the corresponding mic/line input. Phantom power 
voltage is not adjustable and is available only on inputs 1 – 8.

ATTENTION:	

•	 Condenser microphones require phantom power.  
Dynamic microphones do not require power.  
Never set an unbalanced dynamic microphone to +48V. Doing so may 
damage the microphone. 

•	 For condenser microphones, verify it will safely operate at +48 VDC.

•	 When a line level source is connected, be certain the +48V phantom 
power is off (cleared).

h	 EXP — The EXP connector has a green LED to indicate proper connection to an 
active expansion network and a yellow LED that blinks to indicate data activity.

i	 LAN — The LAN connector has a green LED to indicate proper connection to an 
active LAN and a yellow LED that blinks to indicate data activity.

j	 Reset and Power/Reset LED — The reset actuator initiates system resets (see 
“Reset Actuator and LED” on page 12) . The green LED indicator adjacent to the 
reset button duplicates the front panel LED operation.

Power Cycle
Current mixing and audio processor settings (the current state of the device) are saved in 
nonvolatile memory. When the unit is powered off, all settings are retained. When the unit 
is powered back on, it recalls settings from the nonvolatile memory. If a configuration was 
in process during the power down, the saved mix, audio level, and audio DSP processor 
settings become active.

On power up the unit performs a self-test. The front power indicator LED flashes during 
the test, then lights solid when the unit is available for operation or programming. 

Firmware Updates
The firmware of the DMP 128 can be updated through an Ethernet, USB, or RS-232 
connection. The user can obtain new firmware from the Extron website, or from an 
Extron Applications Engineer via e-mail. After obtaining the new firmware, upload it to 
the unit via the served web pages (see “HTML Operation” on page 137), using the 
Firmware Loader launched from the DSP Configurator program (see “DMP Software” 
on page 14), or using the Extron standalone Firmware Loader software application 
available on the included disc or at www.extron.com.
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Reset Actuator and LED
A recessed button on the rear panel initiates several reset modes. The rear panel LED 
blinks to indicate the reset mode. 

100-240 ~ 0.6A

RESET

LAN

3

7

2

6

1

5

MIC/LINE INPUTS

Tx Rx

RS-232

DIGITAL I/O

1 2 3   4    5

MIC
+48V

1 32
DMP 128
Digital Matrix
Processor

EXP

50/60 HZ

4

8

4

5 76 8

9 10

11 12

6 7 8   9  10

11 12  13  14  15 16  17 18  19  20

O
U
T
P
U
T
S

21 3 4

65 7 8

j

Rear Panel

Figure 9.	 Reset Button and LED

Hardware Reset Modes:

NOTE:	 The reset modes listed below will close all open IP and Telnet connections, 
and close all sockets. 

With power on, when the reset button is held down, every three seconds the rear panel 
LED will pulse (blink). At the first blink Mode 3 is available, at the second blink Mode 4 is 
available and the third blink indicates Mode 5 is available. The reset modes have separate 
and distinct functions outlined below (see “DMP 128 Hardware Reset Modes” on 
page 152). 

MODE 1 — Firmware reset:  Disconnect power to the DMP 128. Press and hold the 
reset button while applying power to return the firmware to the version shipped with the 
unit from the factory. Event scripting will not start when powered on in this mode. This 
allows recovering a unit with incorrect or corrupt firmware. 

All user files and settings are maintained. Some user web pages may not work correctly if 
returning the unit to an earlier firmware release.

MODE 3 — Events reset:  With power on, press and hold the reset button until the reset 
LED blinks once (~3 seconds). Release the reset button, then within one (1) second press 
it again to toggle events On or Off, depending on the current state. 
If the event logging is currently stopped, following the momentary (<1 sec.) press, the 
reset LED will flash twice indicating events logging has begun.

If any events are currently running, following the momentary (<1 sec.) press, the reset LED 
will flash three times indicating the events logging has stopped. 

Each flash will last for 0.25 seconds. If the second momentary press does not occur 
within 1 second, Mode 3 is exited.

MODE 4 — IP Address reset:  With power on, press and hold the reset button about 
6 seconds until the reset LED blinks twice. Release the reset button, then within 1 
second, press it again to reset the IP settings. 

Mode 4 will:

•	 Enable ARP program capability

•	 Set IP back to factory default IP address (192.168.254.254)

•	 Set Subnet back to factory default (255.255.0.0)

•	 Set Gateway back to factory default (0.0.0.0)

•	 Set Digital I/O Port mapping back to factory default

•	 Turn DHCP off

•	 Turn events off

If a second momentary press does not occur within 1 second, the reset will be ignored.
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MODE 5 — Factory default reset:  With power on, press and hold the reset button 
until the reset LED blinks 3 times (~9 seconds). Release then momentarily (<1 second) 
press the reset button to return the DMP 128 to factory default conditions. If the second 
momentary press does not occur within 1 second, the reset is exited. 

The default (reset) state of the device is:

•	 All mix‑points are set to 0 dB gain and muted

•	 Input 1 is routed to Output 1

•	 Input 2 is routed to Output 2

•	 Input 3 is routed to Output 3

•	 Input 4 is routed to Output 4

•	 Input 5 is routed to Output 5

•	 Input 6 is routed to Output 6

•	 Input 7 is routed to Output 7

•	 Input 8 is routed to Output 8

•	 All outputs active (unmuted, 100% volume)

•	 No inserted or active DSP processing

•	 All audio inputs are set to 0 dB gain and muted 

•	 All preset and group master memory is clear (empty)

Digital I/O Ports
The four 6-pole 3.5 mm captive screw connector Digital I/O ports provide twenty 
configurable digital input or output ports designed to connect to various devices such 
as motion detectors, alarms, lights, LEDs, buttons, photo (light) sensors, temperature 
sensors, relays (requiring ≥30 mA), and others.

All digital I/O ports are tied to a common ground (one common ground for each 6-pole 
connector), but can be individually configured to operate in one of two modes: digital 
input or digital output. Digital I/O port triggers are not limited to a specific unit and can 
trigger events across a DMP 128 system.

The ports are configured via DSP Configurator. Each port can be configured to monitor 
or drive TTL level digital signals. The ports consist of five I/Os with the sixth pin used as a 
ground providing five ports total. The DSP Configurator software provides selection of a 
script from a list, to be loaded to the DMP 128. The scripts provide pre‑configured sets of 
functions. 

From the main structure menu, select Tools > Configure Digital IO to access the 
scripts (see “Digital I/O Ports” on page 88).
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DMP Software

This section describes the control software for the DMP 128, including:

•	 Software Control

•	 Embedded Web Pages

•	 Windows-based Program Control

•	 DSP Configurator Program Basics

•	 Digital I/O Ports

•	 Emulate Mode and Live Mode

•	 DSP Configurator Windows Menus

•	 Optimizing Audio Levels

•	 Signal Path Building Blocks

Software Control
The DMP 128 can be controlled using the DSP Configurator software, using SIS 
commands through hyper terminal or DataViewer, or using embedded WebPages.  

The DMP 128 has the following connection options:

•	 RS-232 — One single stack 3-pole, 3.5 mm captive screw connector is used for 
bi‑directional RS-232 (± 5 V) serial control.

See “Rear Panel Features and Cabling” on page 6, for additional details on 
connecting the RS‑232 port.

•	 LAN — 10 Mbps, 100 Mbps, half duplex, full duplex connections are supported. Two 
LEDs indicate connection and activity status. The device has the following default 
Ethernet configurations:

IP Address: 192.168.254.254 Default Gateway:  0.0.0.0

Subnet Mask: 255.255.0.0 DHCP: OFF

See “Rear Panel Features and Cabling” on page 6, and “Connection 
Options” on page 113 for additional details on connecting the LAN.

•	 USB 2.0 — A Mini B-type USB connector located on the front panel (duplicated 
on the rear panel) provides high‑speed USB 2.0 connectivity to a host computer, 
backward compatible to 1.0.
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Embedded Web Pages
The embedded web pages, accessible via LAN using a web browser, include the following 
information, available in a tabbed interface.

•	 System Status — The opening web page, displaying a report of system status 
parameters. 

•	 Configuration — this tab contains the following left menu items.

•	 System Settings. Contains IP address and date/time settings.

•	 Passwords. Enter/re-enter admin and user password fields to set up password 
protected access.

•	 Firmware Upgrades. Browse/upload firmware to the device.

•	 File Management — Delete or upload files

•	 See “HTML Operation” on page 137 for further details.

Windows-based Program Control
The DSP Configurator Control Program is compatible with Windows XP, Windows Vista, 
and Windows 7, and provides remote control of the input gain/attenuation, output volume 
output adjustment, and other features.

DSP Configurator can control the DMP 128 via any of the three control ports, RS‑232, 
USB, or LAN.

Updates to this program can be downloaded from the Extron Web site at 
www.extron.com.

Installing the DSP Configurator Program
The program is contained on the Extron Software Products disk. 

Install the software as follows:

1.	 Insert the disk into the drive

2.	 Click the Software tab or software icon.

NOTE:	 If the DVD setup program does not start automatically, run Launch.exe 
from the DVD ROM directory using Windows My Computer.
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Figure 10. DVD Software Menu

3.	 Scroll to the DSP Configurator program and click on Install to its right.

Figure 11. DVD Control Software Menu

4.	 Follow the on-screen instructions. By default, the installation creates a 
C:\Program Files\Extron\DSP_Configurator folder for the DSP Configurator 
program.

5.	 When the DSP Configurator installation is complete, the USB Installer starts 
automatically (see figure 12 on page 17 ). It is recommended to install the USB drivers 
whether they are used immediately or not.
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Installing the USB Driver
When the USB installer begins, follow these instructions.

Figure 12.	 USB Installer Splash Screen

1.	 After the DMP Configurator program installation is complete, click Next to proceed.

Figure 13. USB Installation
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2.	 The USB driver installer is launched. When the installer has completed the installation 
of the USB drivers, the following screen appears:

Figure 14. Successful USB Driver Installation

3.	 Click Finish.

USB driver installation is complete.

DSP Configurator Program Basics

Starting the program

NOTE:	 Extron recommends connection via the Ethernet LAN port for running the 
DSP Configurator program.

To run the DSP Configurator Program, click  
Start > Programs > Extron Electronics > DSP Configurator > DSP Configurator. 

The DSP Configurator program starts in Emulate mode (see figure 15, next page). Also 
see “Emulate Mode and Live Mode” on page 89.

Using the program
In the DSP Configurator Emulate mode, audio parameters may be selected, then 
transferred to the DMP 128 by switching to Live mode (while connected to a DMP 128). 
Audio settings can also be tailored while connected to the DMP 128 which allows 
real‑time auditioning of the audio output as adjustments are made  
(see “Emulate Mode and Live Mode” on page 89).

The main screen contains controls for the input and output channels, virtual sends and 
returns, expansion sends and returns, and other information used in the operation of the 
DMP 128. There is too much information contained on the main screen to enable viewing 
of the entire mix board at one time so several methods are provided to scroll through the 
GUI. 
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DSP Configurator - DMP 128 C

Figure 15.	 DMP 128 Navigation Aids

a	 Minimize buttons — Click once to toggle the view of a selected section from minimum 
to maximum. For example, the Inputs section is maximized with all processor blocks and 
mix‑points shown. Clicking once on the minimize button would then shrink the view to its 
minimum screen area allowing items below to fill the screen.

b	 Maximize buttons — Click once to toggle the view of a selected section from maximum 
to minimum. For example, the Virtual Returns section is minimized with all processor 
blocks and mix‑points hidden. Clicking once on the maximize button would then expand 
the view to its maximum screen area.

c	 Toolbar — All tools and functions not available on the main screen are found here.

d	 Scroll Bar — When the sections are maximized such that the screen area takes up more 
space than can be displayed at one time, items are pushed down or up and no longer 
appear. Use the scroll bar to bring those items back into view.

e	 Hide Channels — Right-click the channel number to hide a channel that has no device 
connected and will not be used in the current configuration. 

NOTE:	 Hidden channels can be shown again using the tools menu and 
selecting View>Show All Channels then unchecking the hidden channels.
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Figure 16.	 DMP 128 DSP Configurator Main Screen

The DSP Configurator program screen consists of an input and virtual return signal 
processor chain, the mix-points, and an output signal processing chain. The main screen 
consumes too much display area to show all mixers and processor chains at a single time 
so there are max/min buttons to collapse each view and a scroll bar on the right side of 
the menu to move up and down the screen.

The main mixer is separated into segments as shown in figure 16. 

NOTE:	 The expansion bus returns mix-points are not shown in this view.

a	 Input gain control h	 Virtual returns signal processor channel

b	 Input signal processor channel i	 Virtual returns to output mix‑points

c	 Input pre-mixer gain j	 Virtual returns to virtual sends mix‑points

d	 Inputs to Outputs mix‑points k	 Virtual returns to EXP sends mix‑points

e	 Output trim control (post-mixer trim) l	 Virtual send bus to virtual returns mix‑points

f	 Output signal processor channel m	 Inputs to expansion sends mix‑points

g	 Output volume control
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Cut, Copy, or Paste Functions
The user may cut, copy, or paste a GUI processor. These actions can be performed from 
a context menu accessed by a right-click of the GUI element, using the Edit menu, or 
using the standard Windows keystrokes: <Ctrl+X> = cut; <Ctrl+C> = copy; <Ctrl+V> = 
paste. 

Multiple GUI elements may be acted upon but the blocks copied must be compatible 
with the desired paste blocks. A highlighted group of elements can be cut or copied to 
a clipboard. The clipboard contents may then be pasted, but will only succeed if there is 
an exact one-to-one relationship between the clipboard contents and the block or blocks 
pasted to. 

In the following example, the Mic #1 input signal path is copied to Mic #5. First the mouse 
is clicked and dragged across the entire signal path. The selected blocks are highlighted 
in green. Press <Ctrl+C>, or use the Edit > Copy menu selection to copy the blocks.

As shown below, the starting point for the paste, (the upper/leftmost element), must first 
be focused by left-clicking the mouse on it. Note the green focus outline that appears on 
the Mic #4 Gain block. The clipboard elements are pasted using the context menu Paste 
command, the Edit menu Paste command, or <Ctrl+V>.

NOTE:	 A cut and copy of elements may be pasted to multiple locations. To copy the 
clipboard to an additional location, click on the leftmost block and paste again. 
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The program warns that all settings in the section being pasted to will be overwritten:

Upon clicking Yes, the entire Mic #4 input path is now identical to the Mic #1 input path 
including signal levels, parameters settings, and mute/bypass selections.

Any single processor block may be copied, then pasted to a similar processor block in 
the same or different input, virtual or output signal path. Mix‑point gains can be copied 
from one to another. Input gain, pre‑mixer gain, post-mixer trim, and output volume 
can only be copied to like gains. For example, an input gain can be copied to any other 
input gain, but cannot be copied to a pre-mixer gain, post-mixer trim, or output volume. 
Mix‑point settings can be freely copied between mix‑points. The user is always asked 
whether they want to overwrite the existing information. If an attempt is made to copy a 
processor block setting to an incompatible block, the user is advised the action cannot be 
completed.
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Navigation
There are two methods of navigation around the GUI: 

•	 Keyboard •	 Mouse

One element in the GUI will always retain focus. When a new DSP Configurator file is 
opened, the upper left element (Output #1 Trim) will be focused by default.

Keyboard Navigation

All GUI elements including mix‑points have the ability to receive focus using the tab 
and arrow keys or using the arrow keys following a single left-click (see “Keyboard 
Navigation” on page 98).

Mouse Navigation

Left-click — A single left click brings focus to a processor block, as well as other GUI 
elements such as tabs, sliders, check boxes. Other left-click actions follow the Windows 
standard.

Right-click — A single right click brings up a context menu specific to the processor 
block right-clicked. Other right-click actions follow the Windows standard.

Double-click — A double-click will open a dialog box from either the focused or 
unfocused state of a GUI element.

DSP Configurator Toolbar Menus
The DSP Configurator contains the following menu bar, arranged horizontally below the 
title bar:

• File • Edit • View • Tools • Window • Help

File	

NOTE:	 New, Open, and Recent Files are unavailable in 
Live mode.

•	 New — Discards the current DSP configuration (after 
prompting to save any changes) and opens a blank 
configuration file.

•	 Open — Loads and activates a previously saved DSP 
configuration file.

•	 Save — Saves all changes to the current DSP configuration 
file under the current file name. If the file has not previously 
been saved, prompts for a file name.

•	 Save As — Saves all changes to the current DSP configuration file under a new file 
name.

•	 Backup — Transfers all partial presets plus the current configuration to a DSP 
configuration file within the DSP Configurator program.

•	 Recent Files — Opens a list of recently opened or saved DSP configuration files.

•	 Exit — Closes the DSP Configurator Program.
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Edit	

•	 Cut — Removes all parameters of a selected 
processor block or set of selected blocks to the 
clipboard. If not followed by a Paste command to a 
different block, the parameters are restored.

NOTE:	 Processor blocks are not removed from the processor stream after a 
Cut and a subsequent Paste operation. Only the parameters are moved. 

Processor blocks and their parameters can be pasted only into another 
block of the same type. For example, the input 1 filter block and all of its 
parameters can be copied to the input 2 filter block but not to the input 1 
delay block.

•	 Copy — Copies all of the parameters of a selected processor block, gain block, or 
set of selected blocks to the clipboard.

•	 Paste — Inserts processor blocks and their parameters from the clipboard into the 
DSP Configurator program at the location selected.

View			 

•	 Meter Bridge — Opens a Meters dialog box with real-time 
meters that monitor signal levels at each input and output.

Figure 17. Meter Bridge

NOTE:	 Meter Bridge is available in Live mode only while connected via the 
LAN port.

•	 Re-enable all dialogs — Re-enables all dialog boxes, the pop-ups that allow 
changes to block parameters.

•	 Group Controls — Opens the Group Controls dialog box (see “Group Masters” on 
page 82).

•	 Show All Channels — Enables channels previously hidden from the main menu to 
be viewed. The selection provides an option to either show all hidden channels for 
that selection, or by moving to the right, an individual channel can be selected leaving 
the others hidden.
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Tools		

The Tools menu contains the following items and sub-menu:

•	 Presets — Provides three options:

•	 Mark All Items — Mark (select) all parts of the current 
configuration (excluding presets), including processors and 
mix‑points to save as a partial preset.

•	 Save Preset — Save the currently marked processors, and 
mix‑points as a partial preset.

•	 Clear Marked Items — Unmark (deselect) all parts of the 
current configuration (excluding presets), including processors 
and mix‑points.

•	 Protected Configuration — Live mode only. Allows a user 
(typically the installer) to save and recall a protected configuration. 
The protected configuration is useful to establish the parameters and values (with the 
exception of the device IP address) in a known state, either as a troubleshooting tool or as 
a baseline configuration. The protected configuration, once saved in the device, is always 
present and cannot be overwritten without entering a user-defined Personal Identification 
Number (PIN) password. The protected configuration is restored without a PIN.

NOTE:	 The default PIN is 0000.

•	 Save — Save the current configuration (excluding presets), including processors and 
mixes as a password protected configuration. The DSP Configurator program prompts for 
a PIN to save.

•	 Recall — Recall the protected configuration.

•	 Change PIN — Change the PIN associated with the protected configuration.

•	 Configure Digital I/O — Opens a utility to configure digital I/O ports. The DMP 128 provides 
twenty digital I/O ports that may be used to trigger external events from DMP 128 actions, or 
for external events to trigger DMP actions (see “Digital I/O Ports” on page 88).

•	 Connect to / Disconnect from Device (depending on Emulate or Live mode) — 
Performs the same functions as the Mode Emulate and Mode Live buttons.

•	 Device Manager — Opens the Device Manager dialog box. If a device is connected, displays 
the details (model, MAC address, IP address). In addition, a device can be added or removed, 
or a selected device cloned, and new folders can be added to an existing device.

•	 Issue RESET Command — Initializes and clears the following: mix‑points, presets, 
processor blocks, and gain blocks. This reset is identical to the E ZXXX} SIS command (see 
“SIS Programming and Control” on page 113).

•	 Save Changes to Device (live mode only) — Saves configuration changes in the DMP 128 
to non-volatile memory. This is advised if you are about to power off the device.

•	 Firmware Loader — Calls the Firmware Loader program, which allows updating the firmware 
without taking the DMP 128 out of service (see “Firmware Loader” on page 151).

•	 Organize Building Blocks — Allows organization of listed building blocks. You can 
also import and export the building blocks file to use your set of building blocks on other 
computers or sets from other computers on yours (see “Signal Path Building Blocks” on 
page 106).

•	 Configure Groups — Opens the configure groups dialog box (see “Group Masters” on 
page 82).

•	 Device Settings (live mode only) — Opens a dialog box that provides a means to change 
the IP address, set administrator and user passwords, change the device name, change the 
date and time, and to select the serial port baud rate.
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•	 Options — Opens a tabbed dialog box that allows customization 
of the DSP Configurator appearance and operation.

•	 Colors — Tailor the appearance of the various graphs and 
dialog boxes. Appearance uses a selected color scheme 
for the complimentary and graph colors. Complimentary 
Colors allows custom selection of colors used with the 
various graphs and dialog boxes. Graph colors change the 
row colors containing the information and descriptions of the 
graphs seen in the processor blocks.

•	 Preferences — The startup splash screen contains options 
for selection of the devices to connect to, or to “Always ask” 
on startup. That selection can be changed using Default 
Device. 

•	 If Show Meters is set to True, Dynamic Block Meters may 
be used to tailor the appearance of the dynamics 
meters to use the full meter to show input and gain 
reduction, or to show the level based on the output 
and gain reduction. 

•	 Processor Defaults, Defaults — Individually selects the 
default parameters for the various processor, trim, and gain 
blocks. 

Each row item contains default settings customized for the 
processor, filter, trim, or gain block it represents. 

Gain and volume blocks can be initially muted, while filter 
and dynamics processor blocks can be initially bypassed. 

NOTE:	 The bypass function is labeled “Enable”.

•	 Processor Defaults, Reset All Defaults — 
Returns the DMP 128 processor and level control 
blocks to factory default settings. Each processor,  
and gain/volume/trim block also has an individual 
default reset.

•	 To view the individual processor defaults, press the 

>

 button to the left of the 
processor, trim, gain or meter device.
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•	 Expansion Bus — Active only 
when a second DMP 128 is 
connected. Provides a means to 
select control of either the primary 
or secondary device.

Window Menu	

•	 Cascade — Rearranges all open DSP Configurator program 
screens, including dialog boxes, in a cascading array.

•	 Close All Windows — Closes all open dialog boxes.

•	 Individual Windows — Lists all open dialog boxes. Clicking on the name brings the 
associated dialog box to the front of the desktop.

Help Selection

The Help menu contains the following elements:

•	 Contents — opens the Help file at the Contents tab.

•	 Search — opens the Help file at the Search tab.

•	 About... — displays the name of the application, the current version number, and 
copyright information. 

NOTE:	 Help can be activated via the F1 key from any main screen or dialog 
(which accesses context sensitive Help).

Presets drop-down
Displays a list of up to 32 presets. Select a preset from the list to 
display it and either activate it (Recall), abort the selection without 
either recalling or deleting it (Cancel), or delete it (Delete).

NOTE:	 An asterisk in the drop-down list indicates a partial preset exists only in 
the DMP 128 and has not been downloaded to the DSP Configurator. 

Mode buttons 
Provides selection between Live mode and Emulate mode (see 
“Emulate Mode and Live Mode” on page 89).

Backup

When in Live mode (connected to a DMP 128), if presets exist in the DMP 128 that are 
not present in the DSP Configurator program (indicated by an asterisk next to the preset 
name), the function halts and prompts the user to run a backup.

Backup (File > Backup) transfers all partial presets plus the current configuration from 
the DMP 128 to a DSP configuration (.edc) file within the DSP Configurator program and 
then displays a prompt to save the file to the hard drive. Backup is unavailable when the 
DSP Configurator program is in Emulate mode.
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Figure 18.	 Control Blocks and Processor Chains

Audio level, mix‑point, processing blocks, and signal chains
As outlined in red above, all control blocks on the main DSP control screen have one of 
three main functions in the overall signal chain:

•	 Level control (gain/trim/volume),

•	 Mix‑point (signal routing),

•	 Signal processing (filter/AEC/feedback/dynamics/delay/duck/loudness/automix).

The signal chain varies depending on whether it is in the input, output, virtual bus, or 
EXP bus stage. Each of the three types of signal processing channels; Input (a/b/c), 
Output (e/f/g), and Virtual (h) shown in figure 18 above, consist of a series of two basic 
types of control blocks specific to that chain: level control (gain a/c, trim e, and volume 
control g), and signal processors (frequency filters, feedback suppression, dynamics, 
delay, ducking, AEC, AM, and loudness). Both types of control blocks are always present 
in the chains. Gain controls default to unmuted and processor blocks are bypassed upon 
insertion.

The EXP returns bus has only an AM processing block.

Gain, trim and volume blocks can be muted and processor blocks (after being inserted) 
can be bypassed for signal comparison. Mutes and bypasses are shown by a red 
indicator in the lower left of the block.

Figure 19.	 Input Gain Control Muted, Dynamics Processor (AGC) Bypassed
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Level Control Blocks
To access a gain, trim or volume control to view a setting, make a change, or observe a 
live audio meter (input gain and output volume blocks only), double‑click the gain block 
icon (see figure 20). This action opens a dialog box that contains the fader for that control.

A dialog box opens,
containing the full 
fader control. 

NOTE: In Emulate mode 
 (the startup mode), 
 the meter is not operational.

Double-click a gain, 
trim, or volume control.

Figure 20.	 Accessing a Typical Gain Control Dialog Box
Level controls always have a fader control for setting the signal level and a digital 
indication of its current setting. They can also have switches or indicators required for their 
specific function.

Processor blocks
Each processor block represents a menu of one or more processors that can be inserted 
into the audio stream. For blocks that provide more than one processor, only one can be 
selected. Each block can be inserted by a double-click or right-click>Insert then 
selecting the desired processor (see figure 21). Once a block is inserted, the selected 
processor is displayed in the block and the block changes color. Processor blocks default 
to bypassed. Bypass is different from mute since the processor will pass an unprocessed 
signal when in bypass mode. To have them default to “not bypassed” see “Tools” on 
page 86.

Double-click the
processor block. 

Click the desired 
processor.

The selected processor is displayed in the 
block.
To change processor variables, double-click the 
block again to open the processor dialog box.-or- 

Right-click the
processor block. Click insert.

Click to select the 
desired processor.

Figure 21.	 Selecting a Processor Block
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Once a processor is inserted, to view associated parameters that define the selected 
processor (such as a frequency curve) or to remove the bypass, double‑click on the 
processor block. This action opens a new dialog box that contains parameters for the 
process (see figure 22).

Figure 22.	 Sample Processor Dialog Box

•	 The Set Defaults button discards all custom settings and	  
reloads the default parameters.

•	 The Bypass button temporarily suspends the processing without	  
removing the processor block. Red indicates the processor is bypassed.

By default, each processor block is bypassed when inserted (the Bypass button in the 
processor dialog box is red). This can be changed for each processor block type (see 
Tools > Options and the specific defaults for the processor types). 

NOTE:	 Figure 22 is a sample of one type of dialog box. Contents and appearance 
of each dialog box are unique to the processor type.

The block can be removed from the signal chain by selecting it with a single mouse click 
and depressing the keyboard <Delete> key or by right-clicking and selecting Delete.

Detailed explanations of each signal chain with their processor blocks along with mix‑point 
operation follow in the next section.
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Mic/Line Input signal Chain controls

The input signal processor chain allows adjustments to program or microphone audio 
material before input to the main mixer.

Gain Control (GAIN)
The gain control provides a single long-throw fader with a range of 
–18 dB to +80 dB, adjustable in 1 dB increments with the fader or 
in 0.1 dB increments using direct entry in the level setting readout 
below the fader. The peak reading meter holds the peak level for 
one second, displaying it numerically in the box below the meter. 
The default setting is unity gain (0.0 dB).

The Phantom Power checkbox, accessible in the dialog box, toggles 
the +48 VDC phantom power on and off. Phantom power is typically 
used to power a condenser microphone.

The Mute button, accessible in the dialog box, silences the mic/line 
input.

The Polarity button, accessible in the dialog box, allows the 
polarity of wires connected to the audio connectors (+/tip and –/ring) 
to be flipped to correct for miswired connectors. 
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Filter (FILT)
Each filter block allows a total of five filters. The first filter is inserted from a processor 
list that appears when the block is double‑clicked or via a context list when the block is 
right‑clicked. 

Figure 23.	 Insert Filter Menu

Once inserted, double‑click the processor block to change parameters of the filter. After 
the first filter is inserted, up to four additional filters may be added to the filter block using 
the dialog box. Select the desired filters from the following list using the drop‑down boxes:

•	 High pass filter — A high pass filter passes a band of frequencies extending from a 
specified cutoff frequency (greater than zero) up toward the high end of the frequency 
spectrum. All frequencies above the specified cutoff frequency are allowed to pass, 
while all frequencies below are attenuated.  
The default cutoff is 100 Hz.

•	 Low pass filter — A low pass filter passes a band of frequencies extending from a 
specified cutoff frequency (less than infinite) towards the lower end of the frequency 
spectrum. All frequencies below the specified frequency are allowed to pass, while all 
frequencies above are attenuated.  
The default cutoff is 10 kHz.

•	 Bass and treble filters — Also known as shelving or tone controls, the separate 
bass and treble filters provide the ability to cut or boost gain linearly above or below a 
specific frequency, with the end-band shape giving the visual appearance of a shelf. 
The bass default frequency is 100 Hz and the treble default is 8 kHz.

•	 Parametric equalizer filter — The parametric filter is a frequency equalizer that 
offers control of all parameters, including amplitude (the amount of gain/boost or 
gain reduction/cut applied), center frequency (frequency), and range of affected 
frequencies (Q) around the center frequency. 
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Figure 24.	 Filter Block Dialog Box

Additional filters are inserted by opening the filter block dialog box, then selecting a filter 
type from the drop-down filter selection list. All filter parameters are modified via the Filter 
block dialog box. Each filter loads with all applicable default parameters displayed to the 
right of each drop-down filter selection list.
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Figure 25.	 Filter Dialog Box, Filters Added

Within the dialog box, a filter is focused when a filter type is inserted, or is focused by 
clicking the filter number to the left of the filter selection drop-down list. Note how box 3 in 
figure 25 is highlighted in yellow, indicating it is the filter in focus. The results of the filter in 
focus (independent of other filters) will show in the graph as a dotted line the same color 
as its filter row when bypassed. When active (not bypassed), the line is solid. 

When multiple filters are enabled, the graph indicates the focused filter result (independent 
of other filters) in the color of the filter row in the type/parameters table. The composite 
response, the combined effect of all filters not bypassed, is always displayed in red. 
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Figure 26.	 Filter Dialog Box, Filter Not Bypassed

Above the graph, each filter has a "handle" (circled in red above) placed directly 
above the cutoff or center frequency whose number corresponds to the filter number 
(outlined in red). Clicking a handle or clicking the table row brings focus to that filter. 
<Click+hold+dragging> the handle horizontally changes the cutoff or center frequency to 
a new position on the x axis.

The table below shows each filter type with default parameter settings. The table 
immediately following shows the possible range for each parameter.

Type Frequency Parameter 1 Parameter 2

High Pass   100 Hz Slope: 6 dB N/A

Low Pass  10000 Hz Slope: 6 dB N/A

Bass   100 Hz Boost/Cut: 0.0 dB Slope: 6 dB

Treble   8000 Hz Boost/Cut: 0.0 dB Slope: 6 dB

Parametric 1000 Hz Boost/Cut: 0.0 dB Q: 1.0

Filter Parameter Settings Range

Frequency 20 Hz to 20 kHz

Boost/Cut -24.0 dB to +24.0 dB

Q (Parametric EQ only) 0.707 to 15.000

Slope (HP & LP filters only) 1st Order (6 dB) and 2nd Order (12 dB)
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High Pass

The high pass filter allows all frequencies below the specified frequency to pass 
unattenuated. All frequencies above the specified cutoff frequency are allowed to pass, 
while all frequencies below are attenuated.  
The default cutoff is 100 Hz.

Figure 27.	 High Pass Filter Response Curve

All frequencies lower than the specified frequency, 100 Hz, are attenuated leaving the 
upper frequency response flat. Also note at the specified frequency (100 Hz) the signal is 
about 3 dB down, typical operation for high pass filters.
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Low Pass

The low pass filter is the opposite of the High Pass filter. All frequencies above the 
specified frequency are attenuated allowing lower frequencies to pass.   
The default cutoff is 10 kHz.

Figure 28.	 Low Pass Filter Response Curve

Here, the frequencies higher than the specified frequency, 10 kHz, are attenuated leaving 
the lower frequency response flat.
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Bass and Treble Shelving

Bass and treble shelving may be added to the filter. Also known as shelving or tone 
controls, the separate bass and treble filters provide the ability to cut or boost gain 
linearly above or below a selected frequency, with the end-band shape giving the visual 
appearance of a shelf. 

If only a bass or only a treble filter is required, either bypass the unneeded control or set it 
to “Unused” in the selection box.

The bass default frequency is 100 Hz and the treble default is 8 kHz.

NOTE:	 Selecting "Bass & Treble Filters" inserts two separate filters.

 

Figure 29.	 Bass and Treble Shelving

The corner frequency of the controls may be selected to 0.1 Hz accuracy. Two slopes, 
6 and 12 dB/octave are available along with the ability to boost or cut the signal up to 
24 dB.
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Parametric (Equalizer)

The parametric filter is a frequency equalizer that offers control of all parameters, including 
amplitude (the amount of gain/boost or gain reduction/cut applied), center frequency 
(frequency), and range of affected frequencies (Q) around the center frequency. 

Up to five parametric filters can be placed in the filter box at one time. Each may be set 
to a different frequency creating a five band parametric equalizer. The control will boost or 
cut the center frequency, and by changing the Q value, the range of affected frequencies 
can be widened or narrowed around the center frequency. In general, a higher Q value 
results in a narrower affected bandwidth. 

To demonstrate how Q affects the filter, the following filter block (see figure 30) containing 
five parametric filters centered at different frequencies but with the same Q of 1.0. The 
filter in focus (c) has a center frequency of 1000 Hz boosting that frequency +12 dB over 
a Q of 1.0. Note the markers on either side of the peak frequency are at about 300 Hz on 
the left and 3000 Hz on the right, a bandwidth of about 2700 Hz.

Figure 30.	 Parametric Filter at 1000 Hz, Q: 1.000

 

DMP 128 • Software Control 39



By increasing the Q to 10.000, the center frequency remains the same. The markers show 
the bandwidth of the filter narrowed to between 900 Hz and 1200 Hz, or about 300 Hz 
(see figure 31). Parametric filters can be used to notch out a very narrow, or very wide 
range of frequencies using the Q.

Figure 31.	 Parametric Filter at 1000 Hz, Q: 10.000

The above dialog box shows the frequency curve for a single active filter. To add its effect 
to the overall frequency response, remove the bypass on the other filters. 
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The overall frequency response is now shown as a solid red line with the filter in focus 
(located in row 3 below) shown in the color of its table row.

Figure 32.	 All Parametric Filters Active

The parametric filter allows frequency selection accurate to 0.1 Hz and either 6 or 12 dB 
of slope. The 3 dB down point will remain constant regardless of the slope setting. Only 
the steepness of the frequency attenuation curve will change.
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Acoustic Echo Cancellation (AEC) 
The DMP 128 C models provide one acoustic echo canceller processor for each of the 
first eight mic/line inputs. A single reference can be selected for each AEC from a list of 
the eight line outputs and virtual paths. The selected reference signal is compared to the 
AEC input signal and the difference in gain is a decibel measurement reported via a meter 
as an echo return loss (ERL).

About AEC

Echo occurs when audio from a talker in the far end is received and amplified into the 
near end listener’s room, with that sound then being picked up by microphones in the 
near end acoustic space and sent back to the far end. The amount of signal sent back 
to the far end talker can be substantial, and with the added transmission delay, the result 
is an echo effect that will seriously compromise communication in a teleconference or 
videoconference.

The Acoustic Echo Cancellation processor removes the potential echo signal at the near 
end mic channel by comparing it to the received signal from the far end, designated as 
the “reference,” and then creating an adaptive filter to cancel the potential echo before it is 
sent back to the far end.  

AEC Setup

Successful operation of the AEC processing block is a function of proper gain structure 
and selection of the AEC reference (see “Optimizing Audio Levels” on page 101). This 
section provides an overview of the two elements.

Proper gain structure involves the relationship between the signal at the selected reference 
and the signal at the mic input, within the context of proper levels for the reference and 
mic inputs independently. The mic input gain setting will naturally be optimized for the 
voice level of the talker in that room; therefore the amount of signal from the far end that is 
picked up by the mic is dependent on how much that far end signal is being amplified in 
the near end room and the distance from the mic to the speakers.

The reference signal is the signal received from the far end, which will ultimately be sent to 
a sound reinforcement system within the near end room. The output of the video codec 
might be connected to any of inputs 9 – 12.

In the AEC dialog, a reference can be chosen from any channel in one of three signal 
chains:

•	 Input Channels

•	 Virtual Return Channels

•	 Output Channels

Extron recommends using an input channel as the reference. An output channel or a 
virtual channel may also be used as a reference; however, doing so adds a little more 
delay to the signal being referenced. 

Using an output or virtual channel reference allows for the combining of input channels 
to a single reference, for instance, in a conferencing setup where both a telephone and 
a video codec may be used in different instances. In this case, both the telephone and 
video codec input channels can be routed to an output or virtual return, with that output 
or virtual return then chosen as the reference.
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When using an output channel as a reference, the reference point is post volume control; 
therefore, changes to the listening volume in the room will affect the AEC gain structure 
(see “AEC Dialog” on page 43). If you have an output channel on the DMP 128 that 
is not being used, you can isolate the reference channel from the channel being used for 
volume control by routing reference signals to the unused output channel. 

Alternately, if you do want the reference signal to track with changes in listening volume, 
yet want more control over the actual reference level:

a.	 Route the far end signal to both the amplifier output and the virtual (unused) 
output.

b.	 Create a group master control that contains the amplifier output and virtual 
output. Set soft limits for the group master control, as desired.

c.	 Set optimal level for the amplified output. Set optimal level for virtual output. 
Relative levels between both settings will be maintained by using the group 
master control.

AEC Configuration

To insert and configure an AEC processor:

1.	 Insert an AEC processor on the desired input channel using one of the following 
methods:

•	 Double-click the AEC (filter) block in the DSP Configurator workspace.

•	 Right-click the AEC block to open the context menu and select Insert AEC.

•	 Click the AEC block to select it (or use the arrow keys to navigate to the AEC 
block) and press the <Enter> key on your keyboard.

2.	 Double-click the AEC processor to open it. Open the Select Reference drop-down list 
and select a reference.

3.	 Click the Bypass button to disengage bypass. The AEC processor is now operational.

AEC Dialog
The AEC dialog contains a number of meters and indicator LEDs 
that are essential for setting up gain structure and monitoring activity. 
The AEC reference must be selected from a list, otherwise the 
echo canceller will not work. Noise Cancellation, part of the AEC 
processor, is selected and adjusted here. A detailed description of 
the AEC dialog components is included below.

Activity LEDs

•	 Far – lights when activity is detected from the remote site.

•	 Near – lights when activity is detected from the local site.

•	 Update – lights when the SEC is updating, i.e., converging or 
reconverging.
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Meters

•	 ERL – the ratio in dB between the signal at the reference and the signal at the AEC 
channel input. When ERL is a positive number, the signal level at the AEC channel 
input is lower than the signal at the selected reference (0 to +15 dB is desirable).

•	 ERLE – the amount in dB of potential echo signal that the AEC algorithm, not 
including NLP processing, is cancelling.

•	 TER – the sum of ERL + ERLE, in dB.

Select Reference

Select the AEC reference from a drop-down list, populated with 
the following:

•	 Output channels (1 – 8)

•	 Input channels (1 – 12)

•	 Virtual Return channels (A – H)

Noise Cancellation

Noise cancellation can be switched on or off from the AEC dialog. 
The noise canceller detects steady state noise, such as HVAC or 
other continuous system noise, and effectively remove it without 
causing audible artifacts.

Noise cancellation is engaged or disengaged using a checkbox. 
When the box is checked, noise cancellation is engaged, or 
switched on. When cleared, noise cancellation is disengaged, or 
switched off. The default setting is noise cancellation switched on 
and set to 15 dB of noise attenuation. 

Up to 20 dB of noise cancellation is available, in 0.1 dB 
increments. 

Setting Gain Structure for AEC
(see “Optimizing Audio Levels” on page 101).
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Advanced AEC Controls
Click on the open/collapse icon at the bottom of the AEC dialog to reveal the advanced 
AEC controls.

Advanced control functionality is as follows:

Non-linear Processing (NLP) Controls

•	 Enable NLP — this box is selected by default. NLP 
is necessary for the removal of echo.

•	 NLP Presets — click a button to load a set of 
values to the three NLP parameters; Max NLP 
Reduction, Attack Time, and Release Time.  

•	 Soft 
•	 Normal 
•	 Aggressive 

The default parameters (shown at right) match the 
Normal preset.

•	 Max NLP Reduction – the maximum possible reduction in echo artifacts that 
can be applied. The range is 0.0 to 80.0 dB in 0.1 dB increments.  
Default is 50.0 dB.

•	 Attack Time – the speed in which NLP is applied. The range is 0.0 to 
100.0 msec in 0.1 msec increments.  
Default is 6.0 msec.

•	 Release Time – the speed in which NLP is released. The range is 1.0 to 
3000.0 msec in 0.1 msec increments.  
Default is 150.0 msec.

Additional Controls

•	 Double Talk Echo Reduction – sets the amount of echo reduction applied 
during double-talk. The range is 0.0 to 20.0 dB in 0.1 dB increments.  
Default is 15.0 dB.

•	 Comfort Noise – sets a comfort noise level in dB to eliminate states of complete 
silence, which may be perceived as a failed connection. The range is 0.0 to 
40.0 dB in 0.1 dB increments.  
Default is 0.0 dB which turns comfort noise off.
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Dynamics (DYN)
A dynamics processor alters the dynamic 
range, the difference between the loudest 
to the quietest portions, of an audio signal. 
Each input channel provides two dynamics 
processor blocks that, when inserted, provide 
one of four types; AGC, Compressor, Limiter, 
or a Noise Gate processor. 

Once a processor has been inserted, individual 
processor parameters can be changed in the 
dialog box, accessed by double‑clicking the 
processor block. For comparison, the block 
can be bypassed by clicking a Bypass button. 

All parameters are displayed in a text box and have a resolution to 0.1 increments. 
Parameters can be set by direct entry in the text box to replace existing text, then 
pressing Enter, tabbing, or clicking to another area. Threshold, gain/attenuation, target, 
and ratio parameters have adjustment points on the graph display. Use the mouse to 
click + drag the graph point to the desired destination or value. All time values have a 
horizontal slider allowing adjustment in 1 ms increments by either a click + drag of the 
slider handle, or focusing on the slider, then using left or right arrow keys (Page Up and 
Page Down keys adjust in increments of 10 ms). 

The table below lists each dynamics processor type, parameters, and factory default 
settings for the processor. 

Parameter AGC Compressor Limiter Gate

Threshold -40.0 dB -30.0 dB -10.0 dB -65.0 dB

Max Gain 12.0 dB

Target -10.0 dB

Window 12.0 dB

Attack Time 500.0 ms 5.0 ms 2.0 ms 1.0 ms

Release Time 1500.0 ms 100.0 ms 50.0 ms 1000.0 ms

Ratio 2.0 :1 20.0 :1

Hold Time 0.0 ms 100.0 ms 50.0 ms 300.0 ms

Max. Attenuation 25.0 dB

Soft Knee Off Off 

Details of the individual dynamics blocks follow. 
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AGC (Automatic Gain Control)

AGC adjusts the gain level of a signal based upon the input strength to achieve a more 
consistent volume. Below the set threshold, the signal is not affected. Above the threshold, 
weaker signals are boosted up to the maximum gain setting to reach a user‑defined target 
level. As the signal level approaches the target level it receives less gain or no gain at all. Once 
the signal level reaches the target level all gain is removed. 

Threshold — is the input level where maximum gain 
will be applied (after the attack time is exceeded). 
On the graph at right follow the red input level from 
the lower left to -40 dB where the first red circle is. 
Signal levels less than -40 dB remain at their original 
levels. All signal levels at or exceeding -40 dB will 
have up to 12 dB of gain applied (Maximum Gain).  
The threshold level can be adjusted from -80.0 to 
0.0 dB in 0.1 dB increments.  
Default is -40.0 dB. 

Maximum Gain — is the highest amplification 
applied to a signal exceeding the threshold and up 
to the lower limit of the window (see below).  
Maximum Gain can be set from 0.0 dB to +60 dB in 
0.1 dB increments. 
Default is 12.0 dB.

Target — is the desired average signal level of the 
output when AGC is applied. AGC can vary the gain 
according to the input signal level, specified target 
level and maximum gain. As the signal approaches 
the target level of –10 dB, gain is reduced until at 
–10 dB, gain is no longer applied.  
The target level can be adjusted from -40 dB to 
0.0 dB in 0.1 dB increments. 
Default is –10.0 dB.

Window — indicated by the two yellow lines, is a specified range above and below the 
target level. Below the lower line maximum gain is always applied to the signal. When the 
signal reaches the window, gain control begins scaling in a linear fashion to achieve smoother 
results as the signal reaches the target level.

The window range can be set in 0.1 dB increments from 0.0 dB to 20.0 dB.

The default threshold is – 40 dB. The default target level is – 10.0 dB. The default gain and 
window are 12.0 dB.

Attack Time — adjusts the time delay for AGC to engage after the input signal level reaches 
or exceeds the threshold level.  
Attack time can be adjusted from 0.0 to 3000.0 ms in 0.1 ms increments. 
Default is 500.0 ms.

Hold Time — adjusts how long AGC continues to boost the signal after the input signal drops 
below the threshold and before release time begins.  
Hold time can be adjusted from 0.0 to 3000.0 ms in 0.1 ms increments. 
Default is 0.0 ms.

Release Time — adjusts the time it takes to return the signal to normal (unprocessed) levels 
after the signal no longer exceeds the threshold level setting. Release time begins only after 
hold time is reached.  
Release time can be adjusted from 10.0 to 10000.0 ms in 0.1 ms increments. 
Default is 1500.0 ms. 
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Compressor

The compressor regulates signal level by reducing, or compressing, the dynamic range 
of the input signal above a specified threshold. The input level to output level ratio 
determines the reduction in the dynamic range beyond the threshold setting. For example, 
with a ratio setting of 2:1, for every 2 dB of input above the threshold, the compressor 
outputs 1 dB. 

Compression is commonly used to contain mic levels within an acceptable range for 
maximum vocal clarity. A compressor can also make softer sounds louder in one of two 
ways. The dynamic range can be reduced by compressing the signal above the threshold 
while raising the post‑compressor gain/trim (referred to as "make‑up gain"). Alternately, 
the input signal can be increased while the compression ratio above the threshold is 
increased correspondingly to prevent clipping. Both techniques have the effect of making 
louder portions of a signal softer while at the same time increasing softer signals to raise 
them further above the noise floor. 

Compression can also be used to protect a system or a signal chain from overload similar 
to a limiter.

The default threshold is -30 dB and default ratio is 2.0:1.

Threshold — is the input signal level above 
which compression begins (subject to attack 
time) and below which compression stops 
(subject to hold and release time).  
The threshold level can be adjusted from 
-80.0 to 0.0 dB in 0.1 dB increments.  
Default is -30.0 dB. 

Ratio — is the input signal level reduction 
when compression is engaged.  
Ratio can be adjusted from 1.0 to 100.0 in 
0.1 increments.  
Default is 2.0:1.

Attack Time — adjusts the time delay for 
compression to engage after the input signal 
level reaches or exceeds the threshold level.  
Attack time can be adjusted from 0.0 to 
200.0 ms in 0.1 ms increments. 
Default is 5.0 ms.

Hold Time — adjusts how long compression 
continues after the input signal drops below 
the threshold and before release time begins.  
Hold time can be adjusted from 0.0 to 
500.0 ms in 0.1 ms increments. 
Default is 100.0 ms.

Release Time — adjusts the time it takes to return the signal to normal (unprocessed) 
levels after the signal no longer exceeds the threshold level setting. Release time begins 
only after hold time is reached.  
Release time can be adjusted from 10 to 1000.0 ms in 0.1 ms increments. 
Default is 100.0 ms. 

Soft Knee — Select the Soft Knee checkbox to smooth and soften the transition from 
uncompressed to compressed output levels. There are no adjustments.
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Limiter

The limiter restricts the input signal level by compressing its dynamic range above a 
specified threshold. The limiter is most commonly used to prevent clipping, protecting a 
system against component or speaker damage. While the limiter is closely related to the 
compressor, it applies a much higher compression ratio of ∞:1 above the threshold. The 
ratio is fixed and cannot be changed.

Threshold — is the input signal level above 
which limiting begins (subject to attack time) 
and below which compression stops (subject 
to hold and release time).  
Threshold level can be adjusted from – 80.0 
to 0.0 dB in 0.1 dB increments.  
Default is –10.0 dB. 

Attack Time — adjusts the time delay for 
limiting to engage after the input signal level 
reaches or exceeds the threshold level.  
Attack time can be adjusted from 0.0 to 
200.0 ms in 0.1 ms increments. 
Default is 2.0 ms.

Hold Time — adjusts how long limiting 
continues after the input signal drops below 
the threshold and before release time begins.  
Hold time can be adjusted from 0.0 to 
500.0 ms in 0.1 ms increments. 
Default is 50.0 ms.

Release Time — adjusts the time it takes 
to return the signal to normal (unprocessed) 
levels after the signal no longer exceeds the 
threshold level setting. Release time begins 
only after hold time is reached.  
Release time can be adjusted from 10 to 
1000.0 ms in 0.1 ms increments. 
Default is 50.0 ms. 

Soft Knee — Select the Soft Knee checkbox to smooth and soften the transition from 
uncompressed to compressed output levels. There are no adjustments.
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Noise Gate

The noise gate allows an input signal to pass only when it exceeds a specified threshold 
level. Above the threshold level, the signal passes unprocessed; below the threshold the 
signal is attenuated at the rate set by the ratio adjustment. The typical setting of the noise 
gate threshold is just above the noise level of the environment or source equipment. That 
allows signals that are above the noise to pass, and attenuates the noise when there is no 
signal eliminating background noise.

Threshold — is the input signal level below 
which attenuation (gating) begins (subject to 
attack time) and above which gating stops 
(subject to hold and release time).  
The threshold level can be adjusted from 
-80.0 to 0.0 dB in 0.1 dB increments.  
Default is -65.0 dB.

Max Attenuation — is the maximum 
attenuation of the signal when it drops below 
the threshold.  
Maximum attenuation can be adjusted from 
0.0 to 80.0 dB in 0.1 dB increments.  
Default is 25.0 dB.

Ratio — is the input signal level reduction 
when gating is engaged.  
The ratio can be adjusted from 1.0 to 100.0 
in 0.1 increments.  
Default is 20.0:1.

Attack Time — adjusts the time delay for 
gating to engage after the input signal level 
drops below the threshold level.  
Attack time can be adjusted from 0.0 to 
200.0 ms in 0.1 ms increments. 
Default is 1.0 ms.

Hold Time — adjusts how long gating continues after the input signal drops below 
the threshold. If the signal is still below the threshold when hold time ends, release time 
begins.  
Hold time can be adjusted from 0.0 to 500.0 ms in 0.1 ms increments. 
Default is 300.0 ms.

Release Time — adjusts the time it takes to return the signal to normal (unprocessed) 
levels after the signal is no longer below the threshold level setting. Release time begins 
only after hold time is reached.  
Release time can be adjusted from 10 to 1000.0 ms in 0.1 ms increments. 
Default is 1000.0 ms. 
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Delay (DLY)
The delay processor block, when inserted, provides a means to delay the audio signal. 
Audio Delay is used to sync audio to video or to time-align speakers that are placed at 
different distances from the listener. The DMP 128 can set delay by either of two criteria: 
time or distance (feet or meters). 

The default unit setting is time with a range of 0.0 ms to 200.0 ms adjustable in 0.1 ms 
steps. Default is 100.0 ms. 

Settings are controlled with a vertical slider and indicated with a value readout field. The 
value can be changed by clicking within the readout field, changing the number, then 
either pressing Enter, tabbing, or clicking away from the field.  

Figure 33.	 Delay Dialog

Slider adjustments made in feet or meters correspond incrementally to the distance 
required to make 1 ms, or 5 ms adjustments (detailed in the table below). If more precision 
is required, enter time in 0.1 ms increments into the readout field.

Method Time Feet Meters

Click + drag 1 ms ~1.1 feet ~0.3 m 

Focus + arrow 1 ms ~1.1 feet ~0.3 m 

Focus + Page Up/Down 5 ms ~5.6 feet ~1.7 m

When distance (feet or meters) is chosen, the conditions (temperature) field becomes 
available and can be set either by degrees Fahrenheit or Celsius. When entering a 
distance, time delay compensation is automatically modified based on differences in the 
speed of sound due to air temperature.  
Default is 70° Fahrenheit.

NOTE:	 When using distance (feet or meters), set a temperature value first, then set 
the distance.
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Ducking 
Ducking provides a means to duck, or lower, the level of one or 
more input signals when a specified source must take precedence. 
The ducking processor block, when inserted, provides a means 
to duck one or more mics and program material (ducking targets) when the processor 
detects a signal from the ducking source. Ducking lasts for the duration of the interrupting 
signal (ducking source) determined by the threshold setting (plus hold and release time) 
and restores the original levels of the ducked inputs once the other signal has ceased. 

NOTE:	 Ducking is not functional when an input chain includes active automixing. If 
the input to output mix-point is orange, indicating it includes automixing, ducking 
will not function for that input. To enable ducking either delete the automix 
processor in the signal chain or uncheck “includes automixing” at the mixpoint.

Ducking is useful when:

•	 Program material needs to be 
attenuated in order to more clearly 
hear a narrator voice.

•	 One microphone, such as one 
used by a master of ceremonies, 
needs to have priority over other 
mics, program material, or both.

•	 A paging mic needs to attenuate all 
other signals.

All ducking processor blocks are 
controlled via a common dialog box 
that opens when any of the ducking 
blocks are selected. All empty ducking 
processor blocks have no ducking 
source or target settings by default. 

When the first ducking source is 
inserted (shown at right), no ducking 
targets are selected. 

NOTE:	 Signal reduction is not cumulative. Ducking will only reduce an input by the 
amount set in the by (dB): text box even if it is being ducked by another ducking 
source (see “Ducking and Priority Ducking” on page 55).
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Ducking Configuration Dialog  
Ducking is configured in a dialog box which opens when an active ducking processor block is 
double-clicked.

a Current source indicator

Shows the input selected as the ducking 
source. Ducker settings affect the input channel 
shown here. When a ducker dialog is opened 
for a channel, the current source defaults to 
that channel. The current source can also be 
selected via the priority readout/source selector 
(see below).

b Enable mic/line source checkbox 

When checked, ducking is enabled for the 
current source and the ducker processor block 
is lit. When cleared, ducking is disabled for the 
current source and the ducker processor block 
is unlit. 

c Duck Targets: 

Shows all potential input targets. Only inputs that 
are checked will be ducked. The current source 
is not available as a target (a source cannot duck 
itself). If the current source has been designated 
as a target of another input channel, that input 
channel is not available (a target cannot be the 
source).

d by: (Target gain reduction amount)

Individual attenuation settings for each duck 
target in dB. The default is 20.0 dB. If additional 
attenuation of a target is required, increase this 
value. 
The attenuation range is 80.0 to 0.0 dB in 0.1 dB increments. 

e Priority 

Displays the hierarchy of ducking source to duck targets. Priority levels are displayed in tree 
fashion. Input channels that are targets being ducked by a source are shown as indented 
below the source. Any input channel displayed in the tree is an active link. Click an input 
channel to select that channel as the current source. The current source indicator (a) reflects 
the selected input channel.

f Settings: 

Used to configure the parameter settings for the ducker source. When a ducker block is 
copied, these settings are transferred.

Threshold — Sets the input signal level, in dB, the ducking source must exceed before 
ducking begins. If ducking does not occur quickly enough to avoid loss of speech or program 
material from the ducking source, decrease this setting. If ducking occurs too soon, allowing 
background noise to trigger ducking, increase the setting.  
The range is -60 to 0 dB in 1 dB increments. Default is -30 dB.

a

b

e

f

c d
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Attack Time — Adjusts the time to duck the targets once the threshold is exceeded.  
The range is 0 to 3000 milliseconds in 1 millisecond increments. Default is 1 millisecond.

Hold Time — Determines the time, in milliseconds, after a ducking source signal drops 
below the threshold before ducking ceases.  
The range is 0 to 10000 milliseconds in 1 millisecond increments. Default is 
1000 milliseconds (1 second).

Release — Determines how long, in milliseconds, after the ducking source level is below 
the threshold and the hold time is met, the ducking targets take to restore signal levels. 
The range is 10 to 10000 milliseconds in 1 millisecond increments. Default is 
1000 milliseconds (1 second).

Priority 

In some cases, multiple levels of ducking may be required enabling an input source to 
take precedence over all but one other input. 

In this example, Inputs 2-6 are set to duck when Input #1 has a signal above the ducking 
threshold. Input #2 is set to duck inputs 5-6. Since Input #1 has previously been set to 
duck Input #2, Input #1 is disabled (grayed out) to prevent contradictory priorities.

Figure 34.	 Ducker Configuration, Input Priority

Notice the priority tree on the right. The inputs are arranged by their priority status. Input 
#1 has all other ducked inputs under it, therefore if a signal is detected, it will trigger Inputs 
2-6 to duck. If Input #2 detects a signal and there is no signal on Input #1, Input #2 will 
trigger inputs 5-6 to duck. However if the Input #1 signal exceeds the threshold, it will 
then duck all inputs including Input #2. 

NOTE:	 Ducking attenuation is not additive. When an input target is ducked, 
regardless of how far down the priority line it is, the maximum attenuation is that 
set for the individual input and virtual send in the “by:” column near the center of 
the dialog box.

See “Ducker Tutorials” on page 55 for additional information.
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To set an additional ducking source:

1.	 Insert a ducking processor on the additional ducking source. 

In this example input #2 will be the second ducking source, with input #1, as shown 
above, as the first source. 

NOTE:	 Since it was previously selected as a 
ducking target, Input #1 will not be available 
as a target of Input #2.

2.	 Open the ducking dialog box for the input and select 
the desired duck targets. In this example inputs #5 
and #6 are the ducking targets of input #2.

Any signal on input #2 that exceeds the 
ducking threshold will now duck inputs 5-6. The 
ducking targets may be changed at any time by 
double‑clicking the input #2 ducking processor block. 

Since input #2 is a target of input #1, if a signal on 
input #1 exceeds the ducking threshold, inputs 2-6 
will still be ducked regardless of whether the signal on 
input #2 exceeds its ducking threshold.

NOTE:	 No input will be ducked more than the 
amount set in the “by(dB):” box.

Ducker Tutorials
The examples below are based on different input configurations. Insert a ducker from a 
ducker processor block using one of the following methods: 

Double-click the block, 
then click “Ducker”

Right-click the box to open context
menu, then click “Insert Ducker”

-or-

Once inserted, double-click on the ducker block to open the ducker configuration dialog 
box. The Enable Mic/Line Source box will be checked. 

Ducking and Priority Ducking
The first inserted mic will duck all selected targets. 

To set a ducking source:

1.	 Insert a ducking processor to input #1. 

2.	 Open the ducker configuration box and select the 
desired duck targets. In this example inputs #2-6 
are the ducking targets. 
Any signal on input #1 that exceeds the ducking 
threshold will now duck inputs 2-6. 

The ducking processor also provides a means to have 
an additional input duck other targets using the Priority 
feature. The second input ducks its selected duck 
targets, and can also be ducked by the first ducking 
source. 
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Automix (AM)
An automixer manages multiple microphone sources, gating or varying input gain 
automatically. When properly set, the automixer system will improve use and performance 
when multiple mics are in use. The two basic types of automixer include gated and 
gain-sharing. 

A gated automixer attenuates an input channel when the signal level drops below a user-
defined threshold. DSP Configurator allows the user to divide these auto mixers into 
gating groups. Each gating group is effectively a separate automixer. 

A gain sharing automixer sets a maximum room gain and splits this among all open mics, 
based on their input levels. While a gain sharing mixer will typically have less delay in 
reacting to a speaker, gated automixers will normally produce a better noise floor.

The DMP 128 allows the user to choose between a gating automixer and a gain sharing 
automixer. When the number of open mics (NOM) is set to zero, the automixer is 
gain‑sharing. When a NOM value is provided, the automixer is gated.

The DMP 128 uses an automix dialog box to configure the parameters of each channel 
and select an AM group.

Automix parameters:

•	 AM Group (Assignment) — 
Assigns the channel to a gating 
group.  
Selections are 1 – 8. Default is None. 

•	 Show AM Group Details  — 
Accesses a popup dialog box that 
details all current groups and the 
input assignments to each (see the 
following section).

•	 Last Mic Mode On/Off — prevents 
all mics from gating off at the same 
time, ensuring there is always one 
active mic channel. There are four 
possible states:

•	 If not enabled on any mic input, all mics will gate off.
•	 If enabled on all mics, the last active mic will remain on.
•	 If enabled on one mic: 

•	 The enabled mic will remain active if it is active when all other mics gate off, 
or 

•	 If the enabled mic is not active, it will gate on when all other mics gate off.
•	 If enabled on some but not all mics, then: 

•	 If enabled on the last active mic, this mic will remain active, or 
•	 If not enabled on the last active mic, then the first enabled mic in the group 

will gate on.
•	 Chairman Mode On/Off — one mic or multiple mics may be set to Chairman under 

the Gating Priority list. When a chairman mic is gated on, all non-chairman mics are 
gated off to the Off Reduction level. 

•	 Current NOM — Displays the selection of the maximum number of mics that may be 
gated open at any time, per gating group. The setting can be changed using the AM 
Groups dialog box. Current NOM range is 1 – 12.

Gating Threshold
Indicator

Channel Level
(RMS)
Channel Level
Readout
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•	 Gate Threshold — The signal level below which the mic channel gates off and above 
which it gates on. 
Range is –60.0 dB to 0.0 dB.  
Default is –50.0 dB.

•	 Off Reduction — The channel attenuation when a mic channel gates off.  
Range is 0.0 dB to 100.0 dB attenuation (0 to –100 dB).  
Default: 60.0 dB.

•	 Attack Time — Sets the time at which gain is applied after a channel gates on. 
Range is 0.0 msec to 3000.0 msec in 0.1 msec increments.  
Default: 10.0 msec. 

•	 Hold Time — The time that a mic remains active after the signal drops below a 
user‑defined threshold.  
Range is 0.0 msec to 10000.0 msec in 0.1 msec increments. 
Default: 400.0 msec.

•	 Release Time — The time it takes to ramp the signal level to the Off Reduction 
value when the mic channel gates off.  
Range is 10.0 msec to 10000.0 msec in 0.1 msec increments. 
Default is 100.0 msec. 

•	 Gate Status Indicator and meter — The meter provides real-time sampling of the 
selected AM channel with a digital readout of the current level the meter. The indicator 
lights when the channel is shut off.

To insert an automix block into a channel:

1.	 Insert an AM processing block in the desired channel. 
Either: 

a.	 Right-click the AM block and select Insert 
Automixer,

b.	 Double-click the AM block and select Automixer.

2.	 Double-click the inserted AM block to open it (see “Automix parameters:” on 
page 56).

The AM block defaults to Bypass. Click the Bypass button to toggle the AM block to 
active.
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Automix Groups

Assigning individual automix channels to groups allows you to see and adjust all channels 
assigned to the group on one page. The automix group dialog provides details of all 
grouped and ungrouped inputs including the automix settings of each channel or mic. 
This allows viewing of all channels in the selected group at a glance to provide a overview 
of the group. Individual settings can be changed without leaving the groups dialog. You 
can also select all “Ungrouped items” and see the channels currently unassigned to a 
group.

Figure 35.	 Automix Groups Dialog

To Configure an Automix Group:

A channel must first have an active automix block before it can be included in an automix 
group.

1.	 Insert an AM processing block in the desired channel. Either 

a.	 Right-click the AM block and select Insert Automixer.

b.	 Double-click the AM block and select Automixer.

2.	 Double-click the inserted AM block to open it.

3.	 Select the group number from a range of 1 – 8.

4.	 Set the parameters for the channel.

5.	 Repeat steps 1 – 3 for all channels in the automix group.

6.	 Open any AM block and click Select AM Group Details to open the automix 
group configuration page.

7.	 Set NOM for the selected group.

8.	 Test the system and make adjustments as needed. 

Adjustments can be made to individual automix channels using the rows by opening 
each individually, or globally to all channels using the AM group details page. Observe 
Gate Status indicators to verify that channels gate on properly.

The AM Group Details dialog provides details of all grouped and ungrouped inputs 
including the automix settings of each channel or mic. This allows viewing of all channels 
in the selected group at a glance to provide an overview of the group. Individual settings 
can be changed without leaving the groups dialog.
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Pre‑mixer Gain (GAIN) 
The post-input processing gain control (also called the 
pre‑mixer gain) provides gain or attenuation post-processing 
gain block. It includes a mono long-throw fader with a –100.0 
to +12.0 dB gain range, and a current tlevel setting readout 
below the fader. Fader adjustments are in 1 dB increments, 
while adjustments can be entered manually to 0.1 dB 
resolution.  
Default is unmuted at unity (0.0 dB) gain. 

Selecting the fader handle with the mouse or clicking within 
the fader area brings focus to the fader. The input signal level 
can be adjusted using any of the following methods:

•	 Direct adjustment. Select and hold the fader handle, then 
drag it to desired level in 1.0 dB steps.

•	 Select or tab to the fader handle, then use the up/down 
arrow to set the desired level in 1 dB steps.  
Page Up/Page Down increases/decreases level in 5 dB 
steps.

•	 Click in or tab to the level readout field. Type a new value, then press <Enter> or 
<Tab> to another area.

Configuring an Automix Channel

Before configuring automix, it is recommended that proper gain staging is set for the input 
mics. This will ensure that adequate signal is provided for automix to work properly. 

An automix block should be inserted for each microphone, and the mic assigned 
to a group (see “Automix Groups Dialog” above). Setting a reasonable NOM for the 
microphone group will increase intelligibility by limiting the number of open mics that are 
allowed to gate on at once. A NOM of three is recommended. 

In events where a small number of talkers may need priority over other talkers (such as a 
presenter at a lectern) Chairman Mode can be enabled on the priority input channel. 

Last Mic Mode may be used to minimize the frequency of gate changes. This helps to 
prevent rapid switching of input mics by, ensuring that a talker is not gated off when their 
speech is paused.

After the automixer is configured, be certain to set the appropriate mix‑points to include 
automixing.

Fader Handle

Input
Signal Level 
Readout
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Line Output Channels
There are eight mono Line Output channels. Controls and processing blocks, identical for 
each output channel, are described in the following sections. 

Post-mixer Trim Control (TRIM) 
The post-mixer trim control provides a fader for fine adjustment of the 
program material prior to the output signal chain. The trim control has 
a range of –12 dB to +12 dB in 0.1 dB increments. 

Default is unmuted at unity (0.0 dB) gain.

Loudness (LOUD)
The loudness processor block, when inserted, applies 
a filter compensation curve to the signal in an inverse 
relationship to the output volume control setting; the 
higher the output volume setting, the less compensation is 
applied  
(see “Calibrating Loudness” on page 61).

The loudness processor compensates for changes in human perception to varying volume 
levels by applying a filter compensation curve to the signal in an inverse relationship to 
the gain control setting. The higher the gain setting, the less loudness compensation is 
applied. Generally, as volume is lowered, perception of certain frequencies is progressively 
diminished, returning to a more flat response as volume is increased. Loudness will boost 
those diminished frequencies to the highest degree at low volume levels, decreasing the 
boost as volume increases.

Bypass must be disengaged for the loudness processor to function. The bypass button 
is red when engaged (loudness control defeated), and gray when disengaged (loudness 
control active). 
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When bypassed, the graph displays the current filter curve as a dotted line. When bypass 
is disengaged, the current filter curve is displayed as a solid line.

Figure 36.	 Loudness Dialog Dialog box

The Loudness dialog box contains the following elements:

1.	 Graph — displays the compensation curve being applied to the signal. These curves 
are read-only, and are not adjustable from the graph.

2.	 Compensation Adjustment slider — from a center zero-point, the user can slide to 
the left for less loudness compensation (filter curve is reduced), or to the right for more 
(filter curve is increased). The slider position is translated into a dB value, displayed in 
the compensation readout box contained in the Advanced Calibration section. The 
slider has a 48 dB (±24 dB) range. 

3.	 Advanced Calibration — The calibration box provides a value that corresponds 
to the position of the compensation adjustment slider. The SPL box displays the 
summed value of the slider and the preceding trim control.

Calibrating Loudness

The user may fine-tune the amount of loudness compensation using the compensation 
adjustment slider and adjusting “by ear,” or by measuring SPL levels in a particular room, 
then using the slider to adjust the loudness filter relative to the SPL of the room and 
system gain structure.

Before calibrating loudness, set up the system gain structure (see “Optimizing Audio 
Levels” on page 101). A pre-recorded track of pink noise or pink noise from a signal 
generator is preferable for this purpose. Program material may also be used (using familiar 
material is recommended). 

If using a signal generator set it to output –10 dBu, then set the input gain of the 
DSP Configurator so the input meter reads –20 dBFS. If using a recorded source the pink 
noise should be recorded at –20 dBFS and the player output level setting control set to 
maximum, or 0 dB of attenuation. For program material, set the input level to meter at 
approximately –15 dBFS, with peaks safely below 0 dBFS. 
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Unmute the mix‑point from the pink noise source to the output connected to the room 
amplifier being calibrated. With the basic gain structure previously set up, loudness can be 
calibrated using an SPL meter or by ear. (Loudness can also be set using an SPL meter, 
then fine-tuned by ear.)

To calibrate loudness, use a sound pressure level meter set to “C” weighting: 

1.	 Set the Loudness processor to Bypass (Bypass button red).

2.	 Place the meter in an average (but somewhat prominent) listening location. 

3.	 Generate pink noise, or start the program material playback.

4.	 Measure the SPL in the room. 

5.	 In the loudness dialog, adjust the slider until the value in the “SPL” readout box 
matches the reading on the SPL meter. 

NOTE:	 Theoretically, calibration can be performed with the output channel volume 
and post‑mixer gain level set to any comfortable listening level. But a relatively 
loud volume (well above the ambient noise in the room) that can be easily 
measured is preferred. 

Loudness is now calibrated. Disengage Bypass to hear the compensation.

Alternate method to calibrate loudness:  

1.	 Set up the procedure using steps 1 – 3 of the previous procedure.

2.	 Set the compensation adjustment slider to its default center position. 

3.	 Set the output channel volume fader to 0 dB (100% volume). 

4.	 Adjust the amplifier until the SPL meter reads 90 dB. 

Loudness is now calibrated. This method works if 90 dB is an acceptable amplifier/
volume limit for the room. 

Setting Loudness “By Ear”

When setting loudness by ear, it is essential the system gain structure be set up first. Sit in 
an average (but somewhat prominent) listening location. 

1.	 Set the loudness processor to Bypass.

2.	 Set the output volume fader in the DSP Configurator to a relatively quiet listening level. 
Filter compensation from the loudness processor is most prominent at low listening 
levels. Use familiar program material set to the levels described earlier.

3.	 The Calibrate slider should be set to 0, the center point. Disengage the loudness 
Bypass. The result will be a moderate enhancement to the program material, with 
more accentuated bass frequencies (below 500 Hz), and more brightness in the 
high frequencies that carry harmonic content (above 7 kHz). Engage and disengage 
the Bypass switch in order to “A/B” the difference between loudness off and on, 
respectively. 

4.	 To experiment with less loudness compensation, move the loudness compensation 
slider to the left (less). For more loudness compensation, move the slider to the right 
(more). 

5.	 Any adjustment made to the loudness compensation slider will carry through to all 
listening levels. Set the output volume fader in the DSP Configurator to a relatively 
loud listening level. 

6.	 Engage and disengage the Bypass switch in order to “A/B” the difference between 
loudness off and on. At a loud listening level, the difference should be minimal or 
barely perceivable.
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Delay Block (DLY) 
The delay processor block, when inserted, provides 
a means to delay the audio signal to compensate for 
loudspeaker placement in situations where speakers 
delivering the same signal are much farther away than 
others. The delay processor block is identical to the delay processor available on the 
input and described in (see “Delay (DLY)” on page 51). Typically the near speakers 
would be delayed so that audio delivery time matches the speakers further away.

Filter Block (FILT) 
The filter processor block, when first inserted, provides one of four 
filter selections: High Pass, Low Pass, Bass & Treble filters and 
Parametric EQ. Up to nine filters can be added to each filter block. 
The output filter block is identical to the input filter processor block 
except that up to nine filters total can be selected (see “Filter 
(FILT)” on page 32).

NOTE:	 Selecting the Bass & Treble Filter inserts two separate filters.

Dynamics block (DYN) 
A dynamics processor block, when inserted, 
provides one of four dynamics processors: 
AGC, Compressor, Limiter, and Noise Gate. 
The available processors are identical to the 
processors available on the input dynamics 
processor block and described in (see 
“Dynamics (DYN)” on page 46).
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Volume Control (VOL)  
Each output channel volume block provides a mono long‑throw 
fader with a range of 0 to 100 dB of attenuation, and a volume 
setting readout (in dB) below the fader. Volume level is adjustable 
with the slider or by entering the desired level directly into the 
volume setting readout in 0.1 dB increments. 

Clicking the fader handle or clicking within the fader area brings 
focus to the fader. The input signal level can be adjusted using any 
of the following methods:

•	 Direct adjustment. Click and hold the fader handle, then drag it 
to desired level in 1.0 dB steps.

•	 Click or tab to the fader handle, then use the up/down arrow 
to desired level in 1 dB steps. Page Up/Page Down increases/
decreases level in 5 dB steps.

•	 Click in or tab to the level readout field. Type a new value, then 
press <Enter> or <Tab> to another area.

Output polarity switching is also provided with a button that toggles 
polarity. 

The default setting is unmuted, at 0 dB attenuation. A peak meter displays the real‑time 
audio level from – 60 to 0 dBFS. 

The OK button accepts settings and closes the dialog with a single click, while the Cancel 
button ignores changes and closes the dialog.

The output volume control provides level control for each output. The output control is a 
trim control adjustable from –100.0 to 0 dB. The default setting is unity gain (0.0 dB).

The Polarity button, accessible in the dialog box, allows the polarity of the wires 
connected to the audio connectors (+/tip and -/ring) to be flipped in order to easily correct 
for miswired connectors.

The Mute button, accessible in the dialog box, allows the post-meter audio output to be 
silenced. When the audio output is muted, the mute button lights red, and red indicators 
in the block turn on. 

If the output has been grouped with other inputs or outputs, the group number will be 
indicated on the right side of this button (see “Line Output Channels” on page 60).
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Virtual Bus Returns
There are eight mono virtual bus return inputs, fed by the virtual bus sends. Channel 
controls and processing blocks described in the sub-sections that follow are identical for 
each virtual bus return channel. 

The eight returns are divided into two similar paths. Channels A-D contain a feedback 
suppression processing block in each channel. Channels E-H are identical to A-D except 
there are no feedback processing blocks.

Virtual Bus Returns, A-D

The virtual bus is used when additional processing of an input signal is required. It is also 
useful to apply identical filtering, dynamics processing, loudness compensation, or signal 
gain/attenuation to multiple inputs.

Feedback Suppressor (FBS)
The Feedback Suppressor (FBS) is used when there is indication of feedback during 
live operation. Dynamic filters automatically detect feedback on a live mic channel, and 
engage a set of up to five fixed and 15 dynamic filters to counteract the frequency peaks 
at the detected feedback frequency. Up to 15 separate filters may be employed at any 
time. The 15 filters act in a FIFO, or first in, first out rotation. If all 15 filters are employed, 
when an additional feedback frequency is detected it will overwrite the first detected 
feedback frequency and so on. 

To avoid a new feedback frequency overwriting a previously detected one, up to five of the 
dynamic feedback frequencies can be placed into fixed filters. Once written into the fixed 
filters, the feedback frequency can only be overwritten by the user manually writing a new 
frequency to the filter. 

The FBS dialog box has three tabs;  Settings, Dynamic Filters and Fixed Filters. 
Global settings and view options are controlled from the settings tab. Dynamic to fixed 
filter allocations are handled from the dynamic filters tab. Filter parameters can be 
modified from the Fixed Filters tab. 
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The FBS dialog box provides the following global buttons: 

•	 Clear All — clears all dynamic filter settings.

•	 Lock — locks the dynamic filters to current settings, preventing automatic updates. 
This temporary mode is useful while testing the system, or during the time when 
dynamic filters are being converted to fixed filters. When the FBS dialog box is closed, 
lock mode is automatically disengaged.

•	 Bypass FBS — turns off feedback detection when engaged (button is red). Only the 
dynamic filters are bypassed. Fixed filters remain active.

•	 Set Defaults — Click once to return the FBS to default settings. 

Figure 37.	 Feedback Suppressor

 

DMP 128 • Software Control 66



FBS Settings Tab

The settings tab enables selection of the feedback suppressor parameters. 

•	 For Composite View show: — the graph view is set by one of three radio buttons: 

•	 Only Dynamic FBS Filters

•	 Only Fixed FBS Filters

•	 Dynamic & Fixed FBS Filters (default)

•	 Mode: Q — adjusts the notch filter Q used by dynamic filters. Similar to Q on the 
parametric equalizers, Q changes the bandwidth of the filter. The default setting can 
be modified in Tools > Options. The range is from 5 to 65. Larger values provide 
less change to the audio frequency response while lower values may provide greater 
feedback suppression but with more possible impact to the tonal response of the 
source audio.  
Suggested values for specific applications are:

Q Value Application

7 Voice with considerable feedback potential

30 Voice with less feedback potential 

65 Music with minimal feedback potential

•	 Attack Time — sets the time at which dynamic filters are generated after feedback 
detection. A longer attack time (greater than 200 ms) reduces the chance that music 
or audio content will trigger the dynamic filters to respond. A shorter attack time (less 
than 2 ms) reduces the time between when feedback is detected and suppressed.

•	 Hold Time — expressed in hours:minutes:seconds up to 9 hours. Hold time sets 
the time a dynamic filter setting persists before the filter is cleared. When hold time is 
disabled (checkbox cleared) dynamic filters persist indefinitely unless cleared manually 
or the device is power cycled. 

Figure 38. FBS Settings Tab
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FBS Dynamic Filters Tab

This tab contains the fifteen dynamic filters, with a scroll bar to display filters hidden due to 
the dialog box size. 

Dynamic filters are notch filters that are cut only, providing attenuation up to 30 dB at the 
specified Q. The default Q is set in the Tools > Options menu, but can be changed on 
the settings tab prior to engaging the FBS dynamic filters. Changing the Q setting after 
dynamic filters have been generated will clear all dynamic filters.

Figure 39.	 FBS Dynamic Filters Tab

Frequency and cut values are read only. Dynamic filters are in auto-detect mode when the 
FBS block is active (when Bypass FBS is off). If testing reaches a point where no further 
changes are desired, the lock button may be engaged. The lock mode of operation is 
temporary, and is intended to be used during setup of the FBS. When the FBS dialog box 
is closed, lock mode is automatically disengaged.

If there are specific dynamic filters the operator wants to assure are not overwritten, press 
the Move to Fixed button to write the designated filter settings to the first available filter in 
the Fixed Filter tab.

NOTE:	 When a dynamic filter setting is moved to the fixed filter, it will automatically 
clear that frequency from the dynamic filter. 

The Clear button will remove a detected frequency from the corresponding dynamic filter. 
A cleared filter reverts to auto-detect mode unless Lock mode is engaged.
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FBS Fixed Filters Tab

Fixed filters are notch filters with an adjustable center frequency and Q, and up to 30 dB 
of cut. The fixed filters are typically set by converting dynamic filters to fixed, however 
adjustments to filter parameters can be manually made from the Fixed Filters tab.

Fixed Filters are inactive and the filter type is set to “Unused” by default. 

Figure 40.	 FBS Fixed Filters Tab

No filter parameters are displayed when the filter type is set to Unused. As a filter is 
moved to the fixed filter tab from a dynamic filter, the filter becomes active and displays 
Notch as the filter type. The parameters copied from the dynamic filter are displayed in 
the same line. Once a fixed filter is active, settings can be modified or adjusted if needed. 
Fixed filters can also be individually bypassed by clicking the Bypass button.

FBS Settings Ranges and Fixed Filter Defaults

FBS Parameter Settings Range Default Setting

Frequency 20 Hz to 20 kHz N/A

Q 5.000 to 65.000 30.000

Attack Time 0.0 ms to 1000.0 ms 10.0 ms

Filter Hold Time 0 seconds to 9 hours 00:00:00; Disabled

Fixed Filter Parameter Settings Range Default Setting

Frequency 20 Hz to 20 kHz 1000.0 Hz

Q 1.000 to 65.000 30.000

Cut Up to 30 dB cut 0.0 dB
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Filter (FILT)
Filter function and interface is identical to the mic/line input channel Filter block except 
that only three filters are provided (see “Filter (FILT)” on page 32).

Dynamics (DYN)
There is one dynamics processor block available on each virtual path. Dynamics function 
and interface is identical to the mic/line input channel Dynamics block,  
(see “Dynamics (DYN)” on page 46).

Loudness (LOUD)
There is one loudness processor available on each virtual path. The loudness function and 
interface is identical to the Output channel Loudness block (see “Loudness (LOUD)” on 
page 60).

Bypass must be disengaged for the loudness processor to function. The bypass button 
is red when engaged (loudness control defeated), and gray when disengaged (loudness 
control active). 

Delay (DLY)
Audio Delay is used to sync audio to video or to time-align speakers that are placed at 
different distances from the listener. The Delay function and interface is identical to the 
input channel delay block (see “Delay (DLY)” on page 51).

Gain (GAIN)
Each virtual input channel gain block provides a mono long-throw fader with a –100.0 
to +12.0 dB gain range, and a level setting readout below the fader. Fader behavior is 
identical to the Pre-mix‑point gain block, described in the mic/line input section  
(see “Pre‑mixer Gain (GAIN)” on page 59). Fader adjustments are in 1 dB 
increments, while adjustments can be entered manually to 0.1 dB resolution.  
Default is unmuted at unity (0.0 dB) gain.

Virtual Bus Returns, E-H
There are four additional mono virtual bus return inputs, also fed by the virtual bus sends. 
Virtual Bus Returns E-H are identical to A-D except there are no feedback processors. 

As with the virtual bus returns A-D, these returns are used when additional processing of 
an input signal is required. It is also useful to apply identical filtering, dynamics processing, 
loudness compensation, or signal gain/attenuation to multiple inputs.
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Output Mix Matrix
The DSP architecture contains an output mix matrix that connects all inputs to the line 
outputs, a virtual send mix matrix that connects all inputs to the virtual bus sends, and 
an expansion (EXP) output mix matrix that connects the mic/line inputs and virtual bus 
returns to the expansion bus sends (see figure 41 on the next page). 

The DSP Configurator GUI provides control of the output mix matrix, used to set mix 
levels from the post processing inputs and post processing virtual returns, to each line 
output bus. The mix-point GUI behavior is shown in the table on page 73.

Each mic/line input and virtual bus return is connected to a mix‑point for each of the eight 
line outputs. In general, mix levels are set relative to each other, achieving a desired blend 
of input signals at an optimal output level, close to, but not exceeding 0 dBFS at the line 
output Volume block level meter (while accounting for processing that may occur in the 
line output signal chain). 

NOTE:	 Although the virtual bus send and return lines, A-H, are shown as end points 
in the GUI, they are connected A-A, B-B, C-C, D-D, E-E, F-F, G-G and H-H. 
Those connections cannot be changed.
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Virtual Send Bus Expansion Outputs1     2     3     4      5     6     7      8  

Expansion Outputs1     2     3     4     5     6     7     8  

1     2     3     4      5     6     7      8  

A     B     C     D     E     F     G     H  1     2     3     4     5     6     7     8  

9

10

11

12

13

14

15

16

A     B     C     D     E     F     G     H  

Inputs

Virtual Returns

Expansion Inputs

Outputs

1 - 8

9 - 16

Output 
Mix Matrix

Virtual Send
Mix Matrix

Expansion Bus
Mix Matrix

Figure 41.	 Overview of DSP 128 Mix-matrix
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Mix‑point GUI Behavior:
Mix-point color — There are three colors of mix-points:  

•	 Teal indicates standard processing (default), 

•	 Orange indicates the signal chain also includes an auto‑mix channel 
and,

•	 Green indicates that all signal processing has been bypassed. 

No mix information — a faint circle (teal, green, or orange) on the 
mix‑point indicates it is muted (contains no mix information).

Mix information — a solid circle indicates the mix‑point contains mix 
information (the mix-point is unmuted).

Mouse-over — the cursor changes to a hand when a mouse‑over occurs 
at a mix‑point whether the mix‑point contains mix information or not.

Single-click — a single click brings focus to (selects) the mix‑point, 
indicated by a dark green outline around the circle.

Double-click — opens the mix‑point dialog box. The focus outline turns 
light green to indicate the open dialog box. If the mix‑point is muted, the 
mix‑point circle is gray and the Mute button in the dialog box will be red. If 
unmuted, the bubble is teal and the mute button in the dialog box is normal 
(typically gray for most color schemes).

Multiple open dialog boxes — When multiple mix‑point dialog boxes 
are open, the mix‑point for the most recently opened dialog box receives 
the light green focus circle, while previously opened dialog boxes relinquish 
their focus. Focus can be returned by either clicking on a previously 
opened dialog box, or by double‑clicking on a mix‑point.
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Clicking a mix‑point brings focus to that mix‑point. A circle appears around the teal 
mix‑point which remains transparent. Double-clicking a mix‑point opens a configuration 
dialog box with the following components:

•	 Mono Fader — Sets the signal level from the 
selected input to the output bus. Gain range is -35 dB 
to +25 dB. Fader behavior is identical to the input 
channel gain block described in the mic/line input 
section with the exception that course adjustment 
(Page Up/Down) increases/decreases in 5 dB 
increments.

•	 Mute — Mutes and unmutes the signal to the output 
bus. The mix‑point ball is transparent when muted 
(Mute button red) and solid when unmuted.

•	 No Input Processing — When checked, bypasses all 
processing for the preceding gain string. This allows a 
direct comparison of sound between the unprocessed 
signal and fully processed. The mix‑point turns green 
when unmuted and transparent green when muted. 
Default is cleared.

•	 Include Automixing — When checked, includes 
the automix channel input. Default is cleared, muting 
the automix channel input. The mix‑point turns solid 
orange when unmuted and transparent orange when 
muted. 

•	 OK/Cancel — click OK to accept changes and close the box. Cancel ignores 
changes and closes the dialog box.

The title above the fader reflects the input and output channel names for the mix‑point. 
The example on the left is the Input #1 to Output #1 mix‑point set to 0.0 dB. 

The input level text below the mute button indicates the input level setting for the input 
gain control of the selected input signal path, in this example 6 db.

Only when the mix‑point is unmuted does the circle become solid.

NOTE:	 The No Input Processing and Include Auto‑mixing buttons are 
mutually exclusive. You cannot select both. If you are including an automix 
channel in the signal path, when you select No Input Processing, Include 
Auto‑mixing will clear and not turn back on even when No Input Processing 
is unselected. If you want to continue to have an automixing channel in the signal 
path, it must be selected again.

 

DMP 128 • Software Control 74



Mix-point Examples
In order to better understand how the mix‑points work, the following diagrams provide 
examples of mixes. 

NOTE:	 To simplify the diagrams not all input and output lines are shown. 

Figure 42.	 Input 1 to Output 1

In the first example (see figure 42) input audio from Mic/Line Input 1 is processed and 
arrives at the output matrix mix‑point. A double-click on the mix‑point opens the dialog 
box. When the mix-point is unmuted on Input 1 of the output mix‑point, the mix junction 
turns teal with a light green circle to indicate the open mix‑point dialog box is the focus, 
and the signal is routed to Output 1. 

The mix level can be adjusted using the slider or by direct input of a value between –35.0 
and 25.0 dB into the dialog box below the slider.
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Figure 43.	 All Inputs to Output 1

In the next example (see figure 43), input audio from all twelve mic/line inputs are 
processed individually and arrive at the output mix‑point. When the individual mix‑point 
mute buttons are released, the output mix‑point junctions turn teal, and the signals 
are routed to Output 1. Since all the signals are now on output signal line 1, open the 
individual mix‑point dialog boxes to adjust signal levels for the desired balance. Open the 
output trim, processing, or volume to change the signal levels or effects for the mixed 
signals coming from the mix-points. 

In this manner any single input, or any number of inputs can be routed to any single 
output or any number of outputs.
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Figure 44.	 Input 1 to All Outputs

In the example in figure 44 above, Input 1 has been routed to all eight outputs by 
unmuting the mix‑point for mic/line Input 1 for each output (1 – 8) bus. The example in 
figure 44 also shows mix-point four with input processing bypassed (green) and mix-point 
eight with active automix.  
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Virtual Send Bus Mix Matrix
The DSP architecture contains a virtual send bus mix matrix that connects the 
mic/line inputs and virtual bus return signals to the virtual bus sends. There is an additional 
mix matrix to route EXP input signals to the virtual bus sends. 

The DSP Configurator GUI provides control of the virtual bus mix matrix, used to set levels 
from input signals to the virtual bus sends. Each of the twelve mic/line and eight virtual 
return inputs are connected to a mix‑point for virtual bus A-H (and the EXP inputs). Each 
mix‑point is muted and set to 0.0 dB (unity gain) by default. In general, mix levels are set 
relative to each other, achieving a desired blend of input signals at an optimal level close 
to, but not exceeding 0 dBFS at the output volume level meter. 

The secondary mix matrix contains a section (see figure 45 below) that allows virtual bus 
returns to be routed back to the virtual bus matrix to allow further processing using an 
additional virtual bus processing block. To prevent feedback loops, a virtual channel is 
prevented from being routed back to itself by eliminating the mix‑point that would allow 
that to occur. 

In situations requiring extra processing, the virtual bus return output is routed back to the 
virtual bus mix matrix, virtual bus send, which then routes the signal back to a processing 
signal chain other than the one it was routed from.

Virtual Send Bus Mix-points
(from Mic/Line Inputs)

Virtual Send
Bus Mix Matrix

Virtual Send Bus Mix-points
(from Virtual Bus Returns)

EXP Inputs to Virtual Bus 
Sends

Figure 45.	 Virtual Bus Mix Matrix (EXP inputs 9-16 not shown)
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In the example in figure 46 below, Input 1 is sent to the virtual bus send by muting all eight 
signals on the Input 1 output mix‑points. The virtual bus now serves as additional signal 
processing for the input. The signal routes from virtual send A and through virtual bus A 
signal chain before being sent to the virtual bus return mix‑point and Output 1.

This configuration is useful when more than one input requires identical processing. 
For example if all inputs were normalized but required a uniform gain to bring them up 
to adequate output levels, rather than changing each pre-mix gain control by a similar 
amount, all twelve inputs could be routed to a virtual bus (in this case virtual bus A). Then, 
using the virtual bus A return gain control, a single adjustment can be used to apply the 
same gain to all twelve inputs before sending the signal to the desired output line.

In other cases, if multiple mic inputs are being mixed with program material, only the 
program material might require loudness contouring. So the mics could be routed directly 
to the output but the program material input could be routed to the virtual bus return 
where loudness contouring could be applied. The program material could then be routed 
to the same output as the mics. 

Figure 46.	 Input 1 to Virtual Bus A
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Expansion Bus Mix Matrix
The DSP architecture contains a third mix matrix that supports connection and control 
of a second DMP 128 using the included shielded Cat 6 cable. The bus connects the 
mic/line inputs, virtual sends, and virtual returns to the expansion bus sends and returns. 
The DSP Configurator GUI provides all necessary control of the mix matrix.

Expansion Outputs
Mix Matrix

Inputs to
EXP Sends
(Outputs)

Virtual Returns
to
EXP Sends
(9-16 only)

Exp Inputs
to
Outputs

EXP Inputs
to
Virtual Sends

Figure 47.	 Expansion Bus Mix Matrix (EXP bus outlines 9-16 not shown)
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Multi-device Digital Audio I/O

Extron EXP Bus

A digital audio connection to an external DMP 128 is supported through the rear panel 
EXP port using the expansion bus mix matrix. The expansion bus mix matrix can route 
any or all of the mic/line inputs and virtual returns to the expansion outs (1-8) with eight 
additional channels (expansion outs 9-16) directly connected to the virtual bus returns. 
The expansion outputs use an Extron proprietary protocol to exchange audio channels 
with another device using the same Extron protocol.

Multi-channel audio on the 16-channel expansion out bus may be processed and used by 
the connected DMP 128 then returned to the sixteen (16) input expansion bus return. 

The expansion bus may also be used for AEC reference. Expansion inputs can include 
automix processing, and be included in a gating group.

Only one device can be shown in the DSP Configurator screen at any time. There are two 
ways to configure the two devices; switch between the two using the device manager 
described above, or open a second DSP Configurator dialog box and connect it to the 
second device. 

Device Manager
When two DMP 128 devices are connected using the EXP bus, the tools menu is used to 
configure the connection. 

By default, the DMP 128 is configured as the primary device. One of the two connected 
DMP 128 devices must be set as a “secondary unit”. To change the active device in the 
DSP Configurator dialog box to secondary, use the >Tools>Expansion Bus menu and 
select primary or secondary. A checkmark appears beside the active device.

From the menu bar, select Tools>Device Manager to open the device manager dialog 
shown in figure 48.

abc d

Figure 48.	 Device Manager Dialog

The icons function as follows:

a	 Add Device – Brings up the initial DSP Configurator dialog box that allows the 
selection of the model number of the secondary device.

b	 Clone Device – Provides the option to duplicate the primary device configuration to 
the connected secondary device.

c	 Delete Device – Deletes the highlighted device

d	 Expand or Collapse Device – If the device connection tree is collapsed, allows it to 
be expanded. If the device tree is collapsed, expands it.

The icons for the devices will be grayed out if the device is offline.
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Group Masters
There are 32 Group Masters that can each be configured to simultaneously control up 
to 16 group members. Group masters are configured in the DSP Configurator program 
and are saved in the device. Working in emulate mode, group masters can be saved in a 
configuration file and pushed to the device upon connection. 

A group master can either be a gain control or a mute control. Only one control type 
can be selected as group members for control by a group master. For example, a group 
master can be configured to control post-matrix gain levels, but not post-matrix gains plus 
input gain block. A group member can, however, be controlled by multiple group masters. 
It is recommended this feature be used cautiously, as “overlapping” membership can 
quickly become unmanageable. 

Group master gain controls can send specific values, such as those sent by a fader 
control. Group master gain can also be set by increment/decrement. For information on 
using increment/decrement controls within the DSP Configurator software  
(see “Tools” on page 86). 

Group Members
Once a group has been created, the group members — the individual controls that 
comprise the group update to indicate they are now part of a group. group members can 
still be controlled individually, allowing for relative levels between group members to be 
fine‑tuned. Group Member levels can also be set by a preset recall.

Grouped Controls
Grouping is convenient when multiple controls require muting at the same time or when 
multiple signal levels need to be increased or decreased simultaneously. For example, in a 
system with several audio outputs dedicated to a single room, the operator may want all 
outputs to change at the same rate and at the same time. The Output 1 through 4 volume 
controls can be grouped into a master that controls the volume throughout the room.

For further flexibility, individual volume controls in the group can be set for an output level 
based on its use. When the group fader is moved, all four output control faders move in 
tandem while retaining their levels relative to each other.

Grouped faders move together at relative levels to the top or bottom of their travel (see 
figure 49, next page). If one fader reaches the limit of its travel first, it retains that position 
while the other faders continue to travel. When the grouped faders travel in the reverse 
direction, the fader that was at its limit reverts to its position relative to the other faders. 

NOTE:	 If a block was previously muted when the group mute is activated, that block 
remains muted when the group mute is released.

TIP:	 When including a control in multiple groups, do so with care. Overlapping group 
membership can quickly become unmanageable. Use presets to set individual 
faders to known levels.
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Figure 49.	 Sample Fader Group Master and Associated Gain Controls

Mute controls within the blocks can also be grouped (see figure 50). 

Figure 50.	 Sample Mute Group Master and Muted Outputs
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Configuring a Group Master
Configure a group as follows:

1.	 Click Tools > Configure Groups (see figure 49 on previous page) to open the 
Configure Groups dialog box. 

or click View > Group Controls and then click the Add a Group menu selection.

2.	 In the Select Group drop-down box, click a group to select it (see figure 51). The 
list defaults to the first empty group. Select an empty group if necessary, or select an 
existing group to overwrite.

Figure 51.	 Configure Groups Add Group Dialog Box

NOTE:	 <empty> groups have no group members assigned. Numbered groups 
(such as <Group #1>) have controls assigned that may be overwritten if selected.

3.	 In the Select Control Type section, expand the tree for the type of control, Gain 
or Mute, then select the desired control type. When a selection is made in the Select 
Control Types section, the Available Group Members section populates with all 
possible members for the selected control type. 

NOTE:	 Potential group members in step 4 that are already assigned to a 
different group are displayed in blue.

4.	 In the Available Group Members section, make appropriate selections by clicking 
the checkbox(es). When a + sign exists, click to expand the tree and select individual 
controls. Up to 16 group members may be added.

5.	 Click the Apply button to create or configure the group.

6.	 Repeat steps 2 through 5 to create or configure up to 32 groups.

7.	 Click the Close button to exit the configure groups dialog box.
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Deleting a Group Master
To delete a group:

1.	 Click Tools > Configure Groups (see figure 52, below) to open the configure groups 
dialog box 

or click View > Group Controls and then click Add a Group.

2.	 In the Select Group drop-down box, click a numbered group (such as "Group #1") 
to select it.

3.	 Click the Delete Current Group button in the lower left area.

4.	 Click Yes in the Confirm Deletion dialog box.

Viewing and Using a Group Master
Click View > Group Controls to open the group controls dialog box (see figure 52). The 
group controls dialog contains two menu items:

•	 Add a Group allows you to add additional groups.

•	 Tools enable you to perform various functions from the group controls dialog box.

In addition, once groups are created a single mute button or a group fader plus the 
current setting readout and any soft limits that have been set are visible.

Figure 52.	 Group Controls Dialog Box

The group fader controls function as follows:

•	 Slide a group fader up and down to adjust all gain controls in the group.

•	 Click and drag a soft limit ( ) to set the ceiling and floor for the group.

NOTE:	 Soft limits cannot be dragged beyond the current setting of the group 
fader.

Add a Group
To launch the configure groups dialog box from group controls, click Add a Group. When 
a new group is added and the Add New Group dialog is closed, the group controls dialog 
box refreshes to display the added control.

NOTE:	 If a block is muted, that block remains muted when the group mute is 
released.
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Tools
The Tools menu (see right) contains these selections:

•	 Clear All Groups — clears all 
group members and group master 
parameters. Soft limits are also 
cleared.

•	 Increment/Decrement Simulator 
— allows the user to test increment/
decrement values (see below for 
more information)

•	 Refresh All Group Data — Updates 
group members and group master parameters.

•	 Group Details Report — generates a report, listing all group masters and membership 
(see next page for more details).

Increment/Decrement Simulator

The Increment/Decrement Simulator provides a control for increment and decrement, with the 
ability to set increment and decrement values. This control is temporary, since this value is not 
remembered in the device. 

To use the Increment/Decrement Simulator:

1.	 Select Tools > Increment/Decrement Simulator from the Tools menu.

2.	 Select the group to be controlled from the Select Group drop-down list. The following 
dialog box appears:

Figure 53. Increment/Decrement Simulator Dialog Box

NOTE:	 The Number of Group Members: readout indicates the number of 
controls to be affected.

3.	 Enter an increment value and a decrement value. The default value is 1. 

NOTE:	 The size of the increment can be changed by typing a value in the 
Increment Value or Decrement Value field. Values can be as large as the 
maximum range of the control or as fine as 0.1 dB. For groups controlling 
mute, 1 is the only valid value.

4.	 Click the Increment and Decrement buttons as needed. The group master control 
increases or decreases by the set value to the top or bottom of its soft limit range.

NOTE:	 When set, soft limits cannot be exceeded.
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Group Details Report

Select Tools > Group Details Report to create a Microsoft Word file that details all 
created groups (see figure 54).

 GROUP DETAILS REPORT
Group #1
 Processor Type: Output Volume
 Current Mute status: Unmuted
 Current Group Members:
  Main Amp (Output#1) Left Channel
  Stage Mixer (Output#2) Right Channel
  House Video (Output#3) Left Channel
  Prgm Record (Output#4) Right Channel

Group #2
 Processor Type: Pre-mixer Trim
 Current Gain value: 2 dB
 Current Group Members:
  Mic #1 (Input#1)
  Mic #2 (Input#2)
  Mic #3 (Input#3)
  Mic #4 (Input#4)
  Mic #5 (Input#5)
  Mic #6 (Input#6)

Figure 54.	 Sample Group Details Report

Soft Limits
Each gain type control provides upper and lower soft limits that can be used to limit the 
range of the group master control. Soft limits ( ), shown at left, prevent group controls 
from exceeding an upper limit or going below a lower limit. They are easily adjustable and 
provide the ability to set a ceiling and floor for the group. When a group master is created, 
the soft limits default to the hard limits (maximum and minimum) of that group of controls. 

Soft Limits can be defined using the mouse by clicking on, then dragging the soft limit 
icon. The resolution is 0.1 dB.  
For more precise setting use the keyboard as follows:

Click within the group master fader to bring focus, then use the following key 
combinations: 

To move the upper limit:

•	 <Shift + Up/down arrow> key moves in 0.1 dB increments.

•	 <Shift + Page Up/ Page Down> key moves in 10 dB increments.

•	 <Shift + Home> moves limit to upper default. Shift + End moves limit to the current 
fader position.

To move the lower limit:

•	 <Ctrl + Up/down arrow> key moves in 0.1 dB increments.

•	 <Ctrl + Page Up/ Page Down> key moves in 10 dB increments.

•	 <Ctrl + Home> moves limit to the current fader position. <Ctrl + End> moves limit 
to lower default.
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Digital I/O Ports
The DMP 128 provides twenty (20) digital I/O ports that may be used to trigger external 
events from DMP 128 actions, or for external events to trigger DMP 128 actions. The 
DSP Configurator software provides pre-configured scripts with a fixed set of common 
trigger/event combinations. When selected, the script is compiled and placed onto the 
File Management system of the device. For more advanced or custom scripts, contact an 
Extron Electronics Applications Engineer.

When no scripts are active, the digital I/O ports default to DI (digital input) and inactive 
(‘Logic Hi’ ≈ +5 VDC). The DI detects a Logic Hi as +5 VDC and Logic Low (active) as less 
than +1 VDC. 

A DO (digital output) sends a Logic Lo as less than +1 VDC and a Logic Hi as +5 VDC. 
For every script that involves a DO, two versions are available to provide either a 
Logic Hi or a Logic Lo response to any action. The alternate script is designated as 
“Reverse DO.”

To build a script and place it into the DMP 128 File Management system:

1.	 From the tools menu, click Configure Digital I/O, then select Build Digital I/O 
Configuration. 

2.	 This brings up a dialog that allows selection from a list of pre-configured scripts.

3.	 Select a script from the Select a Digital I/O Configuration section. The 
event description section describes the script and how the Digital I/O ports act while 
the script is running. Highlight the desired script, then click OK. 

4.	 A dialog box appears, verifying the file has been successfully uploaded to the device. 

NOTE:	 When performing this procedure in Emulate mode, the connection 
dialog will appear between step 3 and step 4. The DSP Configurator will 
connect and then disconnect during the procedure, returning to Emulate 
mode when completed.
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Reinitialize Digital I/O
Should the script stop running for any reason, go to Tools > Configure Digital I/O, 
then select Reinitialize Digital I/O. This option is only available in live mode.

To remove a digital I/O script from the DMP 128:

Only one digital I/O configuration can be active at a time. If the I/O activity needs to be 
modified, remove the current configuration by:

1.	 From the Tools menu, click Configure Digital I/O, then select Remove Digital 
I/O Configuration from the Device and press OK.

2.	 If the DSP Configurator is connected to a device, the I/O configuration will be 
removed. If it is not connected, a connection dialog box will appear. 

3.	 Make certain the connection information is correct, then press OK. The I/O 
configuration script will be removed and a confirmation dialog box will appear. 

Emulate Mode and Live Mode
The DSP Configurator program has two operational modes, Live and Emulate. In live 
mode, the program has established a connection and is synced with the DMP 128. 
Changes affect the device in real-time and changes in the current state of the device 
are reflected in the DSP Configurator. In contrast, emulate mode allows the user to 
work offline, creating or editing configurations that do not immediately affect DMP 128 
operation.

The DSP Configurator program always starts in Emulate mode. In emulate mode, all 
functions of the DSP Configurator program are available without connecting to the 
DMP 128. The user can build a configuration from the blank screen, or open an existing 
file that contains the last configuration displayed plus saved presets. Settings and 
adjustments are saved to a configuration file on the PC. When the saved file is opened 
in the DSP Configurator program, the program restores all settings as the current 
configuration (emulated if in Emulate mode or live if in Live mode).

Live mode can be entered at any time after program launch, either with a blank 
configuration, after creating a configuration, or after loading a previously saved 
configuration file. 

In emulate mode, the current state is titled Current Emulation. In live mode, the current 
state is titled, Current State. 

Synchronizing: Pull from or Push to the Device
When switching to live mode, either:

•	 Pull data from the device and update the DSP Configurator program configuration. 
This option downloads device settings from the DMP 128 and synchronizes it with the 
DSP Configurator program overwriting the current DSP Configurator settings, or

•	 Push data from the DSP Configurator program to the device, overwriting settings in 
the DMP 128.

Live mode can also be used to tailor audio settings in real time while listening to the audio 
output.
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Selecting Live Mode and Pushing or Pulling Data
To switch from Emulate to Live mode:

1.	 Select the desired connection to the DMP 128 and make the proper connections. 

NOTE:	 Extron recommends connection via the Ethernet LAN port when using 
DSP Configurator.

2.	 Click the Mode Live button (see b in figure 55). The communication type 
selection dialog box appears.

or or

Extron USB device

2

3

4a

4b

4c

5a

5b

5c

3

6a

6b

3

Figure 55. Selecting Live Mode

3.	 Click either:

•	 TCP/IP (for connection via the LAN port (preferred) — proceed to step 4, 

•	 RS-232 (for connection via either of the rear panel RS-232 ports — proceed to 
step 5,

•	 USB (for connection via the front panel configuration port — proceed to step 6.

4.	 If TCP/IP was selected in step 3:

a.	 Observe the IP address field in the IP connection dialog box. The field displays 
the last IP address entered.

•	 If the IP Address field is correct, proceed to step 4b.

•	 If the address is not correct, either click in the IP Address field and enter 
the IP address or click on the button ( ) to open a drop-down list and select 
from among recently used addresses. Proceed to step 4b.

NOTE:	 If the local system administrators have not changed the value, 
the factory‑specified default, 192.168.254.254, is the correct value 
for this field.

b.	 If the device is password protected, click in the Password field and enter the 
appropriate administrator password.

c.	 Click OK.

The Synchronize with Device dialog box (see figure 56 on page 92) appears. Proceed 
to step 7.
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5.	 If RS-232 was selected in step 3:

a.	 Click the Com Port drop-down menu and select the port that is connected to the 
rear panel RS-232 port.

b.	 Check the baud rate displayed in the port selection dialog box. If the baud rate 
does not match the device’s rate, click the Baud Rate drop-down menu and 
select the desired baud rate. The default is 38400.

c.	 Click OK.

The Synchronize with Device dialog box (figure 56 on next page) appears. Proceed to 
step 7.

6.	 If USB was selected in step 3:

a.	 Click the USB Device drop-down menu and select DMP 128 (or Extron USB 
device, if DMP 128 is not available),

b.	 Click OK.

The Synchronize with Device dialog box (see figure 56 on next page) appears. 
Proceed to step 7.
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7.	 Click either the:

a.	 Pull radio button to configure 
the DSP Configurator program 
to match the device — proceed 
to step 9

-or-

b.	 Push radio button to configure 
the device to match the 
DSP Configurator program — 
proceed to step 8

8.	 To push all of the DSP Configurator 
gain and processor block 
adjustments (configuration), and all 
presets to the DMP 128, proceed to 
step 9.

To tailor the push (push only the 
configuration, only the presets, 
or the configuration and selected 
presets), click the Advanced button 
and proceed to step 8a.

a.	 Select the Custom radio button.

b.	 Select the desired 
checkbox(es); Push 
Configuration 
and/or Push Presets. If Push 
Configuration is the only box 
checked, click OK and proceed 
to step 9.

Figure 56. Selecting Live Mode (Continued)
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NOTE:	 Push Configuration includes all mix‑point, gain and 
processor block settings. It does not include partial presets.

c.	 If Push Presets was clicked in step 8b, click All to select all presets or 
Selected to choose specific presets.

•	 If Selected was clicked, click OK and proceed to step 8d.

•	 If All was clicked (equivalent to a standard push), click OK and proceed to 
step 9.

d.	 If Selected was clicked in step 8c, the Synchronize with Device dialog box (7b) 
reappears. Click OK. The presets dialog box appears.
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e.	 Select the desired partial presets to push by clicking the appropriate 
checkbox(es).

f.	 Click OK. — Proceed to step 10.

9.	 Click OK. The DSP Configurator program is connected live to the device and the 
processors, and presets are pushed or pulled as selected, completing the selection of 
Live mode.

10.	 If changes were made to the DSP parameters (including mix‑point, gain or processor 
blocks) since the last file save, the DSP Configurator prompts to save the file. Click 
Yes or No.

If a password was required and not entered or if an incorrect password was entered, the 
program prompts for the password.

The configuration and/or presets will be uploaded to the DMP 128.

Presets
Presets are used to recall a group of frequently used settings. Presets created by the DSP 
Configurator may contain all elements (gain blocks, processor blocks, and mix‑points) or 
a portion of the elements available within the program. In Emulate mode, up to 32 partial 
presets can be created, then uploaded as a set and stored to the device and/or stored to 
disk as a configuration file. In Live mode, presets can be created one at a time from the 
current state. They can then be saved to a chosen preset number in the device, with the 
option to name/rename or save to disk.

When recalled, a preset will only overwrite elements contained in the preset. Presets are 
useful when settings for a particular room or only certain elements of a configuration need 
to be changed regularly.

Presets may be created in Live or Emulate modes. In Emulate mode, the presets are 
created, saved to a file, then pushed to the DMP 128 when connecting in Live mode. 

When a pull data synchronization method is performed, preset data remains in the 
DMP 128, with only the list of preset names pulled from the device. Presets in this state 
are marked with an asterisk until that preset is recalled (which pulls the preset data from 
the device), or until a backup is performed (see “Backup” on page 27). Presets pulled 
from the device cannot be saved to disk until they have been recalled, at which time the 
preset data is pulled into the DSP Configurator. Presets with no asterisk can be saved to 
disk. 

Saved presets can be recalled via the DSP Configurator, or a control system sending an 
SIS preset recall command. Presets may also be saved and recalled via the embedded 
web page. Presets saved via the web page contain input gain, output volume, and the 
output mix‑point settings. 
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Previewing/Recalling a Preset
A preset can be previewed in either Live or Emulate mode by selecting the preset from the 
preset drop-down list. 

The program indicates a view-only preset configuration by displaying each preset element 
with a translucent green mask over the block. 

Figure 57.	 Preset Preview

Behavior for previewing and applying presets is as follows:

•	 Live Mode – After selecting a preset, the DSP Configurator displays the preset 
elements that will be affected by a preset recall with a translucent mask over the 
element, and leaves all other DSP Configurator elements unaltered. Elements without 
a translucent mask represent elements in the current state that will be unaffected 
by a preset recall. Real-time changes to the current state will not be reflected in the 
GUI while previewing a preset, and the user cannot alter GUI elements. To apply the 
preset, the user clicks Recall. The preset reverts to “Current State.” 

•	 Emulate Mode – After selecting a preset from the list, the DSP Configurator displays 
the elements that will be affected by a preset recall with a green translucent mask, 
leaving all other elements (which represent the current emulation) unaltered. The user 
clicks Recall to apply the viewed preset to the current emulation. The preset number 
reverts to “Current Emulation.” 

Building a Preset
Only elements of the preset that are highlighted (given focus) will be saved as a preset. 
Ctrl + A will highlight all elements within the DSP Configurator.

To build a preset highlight the desired DSP Configurator elements (gain/processor blocks, 
mix‑points) using standard Windows keyboard and mouse actions as follows:

1.	 <Left click> on the desired block to select a single block, 

2.	 <Ctrl + left click> to select multiple blocks that are not adjacent,

3.	 <Shift/hold + click> on the first block and click on the last block in either a vertical 
column or horizontal row to select multiple blocks, and

4.	 Click and drag a selection rectangle to select multiple adjacent blocks in either the 
vertical or horizontal direction.

5.	 Go to Tools > Presets and select Mark All Items or press <Ctrl + A>. This will 
mark all elements within the DSP Configurator, which will save a “full” preset,

6.	 To save the selection see “Save Preset” on the next page.
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Save Preset

A preset may be saved in either Emulate mode or Live mode.

Saving a preset in emulate mode stores that preset in the currently open file. The 
DSP Configurator file must then be saved to disk via File menu > Save (recommended), 
and/or pushed to the device after a connection is established. This differs from live mode 
where the created preset is saved in real‑time to the device and becomes part of the 
configuration file. 

To save a preset use the following instructions:

1.	 Highlight the desired preset block(s) by using left click, <Ctrl + left click>, <shift + left 
click> or drag around the desired blocks.

2.	 Select Tools > Presets > Save Preset in the main structural menu.

3.	 Select a preset number. In the Preset Name box, unused presets are named 
“unassigned.”  To create a new preset, select an unused preset number and type a 
preset name. If no name is entered, a default name will be assigned. To overwrite an 
existing preset, select a preset with a name other than “unassigned.”

Figure 58.	 Save Preset

4.	 Click OK to save the preset, or Cancel to stop the save preset operation.
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Managing Presets in the GUI
Once the preset is created (whether or not the DSP Configurator file is saved) it will appear 
in the preset list, available from the DSP Configurator screen. 

In Live and Emulate mode, after a preset is selected from the list, action buttons become 
available next to the presets bar.

The user can either Recall (make the preset active), Cancel (return to the current 
emulation or state) or Delete the preset. 

In Live mode selecting Recall will first apply the currently displayed preset elements 
(“marked” elements) from the stored preset and overwrite that portion of the current state, 
then switch the drop-down list to read “Current State.” 

In Emulate mode, the Recall action button will apply the currently displayed preset 
elements (“marked” elements) from the file and overwrite the information contained in 
the DSP Configurator as the current emulation, then switch the drop‑down list to read 
“Current Emulation.”

When a preset is being previewed, in either Live or Emulate mode, the Delete button is 
available. In Live mode, the preset is deleted from the hardware, which will be reflected in 
software (it will be removed from the preset list). After disconnecting from the device and 
before exiting the program, the file must then be saved to retain this change. In Emulate 
mode, the preset is deleted from the file in software, which must then be saved (before 
exiting) to retain this change. In either Live or Emulate mode, the Cancel button will defeat 
the preview action and return the user to current state or current emulation, respectively.

Presets: Pull, Push, or Create Live
When a preset is pulled from the device, the preset data remains in the device until the 
preset has been recalled. The DSP Configurator pulls the names of the presets only. 
These presets cannot be saved to disk until they have been recalled. 

An asterisk next to the preset name indicates that only the preset name has been pulled 
from the device, and the preset data exists only in the device (it has not been recalled). 
Presets pushed to the device or created in the DSP Configurator in live mode have no 
asterisk. Presets with no asterisk can be saved to disk.   
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Protected Configuration
Protected Configuration is a configuration secured with PIN protection. The protected 
configuration can be recalled by any user, but can only be written/overwritten using 
the assigned (up to) 4-digit PIN. Utilities for save/recall/change PIN, separate from 
preset save, are accessed from the tools menu as three sub-menus under a protected 
configuration menu item.

Protected configuration menu items are only available in live mode from the Tools > 
Protected Configuration menu. These functions can only be performed in Live mode, 
and are unavailable in Emulate mode.

•	 Save 

•	 Recall

•	 Change PIN

Save Protected Configuration
The default PIN is 0000. The user can enter the default PIN or use the Change PIN (see 
below) dialog to create a new one. 

Recall Protected Configuration
The dialog informs the user, “Recalling the protected configuration will overwrite all audio 
and video settings currently in the device. Are you sure you want to continue?”  Click OK 
to continue or Cancel the operation.

Change PIN
The change PIN utility allows the user to change a current protected configuration PIN. 
The current PIN must be entered before changes are allowed.
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DSP Configurator Windows Menus
Keyboard Navigation

The DSP Configurator program is fully navigable using the computer keyboard. Some 
keyboard navigation behavior matches Windows standards, while other behaviors are 
specific to the DSP Configurator program.

The <tab> control is used to toggle to the various sections outlined in red in figure 59. 
When the program starts, the cursor defaults to the Emulate button (a). When <tab> is 
pressed, the focus toggles to the next area in order outlined by red boxes in figure 59.

Within the sections, the <navigation arrows> may be used to move one processor block 
or mix‑point right, left, up, or down within the section.

Virtual Returns

Expansion Returns

Exp. Inputs 1 - 8

Exp. Inputs 9 - 16

Outputs

Inputs

m n olr

k

p

q

d

f

c e b ag

h i j

Figure 59.	 DSP Configurator Program

Standard Windows Navigation
The keyboard keys navigate and function as follows:

•	 Tab key —
Sequentially jump among major segments of the DSP Configurator program. From the 
Emulate mode button (a), sequential jumps are in the following order:

b	 Live mode k	 Virtual Returns minimize button

c	 Presets (Down arrow can select presets) l	 Virtual Return signal path (defaults to FBS)

d	 Outputs minimize button m	 Virtual Return bus mix-points

e	 Output signal path (defaults to trim) n	 Virtual Return bus to Virtual sends

f	 Input minimize button o	 Virtual Return bus to EXP sends

g	 Input signal processing (defaults to gain) p	 EXP Returns bus minimize button

h	 Main mix-points q	 EXP Inputs bus 1-8 maximize button

i	 Virtual Send bus mix-points r	 EXP Inputs bus 9-16 maximize button

j	 Expansion Send bus mix‑points
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NOTE:	 The first selection in any area is always the minimize/maximize button. If the area has been 
hidden, the next tab will move the highlight to the minimize/maximize button of the next section. 
If the area is maximized, the next tab will toggle to the signal processing chain or mix‑points 
(depending on the section) before leaving the area for the next section in order.

•	 Shift+Tab key combination —  
Reverses the direction of the Tab key function.

•	 Arrow ( , , , and ) keys —  
Navigate up, down, left, and right within any of the areas outlined in figure 59.

•	 Enter Key — Performs the same action as a mouse double-click. For 
example, opens the context menu from which a processor type may be selected 
or opens a dialog box when applicable. When an action button is highlighted, Enter 
executes the button action and toggles the button when applicable.

•	 Control key — The Ctrl key can be used in the following shortcuts.

•	 <Ctrl+x> — Cut the selected elements.

•	 <Ctrl+c> — Copy the selected elements.

•	 <Ctrl+v> — Paste the selected elements from a previous cut or copy.

•	 <Ctrl+a> — The first press of the Ctrl+a combination highlights all A/V matrix 
block nodes. 

•	 Alt key — The <Alt> key is used with specific letter keys to open and navigate task 
bar menus. When the Alt key is pressed and released, the File menu opens. When the 
Alt key is pressed and held, the first letters in the menu titles (File, Edit, View, Tools, 
Window, or Help) become underlined. Press the underlined letter key to open that 
menu.

•	 Once a task bar menu is open, use the up and down arrow keys to move up and 
down in the menu or submenu, use the right key to open a submenu (if applicable), 
and use the <Esc> key to back out of an active menu or submenu.

DSP Configurator-unique Navigation

Highlighting and marking items, cutting or copying, saving a preset:

When an item within the program is selected, it is highlighted by a green boundary box. 
One or more highlighted items can be cut, copied, pasted, or saved as a preset. The cut, 
copy, and paste functions can be performed using the task bar menus (see the <Alt> key, 
above) or the shortcuts described on the previous page.

NOTE:	 When an item is cut, it is not removed from its original location until it has 
been pasted in its new location.

Highlight multiple elements for cut, copy, paste, or a preset as follows:

1.	 Use the arrow ( , , , and ) key(s) to move to the first block to be highlighted. 

2.	 To highlight a block:

a.	 Press and hold the <Shift> key, then use the arrow ( , , , and ) keys to 
navigate away from the selected block.

b.	 To highlight additional sequential blocks, continue to hold the <Shift> key, then 
use the arrow ( , , , and ) keys to navigate away from the selected block. 
Additional blocks will be highlighted as long as the <Shift> is pressed. When the 
last element is highlighted, move the highlight box one additional block, then 
release the <Shift> key.
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3.	 To move away from the highlighted block or set of sequential blocks, or to highlight 
non-sequential blocks:

a.	 After highlighting blocks in step 2, press and hold the <Ctrl> key, then use 
the arrow ( , , , and ) keys to navigate to the next desired element. As 
long as the <Ctrl> key is held down, the block moved away from will not be 
highlighted. If the block is highlighted, it will be unhightlighted.

b.	 Release the <Ctrl> key, but do not press any arrow keys.

4.	 To highlight another element or group of elements, repeat steps 2 and 3 as required.

5.	 To cut or copy, press the <Ctrl>+<X> or <Ctrl>+<C> key combination.

6.	 To save a preset, press <Alt>, then <T>, then right arrow , then down arrow , 
then <Enter> (see figure 60).

7.	 The Save a Preset dialog box appears.

a.	 <Tab> to the preset number field and type a specific preset number.

b.	 <Tab> to the preset name field and type a preset name.

NOTE:	 Unless entering a specific number and/or name, the 
DSP Configurator program enters the next sequential unused preset 
number.

c.	 <Tab> to highlight the OK button and press the Enter Enter  key.
Alt T Enter

Figure 60.	 Saving a Preset using Keyboard Navigation
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Optimizing Audio Levels
The DMP 128 uses floating point DSP technology, processing data using a combination 
of 32- and 128-bit algorithms. The analog to digital converters (ADC) and digital to analog 
converters (DAC) sample at 48kHz, with 24-bit resolution. 

With floating point DSP it is extremely difficult to clip the audio signal within the DSP audio 
signal chain, after the ADC input and before the DAC output. That means the audio signal 
must not be clipped at the input ADC. Clipping gives audibly undesirable results and once 
the audio is clipped at the input there is no way to correct it further down the signal chain. 
If audio clipping occurs at the output DAC that is not a result of clipping at the input ADC, 
there are ways to address it within the DSP audio signal chain.

The meters in the DSP Configurator indicate clipping at a user-definable point, with 
the default setting at –1 dB. This means the meter indicates clipping when it reaches 
–1 dBFS, or 1 dB below actual clipping (0 dBFS). Setting the clipping meter below actual 
clipping provides a safety net, allowing the user to reduce input gain before clipping 
actually occurs. This “safety net” may be increased or decreased by selecting Tools > 
Options > Processor Defaults > Defaults > Meter Clipping, and setting the Clip 
Threshold to a number between 0 and – 20 (dB). 

NOTE:	 When the Clip Threshold is set to 0 (dB), clipping is indicated only when 
clipping occurs.

Meters within the DSP Configurator are peak-type meters, referenced to full scale, or 
0 dBFS. For the DMP 128 outputs, 0 dBFS corresponds to +21 dBu, the maximum 
output level of the device. Maximum input level is +24 dBu. Gain from – 3 dB to +80 dB 
is applied in the analog domain, while attenuation from – 3 dB to –18 dB is applied in the 
digital domain. The input meters are post-ADC, while the output meters are pre-DAC.
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The remainder of this section references the gain, trim and volume controls outlined in 
figure 61 below. 

a c d eb

Figure 61.	 Gain, Trim and Volume Controls

a	Mic/Line input gain

b	Pre-mixer gain 

c	Mix‑point gain

d	Post-mixer trim 

e	Output volume 

About Setting Gain Structure
There are two approaches the system designer can take in setting up gain structure 
depending upon where output volume will be controlled. The output volume of the 
DMP 128 may be controlled by either of the following two gain blocks:

•	 Volume (e) and,

•	 Pre-mixer gain (b) 

NOTE:	 While the pre-mixer gain control is not in the output signal chain, it can 
be used to control program level independent of mix‑point levels.

In the following instructions, setup is described for output volume or pre-mixer gain when 
appropriate.
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Setting Input Gain
Floating point DSP technology is internally more flexible than fixed point. However, the 
input ADCs and output DACs always run as fixed point, so it is important to optimize 
the audio by setting the input level as close to 0 dBFS as possible. This will maintain the 
resolution at 24-bit. Within the DSP it is not critical to maintain audio levels at 0 dBFS in 
order to secure the resolution at 24-bit.

Input gain can be set using the intended input source device and typical source material. 
When source material is not available, it can be set using pink noise obtained either from a 
pre-recorded track on a DVD or CD, or a signal generator. 

For program material, set the input level (a) so the meters reach approximately 
– 15 to – 12 dBFS, with peaks at approximately – 5 to – 3 dBFS. This setting provides 
enough headroom to accommodate transients or unanticipated loud events in the 
program material to avoid possible clipping. 

When using pink noise, it should be recorded at – 20 dBFS. If the player has an output 
level setting control, set the output of the player to its maximum, or 0 dB of attenuation. 
If the maximum output setting provides gain, then back off slightly from the maximum 
setting. When using a signal generator, set the output at –10 dBu. Whichever pink noise 
source is used, set the input gain in the DSP Configurator so the input meter reads 
– 20 dBFS. 

Setting a Nominal Output Level
In order to set up a gain structure to include signal processing, listening to the audio may 
be advantageous. Route the audio that will carry program material from the source to the 
speakers in the room being set up. With the output volume control (e) set to – 20 dB, set 
the external amplifier so the source material plays at a volume level that is reasonably loud 
but tolerable. 

NOTE:	 When using the volume control for this purpose, set post-mixer trim (d) to 
0 dB. If using the post-mixer trim for this purpose, set volume to 0 dB (100%).

Verify the amplifier is not clipping by observing the amplifier clip indicator. This will set 
the amplification/volume nominal level of the system, and if desired, allow listening while 
making adjustments. Adjust or mute the volume control as necessary  
(see “Setting Volume Control for the Amplifier Stage” on page 105). 
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Adjusting Pre-mixer Gain
After setting input gain, add desired processors into the input signal chain. The pre‑mixer 
gain control (b) may be used to compensate for level changes due to processing. Adding 
a compressor generally reduces the signal level, while a filter may boost or cut the overall 
signal level. If changes are made to filter settings after setting dynamics processors, 
re‑check the levels in the dynamics processors to make certain they are still valid.

NOTE:	 This procedure is valid only when there is no active processing in the 
output signal path, and if the post-matrix trim value is set to 0 dB, unity gain. If 
processors are inserted in the output signal path, engage Bypass to temporarily 
remove them.

To adjust pre-mixer gain:

1.	 Open the line input gain (a), output volume (e), and pre-mixer gain (b) dialog boxes. 

2.	 Connect program material (or pink noise) at the input,

3.	 Set the output volume to 100% (mute if necessary). 

4.	 Adjust the pre-mixer gain (b) so the meter level on the input gain dialog matches the 
meter level of the output volume dialog. This will maintain the audio at an optimal level 
in the input signal chain. 

This sets a good starting point. After setting up the mic input gain and mix‑point levels, 
output processing, and trim levels, if more headroom is required to prevent clipping at 
the outputs, return to the pre-mixer gain controls (b) and lower each one by specific 
amounts. Further minor adjustments to the pre-mixer gain controls will help to balance out 
perceived audio levels of the different inputs.

When using the pre-mixer gain for output volume control, the procedure may be reversed. 
Set pre-mixer gain to 0 dB. With program material (or pink noise) present at the input, 
adjust the output volume until the meter level in the output volume dialog box is below 
clipping (or ideally, matches the level at the input gain meter).

Setting Output Gain Structure
Add all desired processors into the output signal chain. Keep in mind a filter may boost 
or cut the overall signal level and adding a compressor generally reduces the signal level. 
Inserting either or both may require resetting of the output volume. 

Since a limiter is the most likely choice for output processing and can only reduce the 
signal to prevent overload, a reduction of output level does not have to be considered. 
Loudness will boost the overall signal level, but only at lower volume settings 

After adding processors to the output signal chain, the output volume level may clip when 
set to 100% (or less). Floating point DSP allows clipping to be overcome by lowering the 
output volume (e) setting. However, unless a user is prevented from changing the volume 
setting to 100% (or to any position where clipping occurs), it is best to adjust the pre-
mixer gain (b) or post-mixer trim (d) control to prevent any possible clipping. 

Alternately, use the post-mixer trim controls to adjust output volume. Post-mixer trim 
controls provide 12 dB of gain, so use a group master with soft Limits to control levels, 
setting an upper limit of 0 dB or less. Mic levels will also contribute to possible clipping 
at the outputs, and may need to be lowered to maintain the balance between program 
material (line outputs) and voice.
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Setting Mic/Line Input and Mix Levels
In this example, the mic/line Input 1 signal is sent to Output 1. 

To set the mic/line input and mix levels:

1.	 Connect a microphone to Input #1.

2.	 Double-click the mix‑point (c) for mic/line Input 1 to Output 1 to open the dialog for 
that mix‑point and unmute the mix‑point to place that signal into the mix. 
The default level for the mix‑point is 0 dB, or unity gain.

3.	 Open the Input 1 gain (a) dialog and set gain to 0 dB (turn on phantom power if the 
mic requires it), then unmute the channel. 

4.	 While testing the mic, raise the fader level until the mic is clearly audible. The amount 
of gain and the meter level reading will vary at this point, but as a general guideline 
the input gain level should be at 40 to 50 dB, with the meter averaging somewhere 
around – 20 dBFS. 

Ideally, audio should be optimized here, but voice levels at mic inputs can vary greatly. 
Having the meters average around – 20 dBFS allows enough headroom to accommodate 
sudden changes to voice levels. Further adjustment may be necessary.

Adjusting Trim
This is where setting gain structure becomes a balancing act. The following sections 
provide guidelines, but it may take a bit of going back and forth to correctly set levels for 
the installation. For example, output level can be controlled and kept below clipping using 
a compressor or limiter in the output dynamics block. However, adjusting the post-matrix 
trim will affect how the compressor or limiter works.

1.	 Apply program material (or pink noise) at the input to be adjusted. 

2.	 Open the output volume (e) and post-matrix trim (d) dialog boxes. 

3.	 Set output volume to 100% (mute if necessary). 

4.	 Adjust the post-matrix trim until the meter level in the output volume dialog is below 
clipping (or ideally, matches the level at the input gain meter). 

This maintains the audio at an optimal level in the output signal chain while preventing 
clipping at the output. 

Setting Volume Control for the Amplifier Stage
The maximum output of the DMP 128 is +21 dBu. As an example, assume the 
maximum input level of a power amp is +4 dBu with its input attenuator fully open. If 
using the output volume control (e) of the DMP 128 to control volume levels, to ensure 
clipping does not occur at the amplifier, turn down the input attenuator of the power 
amp the equivalent of 17 dB (21 – 4 = 17). That puts the amplifiers input level at –13 dB 
(+4 – 17 = –13). If the amplifier setting (when the output volume controls of the DMP 128 
are at maximum) is too loud for the room, it may need to be reduced further. If it is not 
loud enough for the room, a more powerful amplifier may be required.

It is recommended to use the output volume or post-mixer trim control on the DMP 128 
for controlling output volume. If using loudness processing on the unit, it will only work in 
conjunction with these controls. 

When using the power amplifier input attenuation to control volume (using the same 
power amp maximum input level) set the output volume or post-mixer trim control of 
the DMP 128 to –17 dB. This is another way that clip points of the two devices will be 
matched. Verify the amplifier is not clipping by observing the amplifier clip indicator. 

NOTE:	 Using the amplifier input attenuation to control volume compromises the 
signal-to-noise ratio of the DMP 128, and is not recommended.
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Signal Path Building Blocks
The discrete signal paths; mic/line input, virtual return input, and line output can be 
individually loaded with pre-configured, modular templates called building blocks. These 
modules are designed for specific microphones, source devices or speaker destinations 
and can greatly streamline initial configuration. The modules are configurable and are 
more versatile than a global template. 

The modular building blocks can be loaded to a selected input or output by a right-click 
on the signal path label bringing up the building block dialog box. Building Blocks

Figure 62.	 Building Blocks

Different menus or dialogs are available according to the selected signal path, Mic/Line 
Input, Virtual Return Input, or Line Output.
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Figure 63.	 Building Blocks Dialog Box

The following steps select a lavalier microphone configuration for Input #1.

1.	 Left-click the Input 1 title box. 

The Building Blocks Dialog Box (see figure 63 above) appears.

2.	 Select Lavalier by placing the mouse pointer over the word Lavalier.

The selected text changes color and is underlined. Left-click the selection.

3.	 The input channel then loads the pre-configured processor blocks, sets the gain, and 
names the channel “Lavalier.” 

The building blocks can be renamed and processor blocks further customized according 
to the requirements of the system.
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Adding a Building Block
Custom building blocks can be created using a signal path configured for a specific 
device.

For example, if a new mic is connected to Input #3, the signal path might be configured 
for that specific mic. 

In this example a gain setting is applied, the FBS filter is made active, and a noise gate 
and delay are inserted and stored as a custom building block.

To create a building block for the new microphone:

1.	 Select the input number block.

2.	 In the dialog box, select the Add Block icon in the upper left.

The Add a Building Block dialog box opens.

3.	 In the dialog box, type a name for the new device.

4.	 Select the folder the new device goes in (see above).

5.	 Select Add.
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6.	 The new mic configuration is now a building block that can be used to quickly 
configure new devices.

A new configuration can also overwrite existing templates.

To Overwrite an Existing Configuration:

1.	 Select the input number block (left-click).

2.	 In the dialog box, select the Add Block icon in the upper left.

3.	 In the Add a Building Block dialog box, type an existing name for the new device.

4.	 Select the folder the new device goes in (see above).

5.	 Select Add.
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6.	 The program prompts to warn an existing configuration will be overwritten. Click Yes.

7.	 The new mic configuration overwrites the existing template and is ready for use.

Organize Building Blocks
The Tools menu contains a utility that allows the building blocks to be organized or 
rearranged to suit an application. Individual blocks and folders can be moved or deleted 
and new folders can be created.

The general categories of folders follow the main GUI of DSP Configurator and include the 
main inputs, virtual return inputs and the line outputs.

The Organize Building Blocks option lets you organize listed building blocks. You can also 
import and export the building blocks file so that you can use your set of building blocks 
on other computers.

Organizing Listed Building Blocks

Building blocks can be organized within default 
folders or within new folders. You can move individual 
building blocks or a folder with all of its contents to a 
new location.

To create a new folder in the Organize Building Blocks 
dialog box:

Click the New Folder icon in the upper right corner. 
The folder appears within the currently selected group 
in the organizational tree. 

To move a building block or a folder, click and drag 
the desired item to the new location.

Folders can be expanded to view the associated 
building blocks by clicking beside the folder name. 
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Delete a Building Block

Deleting a building block removes the building block from the list. If you delete a default 
building block, you can restore it if needed (see Restore Default Building Blocks 
below).

To delete a building block:

1.	 From the Tools menu, select Organize 
Building Blocks. The Organize Building 
Blocks dialog box opens.

2.	 To delete a folder and the associated building 
blocks, select the folder from the list and click 
the icon. 

3.	 To delete an individual building block, select the 
building block and click the  icon or right-click 
the listed building block and select Delete from 
the drop-down menu.

Restore Default Building Blocks

If one of the default preconfigured building blocks 
has been deleted, it can be restored. The default 
building blocks are those that were installed with 
DSP Configurator. User-defined building blocks are 
not affected.

To restore default building blocks:

1.	 From the Tools menu, select Organize 
Building Blocks. The Organize Building 
Blocks dialog box opens.

2.	 Click the Restore Default Building Blocks 
icon. The default building blocks and original 
folders are restored to the list.

Importing or Exporting Building Blocks Files

Building blocks file can be imported from another computer running DSP Configurator or 
exported from the current computer for use elsewhere. Building blocks files are saved with 
an XML file extension.

To export a building blocks file:

1.	 From the Tools menu, select Organize 
Building Blocks. The Organize Building 
Blocks dialog box opens.

2.	 Click the Export Building Blocks File 
icon. The “Export to...” dialog box opens.

3.	 Browse to the location where the file is to be 
saved.

4.	 In the File name field, leave the current file name 
or enter a new file name.

5.	 Click Save. 
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To import a building blocks file:

1.	 From the Tools menu, select Organize 
Building Blocks. The Organize Building 
Blocks dialog box opens.

2.	 Click the Import Building Blocks File icon. 
The “Import from...” dialog box opens.

3.	 Browse to and select the desired building blocks 
file.

4.	 Click Open. The selected building blocks file 
is imported into the Organize Building Blocks 
dialog box.
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SIS Programming 
and Control

This section describes SIS programming and control of the DMP 128, including:

•	 Connection Options

•	 Host-to-device Communications

•	 Command/Response Tables

•	 Audio level, mix‑point, processing blocks, and signal chains

Connection Options
The DMP 128 Digital Matrix Processor can be remotely connected via a host computer 
or other device (such as a control system) attached to the rear panel RS‑232 port or LAN 
port, or the front panel USB Config port. 

The DMP 128 can be set up and controlled using SIS commands, embedded Web pages, 
or DSP Configurator software. See “Installation” on page 5  for pin assignments 
and details on the configuration and control port connections. For information on 
DSP Configurator, see “DMP Software” on page 14 and for the embedded Web 
pages, see “HTML Operation” on page 137.

SIS commands may be executed using the Extron Electronics DataViewer program, found 
on the Software Products DVD included with the product.

DMP 128 RS-232 protocol: 

•	 38400 baud •	 no parity •	 1 stop bit

•	 8 data bits •	 no flow control

NOTE:	 The rear panel configuration port requires 38400 baud communication. This 
is a higher speed than many other Extron products use. The DMP 128 control 
software automatically sets the connection for the appropriate speed. When using 
DataViewer or similar application, make sure the PC or control system connected 
to the port is set for 38400 baud.

See “RS-232 Port” on page 114, for additional details on connecting the RS‑232 port.

USB port details: 
The Extron USB driver must be installed before use (see “Installing the USB Driver” on 
page 17).

LAN port defaults: 

DMP 128 IP address: 192.168.254.254

gateway IP address: 0.0.0.0

subnet mask: 255.255.0.0

DHCP: off
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RS-232 Port
The DMP 128 has a serial port that can be connected to a host device such as a 
computer running the HyperTerminal utility, or the DataViewer utility. The port makes serial 
control of the switcher possible. Use the protocol information listed above to make the 
connection (see “Host-to-device Communications” on page 116).

USB Port (front panel)
The DMP 128 has a front panel USB port that can be connected to a host device 
such as a computer running the HyperTerminal utility, or the DataViewer utility. The port 
makes serial control of the switcher possible. Once the connection is established, SIS 
programming can begin (see “Host-to-device Communications” on page 116)

Ethernet (LAN) Port
The rear panel LAN connector on the device can be connected to an Ethernet LAN or 
WAN. Communication between the device and the controlling device is via Telnet (a 
TCP socket using port 23). The Telnet port can be changed, if necessary, via SIS. This 
connection makes SIS control of the device possible using a computer connected to the 
same LAN or WAN. The SIS commands and behavior of the product are identical to the 
commands and behavior the product exhibits when communicating via a serial port or 
USB.

Ethernet Connection

The Ethernet cable can be terminated as a straight-through cable or a crossover cable 
and must be properly terminated for your application (see figure 64).

•	 Crossover cable — Direct connection between the computer and the DMP 128.

•	 Patch (straight) cable — Connection of the DMP 128 to an Ethernet LAN.

A cable that is wired as T568A at one end
and T568B at the other (Tx and Rx pairs
reversed) is a "crossover" cable.

A cable wired the same at both ends is
called a "straight-through" cable, because
no pin/pair assignments are swapped.

12345678

RJ-45
Connector

Insert Twisted
Pair Wires

Pins: Crossover Cable Straight-through Cable

Pin

1

2

3

4

5

6

7

8

Wire color

White-green

Green

White-orange

Blue

White-blue

Orange

White-brown

Brown

Wire color

T568A T568B

End 1 End 2 End 1 End 2

White-orange

Orange

White-green

Blue

White-blue

Green

White-brown

Brown

Pin

1

2

3

4

5

6

7

8

Wire color

White-green

White-orange

Blue

White-blue

White-brown

Brown

Wire color

T568BT568B

White-orange

OrangeOrange

White-green

Blue

White-blue

GreenGreen

White-brown

Brown

Figure 64.	 RJ-45 Ethernet Connector Pin Assignments
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To Establish a Network Connection to the DMP 128:

1.	 Open a TCP socket to port 23 using the mixer IP address.

NOTE:	 If the local system administrators have not changed the value, the 
factory‑specified default, 192.168.254.254, is the correct value for this field.

2.	 The DMP 128 responds with a copyright message including the date, the name of the 
product, firmware version, part number, and the current date/time.

a.	 If the DMP 128 is not password-protected, the device is ready to accept SIS 
commands immediately after it sends the copyright message.

b.	 If the DMP 128 is password-protected, a password prompt appears below the 
copyright message. Proceed to step 3.

3.	 If the device is password protected, enter the appropriate administrator or user 
password.

a.	 If the password is accepted, the device responds with Login User or Login 
Administrator.

b.	 If the password is not accepted, the Password prompt reappears.

Connection Timeouts

The Ethernet link times out after a designated period of time of no communications. 
By default, this timeout value is set to 5 minutes but the value can be changed (see 
“Ethernet data port” on page 121).

NOTE:	 Extron recommends leaving the default timeout at 5 minutes and periodically 
issuing the Query (Q) command to keep the connection active. If there are long 
idle periods, disconnect the socket and reopen the connection when another 
command must be sent.

Verbose Mode
Telnet connections can be used to monitor for changes that occur, such as SIS 
commands from other Telnet sockets or a serial port. For a Telnet session to receive 
change notices, the Telnet session must be in verbose mode 1 or 3. In verbose mode 
1 or 3, the Telnet socket reports changes in messages that resemble SIS command 
responses.
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Host-to-device Communications
The ASCII and URL commands listed in the following tables perform the same functions, 
but are encoded differently to accommodate the requirements of each port (Telnet or 
browser).

DMP 128-initiated Messages
The DMP 128 initiates messages under specific conditions. No response is required from 
the host. The DMP 128-initiated messages are listed here (underlined).

© Copyright 2012, Extron Electronics, DMP 128, Vn.nn, 60–1178-01 
Day, DD MMM YYYY  HH:MM:SS

Vn.nn is the firmware version number.

The DMP 128 sends the boot and copyright messages under the following 
circumstances:

•	 If the DMP 128 is off and an RS-232 connection is already set up (the PC is cabled to 
the DMP 128 and a serial communication program such as HyperTerminal is open), 
the connected unit sends these messages via RS-232 when first powered on.

•	 If the DMP 128 is on, it sends the boot and copyright messages when a Telnet 
connection to the DMP 128 is first opened. The day of the week, date, and time 
are shown when the DMP 128 is connected via Telnet, but not via RS-232. If using 
a Telnet connection, the copyright message, date, and time may be followed by a 
password prompt.

Password Information
The “]Password:" prompt requires a password (administrator level or user level) 
followed by a carriage return. The prompt is repeated if the correct password is not 
entered.

If the correct password is entered, the unit responds with "] Login Administrator ]" 
or "] Login User ]", depending on the password entered. If passwords are the same 
for both administrator and user, the unit will default to administrator privileges. 

Using the Command/Response Tables
SIS commands consist of a string (one or more characters per command field). No special 
characters are required to begin or end a command sequence. When the DMP 128 
determines a command is valid, it executes the command and sends a response to 
the host device. All responses end with a carriage return and a line feed (CR/LF = ]), 
signaling the end of the response character string.
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When programming, certain characters are more conveniently represented by their 
hexadecimal rather than ASCII values. The table below shows the hexadecimal equivalent 
of each ASCII character:

• 

Space

l

I

ASCII to HEX  Conversion Table

Figure 65.	 ASCII to Hex Conversion Table

The command/response tables list valid ASCII (for Telnet or RS-232) command codes, 
the corresponding URL (uniform resource locator) encoded (for Web browsers) command 
codes, the DMP 128 responses to the host, and a description of the command function 
or the results of executing the command.

Symbol definitions

] = CR/LF (carriage return/line feed) (hex 0D 0A)

} =
Carriage return (no line feed, hex 0D)   
(for URL-encoded commands, use the pipe character, | , 
instead)

• = Space character (%20 for web browser)

| = Pipe (vertical bar) character

* = Asterisk character (which is a command character, not a variable)

E = Escape key (hex 1B)  
(use W instead of Esc for Web browsers)

NOTE:	 For Web encoding only: data will be directed to the specified port 
and must be encoded (URL encoding) if it is non-alphanumeric. Change 
any non‑alphanumeric character (%, +, }) within the data section into 
the corresponding hexadecimal equivalent, %xx, where xx represents the 
two‑character hex byte. For example, a space (hex: 20) would be encoded as 
%20 and a plus sign (hex: 2B) would be encoded as %2B.

Error Responses
When the DMP 128 is unable to execute the command, it returns an error response to the 
host. The error response codes and their descriptions are as follows:

E12 - Invalid port number E24 - Privilege violation

E13 - Invalid parameter (number is out of range) E25 - Device is not present

E14 - Not valid for this configuration E26 - Maximum connections exceeded

E17 - System timed out E27 - Invalid event number

E22 - Busy E28 - Bad filename or file not found
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Simple Control Port Commands - Telnet and Web-browser Accessible
Upper and lower case text can be used interchangeably except where noted. Port 23 
is default for Telnet. Port 80 is default for web browsers. They both can be mapped to 
different ports.

The following commands are for either a Telnet (port 23) or Web browser (port 80) 
connection. There are minor differences when implementing these commands via Telnet 
or via URL encoding using a web browser. All commands listed will work using either 
connection method but due to some limitations of the web browser, the encapsulation 
characters must be modified to be certain the web browser will properly handle them. All 
examples are shown in a proper implementation of a Telnet or Web Browser session. 

NOTE:	 When using web browsers, some non-alpha numeric characters must 
be represented as their hex equivalent such as %xx where xx equal the two 
character representation of the hex byte that needs to be sent (i.e. a comma ‘,’ 
would be represented as %2C). Characters such as ‘%’ (percent), ’+’ (plus) and ‘ ‘ 
(space) should also be encoded in Hex. 

Telnet Web Browser

Escape (Hex 1B) W [must not be encoded]

Carriage Return (Hex 0D) Pipe Character (>) [must not be encoded]

When describing the use of SIS commands via a web browser, the [URL] reference is 
used to shorten the examples. [URL] would be the full URL of the control interface and 
web page reference including all path information  
(http://192.168.254.254/mypage.HTML).

To send commands using a Web browser, prefix them with the full URL followed by 
?cmd= (http://192.168.254.254/mypage.html?cmd=WSF>).

Although the DMP 128 uses the same structure for SIS commands, there are two 
variations. One is the global command structure noted above and documented in the 
Command/Response Tables that immediately follows.

The second set of tables, “DSP SIS commands” uses the command structure outline 
beginning with “DSP SIS Commands” on page 124. While using the same structure as 
basic SIS commands, they differ in how the software addresses the individual processor 
blocks within the DMP 128. 

Generally the basic SIS commands will be used for global configuration such as setting 
IP addresses, date/time, while the Audio SIS commands allow functionality of the audio 
signal chain.
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Command/Response Tables

Basic SIS Commands

Command ASCII command
(host to device)

URL Encoded
(web)

Response
(device to host)

Information requests
Firmware Version Q *Q X1!]
Firmware and build version *Q *Q X1!]
Kernel firmware and build **Q **Q X1!]
Verbose version info 0Q 0Q Sum of 2Q-3Q-4Q]
Firmware version 1Q 1Q X1!]
Bootstrap Version 2Q 2Q X1!]
Factory Firmware Version 3Q 3Q X1! plus web ver.-desc-UL 

date/time]
Updated firmware version 4Q 4Q X1! plus web ver.-desc-UL 

date/time]
NOTE:	 An asterisk (*) after the version number indicates the currently running version. Question marks (?.??) indicate that 

only factory firmware is loaded. A caret (^) indicates the firmware version that should be running, but a Mode 1 reset 
was executed and the default factory firmware is running. An exclamation point (!) indicates corrupted firmware.

Query part number N N 60–1178-01 ]

Query model name I I V00x00•A12x08]
Query model name 1I 1I DMP •128]
Query model description 2I 2I Digital•Matrix•Processor]
Query system memory 
usage

3I 3I #Bytes used out of 

#KBytes]
Query user-memory usage 4I 4I #Bytes used out of 

#KBytes]

NOTE:	 X1! = Version number	 Firmware version number to second decimal place (x.xx) 
				    Version and Build number adds four digits (x.xx.xxxx) 
				    to the Version number
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Command/Response Table for Basic SIS Commands (continued)

Command ASCII command
(host to device)

Response
(device to host)

Additional 
description

IP Setup Commands

Set unit name EX1@CN} Ipn•X1@]
View unit name ECN} X1@]
Set name to factory default E•CN} Ipn•X4(]
Set time and date EX1#CT} Ipt•X1#]
View time and date ECT} X1#]
Set GMT offset EX#CZ} IpzX#]
View GMT offset ECZ} X#]
Set Daylight Savings Time EX3$CX} IpxX3$]
Read Daylight Savings Time ECX} X3$]
Set IP address EX1$CI} IpiX1$]
Read IP address ECI} X1$]
Read hardware address 
(MAC)

ECH} X1*]

Set subnet mask EX1(CS} IpsX1(]
Read subnet mask ECS} X1(]
Set gateway IP address EX1$CG} IpgX1$]
View gateway IP address ECG} X1$]
Set DHCP on E1DH} Idh1]
Set DHCP off E0DH} Idh0]
NOTE:	 Changing DHCP from On to Off resets the IP address to the factory default (192.168.254.254)

View DHCP status EDH} X%]
Set verbose mode EX2@CV} VrbX2@]
View verbose mode ECV} X2@]
Get connection listing ECC} [number of connections]]

NOTES:	 X# = Greenwich Mean Time offset	 GMT offset value (–12:00 to 14:00) representing hours and minutes 		
						      (HH:MM) local time is offset from GMT time 
X% = On/Off status		  0=off/disable 
					     1=on/enable 
X1@ = Unit name			   Alpha-numeric up to 24 characters. No special characters except hyphen 
(-) 
					     No upper/lower case distinction, no blanks or spaces, first character must 
be 
					     alpha, last character cannot be hyphen. 
X1# = Local date/time		  Set: MM/DD/YY-HH:MM:SS 
					     Read: day of week, date, month, year HH:MM:SS (for instance; Fri, 21 Jun 
2002 10:54:00) 
X1$ = IP Address			  default 192.168.254.254 
X1* = Hardware MAC address	 00-05-A6-xx-xx-xx 
X1( = Subnet mask		  Default 255.255.0.0 
X2@ = Verbose/Response mode	 0=clear (default for IP), 1=verbose (default for serial and USB), 2=tagged 
responses, 						      3=verbose + tagged responses 
X3$ = Daylight Saving time		  0=off/ignore;  
					     1= USA (begins first Sunday in April/ends last Sunday in October);  
					     2= Europe (begins last Sunday in March/ends last Sunday in October); 
					     3= Brazil (begins third Sunday in October/ends third Saturday in March). 
X4( = Alpha-numeric unit name	 combination of unit name and last three pairs of MAC address
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Command/Response Table for Basic SIS Commands (continued)

Command ASCII command
(host to device)

Response
(device to host)

Additional 
description

Password and Security Settings

Set administrator password E X3#CA} Ipa•X4!]
View administrator 
password

ECA} X4!]

Reset (clear) administrator 
password

E•CA} Ipa•]

Set user password E X3#CU} Ipu•X4!]
View user password ECU} X4!]
Reset (clear) user password E•CU} Ipu•]
Query session security level ECK} X5@]

Ethernet data port

Set current port timeout E0*X6(TC} Pti0*X6(]
View current port timeout E0TC} X6(]
Set global IP port timeout E1*X6(TC} Pti1*X6(]
View global IP port timeout E1TC} X6(]

File Commands

Erase user-supplied web 
page file

EfilenameEF} Del•filename]

Erase current directory E/EF } Ddl] Also deletes files inside 
directory

Erase current directory and 
sub-directories

E //EF } Ddl] filename x•date/time•length

List files from current 
directory

E DF } filename x•date/time•length] 

filename x•date/time•length] 

filename x•date/time•length] 

... space_remaining•Bytes Left]]

List files from current 
directory and below

E LF } filename x•date/time•length] 

filename x•date/time•length] 

filename x•date/time•length] 

... space_remaining•Bytes Left]]

NOTE:	 LF has same response from unit as DF command, except path / directory will precede filenames for files from 
directories below current directory. 

NOTES:	 X3# = 12 alpha-numeric characters	  
X4! = alpha-numeric password	 If a password exists, returns four **** to mask password 
X5@ = Security level of connection	 0=anonymous, 11=user, 12=administrator 
X6( = IP connection timeout	 1-65000 steps, (1 step=10 seconds)
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Command/Response Table for Basic SIS Commands (continued)
Command ASCII command

(host to device)
Response
(device to host)

Additional 
description

Serial Port

Send Data String EX!*X1&*X2)*X2!RS}X@ response]
Configure parameters EX!*X2%,X2^,X2&,X2*CP} CpnX!•CcpX2%,X2^,X2&,X2*]
View serial port parameters EX!CP} X2%,X2^,X2&,X2*]
Configure rcv timeout EX!*X1&*X2)*X2#*X2! CE} CpnX!•CceX1&, 

X2),X2#,X2!]
View receive timeout EX!CE} X1&,X2),X2#,X2!]

NOTES:	 X! = Port Number		  01-99 represented by 2 Bytes (ASCII).  
X@ = Command data section	 NOTE: 	 For web encoding only: Data will be directed to specified port and 
must  
					     be encoded if non-alpha numeric. Since data can include either command 		
					     terminator, they must be encoded as follows when used within the data section:  	
					     Space (Hex: 20) would be encoded as %20 and Plus sign (Hex: 2B)  
					     would be encoded as %2B 
X1& = Command string wait time	 0-32767 in tens of milliseconds 
X2) = Character wait time		  0-32767 in tens of milliseconds 
X2! = Length of stream or delimiter	 L=Byte Count (00 – 32767), D=decimal value for ASCII character  
					     (0-00255) 
X2# = Priority status for receiving timeouts (Default=0) 
					     0=Send data string command parameters if they exist 
					     1=Configure receive timeout command parameters instead. 
X2% = Baud Rate (Default=9600)	 300,600,1200,1800,2400,3600,4800,7200,9600,14400,19200 
					     38400,57600,115200 
X2^ = Parity (Default=N=none)	 O=odd 
					     E=even 
					     N=none 
					     M=mark 
					     S=space 
X2& = Data bits 			   (Default=8)	 7, 8 
X2* = Stop bits 			   (Default=1)	 1,2

Command ASCII command
(host to device)

Response
(device to host)

Additional 
description

Event Control

Read event buffer memory EX3%,X3^,X3&,X3*E } X5$]
Write event buffer memory EX3%,X3^,X3(,X3*E } Evt X3%,X3^,X3&,X3(]
NOTE:	 Response to Write Event is padded with leading zeros for X3% and X3&.
Read string from event 
buffer

EX3%,X3^,X3&,X4$FE} {string}]

Write string to event buffer E{string}*X3%,X3^,X3&FE} Evt X3%,X3^,X3&, {string}]
NOTE:	 ‘F’ must be capitalized to read and write strings to event buffer memory. 

Response to Write Event is padded with leading zeros for X3% and X3&.
Start events E 1AE } Ego]
Stop events E 0AE } Est]
Query # of running events E AE } #####] (5 digit number)

NOTES:	 X3% = Event number		  range 00-99 
X3^ = Event buffer		  0=receive 	 1=Unified 
					     2=data		  3=NVRAM 
X3& = Event buffer offset		  range 0 to Max buffer size 
X3* = Event data size (case sensitive)	 b=bit, B=Byte (8-bit), S=short (16-bit), L=long (32-bit) 
X3( = Event data to write	      
X4$ = number of Bytes to read	 range 1–127 
X5$ = Data element read		  ASCII digit(s) representing numeric value of data elements read from buffer 
					     (leading zeros suppressed)
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Command/Response Table for Basic SIS Commands (continued)

Command ASCII command
(host to device)

Response
(device to host)

Additional 
description

Presets, I/O Names
Write preset name EX1),X1!NG} NmgX1),X1!]

Example: E1,Security 1NG} Nmg01,Security 1] Name preset 1 “Security 1”.

Read preset name EX1)NG} X1!]
Example: E2NG} Security 2]

Recall a preset X1). RprX1)] Command character is a 
period

Example 5. RprX1)] Recall preset 5, which 
becomes the current 
configuration.

Write input name EX#,X1!NI} NmiX#,X1!]
Example: E9,Podium 

cam1NI}
Nmi09,Podium 
cam]

Name input 9 “Podium cam”.

Read input name EX#NI} X1!]
Write output name EX@,X1!NO} NmoX@,X1!]

Example: E1,Main PJ1NO} Nmo01,Main PJ1] Name output 1 “Main PJ1”.

Read output name EX@NO} X1!]

Resets
Reset presets and names EZG} Zpg] Clear all presets and their 

names.
Reset an individual preset EX1)ZG} ZpgX1)] Clear preset X1).
Reset a group EZX2)GRPM} GrpmZ X2)] Delete all members from 

group X2), reset parameters 
and soft limits.

NOTE:	 See Group Masters, for more information about audio group masters.
Reset flash EZFFF} Zpf] Reset flash memory 

(erase user-supplied files).
System Reset (factory 
defaults)

EZXXX} Zpx] Resets all processors, level 
controls and mixers to default.

Reset all device settings 
and delete files

EZY} Zpy]

NOTE:	 This reset excludes IP settings such as IP address, subnet mask, gateway IP address, unit name, DHCP setting and 
port mapping (telnet/web/direct access) in order to preserve communication with the device.  
This reset is recommended after a firmware update.

Absolute reset EZQQQ} Zpq] Similar to System Reset, 
plus sets the IP address to 
192.168.254.254 and the 
subnet mask to 255.255.0.0.

NOTES:	   X# = Input number		  01 – 12 
  X@ = Output number		  01 – 08  
X1) = Preset #			   32 maximum (0 = current configuration) 
X1! = Name			   12 characters maximum 
X2) = Group master group number	 01 – 32
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DSP SIS Commands
Many digital signal processor (DSP) functions; gain, mute, group masters, and a protected 
configuration can be controlled using SIS commands. These commands follow the same 
general rules as basic SIS commands, but the variables (X/) tend to be more complex. 
Also, an understanding of the audio signal flow is helpful to understanding the commands. 
Figure 66 shows the specific DSP functions available for SIS commands. 

NOTE:	 Signal flow is described in greater detail in the section, 
“Audio level, mix‑point, processing blocks, and signal chains” on page 28.

ca b ed

Figure 66.	 DSP Processors Addressable via SIS Commands

a	 Mic/line input gain block (including gain and mute)

b	 Pre-mixer gain block (including gain and mute)

c	 Virtual return gain

d	 Post-mixer trim (gain only)

e	 Output Volume (including gain and mute)
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Symbol Definitions

] = CR/LF (carriage return/line feed) (hex 0D 0A)

} = Carriage return (no line feed, hex 0D)  
(use the pipe character, | , for Web browser commands))

• = Space character

| = Pipe (vertical bar) character

E = Escape key (hex 1B)  (use W instead of Esc for Web browsers)

X6) = Gain and trim control See the table on page 130.

X6! = Level value; 

post-mixer trim (d)
mic/line gain (a)
pre-mixer gain (b),  virtual return gain 
(c), and output volume(e)

See the table beginning on page 132.

-12 dB to + 12 dB, (-120 to 120) in 0.1 dB increments. 

–18.0 dB to +80 dB, (1868 to 2848 ) in 0.1 dB increments.

–100.0 dB to +12.0 dB, (1048 to 2168) in 0.1 dB increments.
NOTE:	 Output volume only, –100.0 dB to +0.0 dB (1048 to 2048).

X6$ = Mute status 0 = unmute 
1 = mute

X6% = Group master group number 01 – 32 

X6^ = Group fader setting dB value, in 0.1 dB increments using negative numbers but not decimal places. 
The valid range depends on the type of gain block that is assigned to the group 
number (X6%) specified in the command: 
a = –180 to 800  (–18.0 dB to +80.0 dB) 
b = –1000 to 120  (–100.0 dB to +12.0 dB) 
c = –1000 to 120  (-100.0 dB to + 12.0 dB) 
d = –120 to 120  (–12.0 dB to +12.0 dB) 
e = –1000 to 000  (–100.0 dB to +0.0 dB)

NOTE:	 Leading zeros are ignored.

X6& = Group fader increment dB value, in 0.1 dB increments, to raise or lower a group fader

X6* = Group fader soft limit dB value, in 0.1 dB increments. The valid range X6^ must be within the range 
for the gain block grouped in X6%.

X6( = Group type 6= gain 
12 = mute

X7) = Personal Identification Number (PIN) Four numeric digits, default = 0000
X7! = Protected configuration status 0 = no protected configuration saved 

1 = protected configuration saved

Special Characters
The HTML language reserves certain characters for specific functions. The device will 
not accept these characters as part of preset names, the device’s name, passwords, or 
locally created file names.

The DMP 128 rejects the following characters: 
{space (spaces are OK for names)}  + ~ , @ = ‘ [ ] { } < > ’ “ ; : > \ ?
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Command/Response Table for DSP SIS Commands

Command ASCII command
(host to device)

Response
(device to host)

Additional 
description

Audio level control, and mix‑point selection

NOTES:	 The command format is the same, regardless of the control to be set; the acceptable adjustment range varies 
depending on the control or mix‑point:

	 • The mic/line input gain range is –18 dB to +80 dB, in 0.1 dB increments. 
• The pre-mixer gain and virtual return gain range is –100 dB to +12 dB, in 0.1 dB increments. 
• The post-mixer trim range is –12 dB to +12 dB, in 0.1 dB increments. 
• The output volume range is –100 dB to 0 dB, in 0.1 dB increments.

	 All responses are shown with the DMP 128 in Verbose mode 2 or 3.

Set a trim or gain (excluding 
mic/line inputs)

EGX6)*X6!AU} DsGX6)*X6!] Set trim or mix control X6) to 
a value of X6! dB.

Example 1 (pre-mixer 
gain):

EG40105*2040AU} DsG40105*2040] Set the #6 pre-mixer gain to a 
value of -0.8 dB.

Set a mic/line gain EGX6)*X6!AU} DsGX6)*X6!] Set mic/line gain control X6) 
to a value of X6! dB.

Example: EG40001*2288AU} DsG40001*2288] Set the mic/line input 2 gain 
to a level of +24.0 dB.

Read a trim 
(excluding mic/line inputs)

EGX6)AU} DsGX6)*X6!] DSP trim or mix control X6) is 
set to a value of X6! dB.

Example  
(post mixer gain control):

EG60101AU} DsG60101*2103] Output 2, post mixer trim is 
set to a value of +5.5 dB.

Read a mic/line gain EGX6)AU} DsGX6)*X6!] Mic/line gain control X6) is 
set to a value of X6! dB.

Example: EG40000AU} DsG40000*2598] Mic/line input 1 gain is set to a 
value of +55.0 dB.

Audio mute

NOTES:	 •	The post-mixer trim cannot be muted.
•	All responses are shown with the mixer device in Verbose mode 2 or 3.

Audio mute EMX6)*1AU} DsMX6)*1] Mute audio point X6).
Example: EM20301*1AU} DsM20301*1] Mute mix‑point input 4 to 

output 2.
Audio unmute EMX6)*0AU} DsMX6)*0] Unmute audio point X6).
Read audio mute or level EMX6)AU} DsMX6)*X6$] X6$: 0 = mute off, 1 = mute 

on.

NOTES: X6) = Gain and trim control See table 1 on page 130.

X6! = Level value: post-mixer trim, mic/line gain, pre‑mixer 
gain, virtual return gain, and output volume

See table 2 beginning on page 132.

X6$ = Mute status 0 = unmute 1 = mute
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Command/Response Table for DSP SIS Commands (continued)

Command ASCII command
(host to device)

Response
(device to host)

Additional 
description

Audio group master commands

NOTES:	 •	See Group Masters, for more information about audio group masters.

•	A group must have assigned members for these commands to have an effect.

•	For X6^, a positive (+) value is assumed unless a negative (-) value is specified.

•	 If entering a X6^ value outside the valid range for the group or outside the soft limits, the DMP 128 
responds with an “invalid parameter” (E13) error.

•	X6^, X6&, and X6* values can be sent without leading zeroes; responses are always 5 digits.

Set a group fader control EDX6%*X6^GRPM} GrpmDX6%*X6^] Set the group fader to a value 
of X6^.

Example: Ed2*-293*GRPM} GrpmD02*-00293] Set the group 2 fader control 
to -29.3 dB.

Raise a group fader control EDX6%*X6&+GRPM} GrpmDX6%*X6^] Increase the level of the X6% 
group fader by X6& dB.

Example Ed2*30+GRPM} GrpmD02*-00263] Raise the group 2 fader 3 dB 
(from -29.3 dB to -26.3 dB, 
starting from the level set 
in the “Set a group fader 
control” example, above.

Lower a group fader control EDX6%*X6&-GRPM} GrpmDX6%*X6^] Decrease the level of the X6% 
group fader by X6& dB.

View the group fader control 
level

EDX6%GRPM} GrpmDX6%*X6^] In verbose modes 1 and 2, the 
response is simplified to 
X6^].

Mute a group mute control EDX6%*1GRPM} GrpmDX6%*+00001] Mute all blocks in group X6%.
Clear (unmute) a group 
mute control

EDX6%*0GRPM} GrpmDX6%*+00000] Umute all blocks in group 
X6%.

View a group mute control EDX6%GRPM} GrpmDX6%*X6$] For group masters, X6$ 
is always expressed as a 
positive or negative 5-digit 
value.

Set soft limits ELX6%*X6*upper*X6*lowerGRPM} Set the groups soft limits to 
X6* and X6*.GrpmLX6%*X6**X6*]

Example: EL2*+60*-60GRPM} GrpmL02*+00060*-00060] Set the upper soft limit for the 
group 2 fader to +6.0 dB and 
the lower limit to -6.0 dB.

View soft limits ELX6%GRPM} GrpmLX6%*X6**X6*] In verbose modes 0 and 1, 
the response is simplified to 
X6**X6*].

View group type EPX6%GRPM} GrpmPX6%*X6(] Show the group type (X6() 
for group X6%. In verbose 
modes 0 and 1, the response 
is simplified to X6(].

View group members EOX6%GRPM} GrpmOX6%*X6)1*X6)2* 
...*X6)16]

X6) is the control or mix-point. 
In verbose modes 0 and 1, 
the response is simplified to 
X6)1*X6)2*...*X6)16].

NOTE:	 X6% = Group master group number		  01 - 32 
X6^ = Group fader level			   dB value, in 0.1 dB increments, using negative numbers but not 
						      decimal places. –100.0 dB to +80.0 dB is represented by –1000 to 800. 
						      The valid range depends on the type of gain or trim block assigned 
						      to the group number (X6%). 
X6& = Group fader increase/decrease		  dB value, in 0.1 dB increments, to raise or lower a group fader. 
X6* = Group fader soft limit			  dB value, in 0.1 dB increments. The valid range must be within the 
						      range for the gain block grouped in X6%. 
X6( = Group type			     6 = gain 
						      12 = mute
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Command ASCII command
(host to device)

Response
(device to host)

Additional description

Protected configuration

NOTE:	 The DMP 128 can save and recall a Personal Identification Number (PIN)-protected configuration, including 
mic mixes, parameters, variables, and values (with the exception of the device’s IP address). The protected 
configuration is useful to establish the DMP 128 in a known state, either as a troubleshooting tool or as a 
baseline configuration.

Save the configuration E S X7) PCFG} PcfgS] Save the configuration to the 
protected memory location.

Recall the configuration E RPCFG} PcfgR] Recall the protected configuration

Change the PIN E P X7)old*X7)
newPCFG}

PcfgP X7)new] Overwrite the old PIN  
(X7)old) with the new one (X7)new).

Query configuration saved 
status

E QPCFG} X7!]

NOTES:	 X7) = Personal Identification Number (PIN)	 Four numeric digits, default = 0000 
X7! = Protected configuration status		  0 = no protected configuration saved 
						      1 = protected configuration saved

 

Command/Response Table for DSP SIS Commands (continued)
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Table 1:  Level Control

a Input Gain control X6) Level b Pre-mixer gain X6) Level

Mic/Line Input 1 40000 X6! Mic/Line Input 1 40100 X6!
Mic/Line Input 2 40001 X6! Mic/Line Input 2 40101 X6!
Mic/Line Input 3 40002 X6! Mic/Line Input 3 40102 X6!
Mic/Line Input 4 40003 X6! Mic/Line Input 4 40103 X6!
Mic/Line Input 5 40004 X6! Mic/Line Input 5 40104 X6!
Mic/Line Input 6 40005 X6! Mic/Line Input 6 40105 X6!
Mic/Line Input 7 40006 X6! Mic/Line Input 7 40106 X6!
Mic/Line Input 8 40007 X6! Mic/Line Input 8 40107 X6!
Mic/Line Input 9 40008 X6! Mic/Line Input 9 40108 X6!
Mic/Line Input 10 40009 X6! Mic/Line Input 10 40109 X6!
Mic/Line Input 11 40010 X6! Mic/Line Input 11 40110 X6!
Mic/Line Input 12 40011 X6! Mic/Line Input 12 40111 X6!

d Post-mixer trim X6)  Level e Volume Out Control X6)  Level

Output 1 60100 X6! Output 1 60000 X6!
Output 2 60101 X6! Output 2 60001 X6!
Output 3 60102 X6! Output 3 60002 X6!
Output 4 60103 X6! Output 4 60003 X6!
Output 5 60104 X6! Output 5 60004 X6!
Output 6 60105 X6! Output 6 60005 X6!
Output 7 60106 X6! Output 7 60006 X6!
Output 8 60107 X6! Output 8 60007 X6!

c Virtual Return Gain X6) Level

Virtual Return A 50000 X6!
Virtual Return B 50001 X6!
Virtual Return C 50002 X6!
Virtual Return D 50003 X6!
Virtual Return E 50004 X6!
Virtual Return F 50005 X6!
Virtual Return G 50006 X6!
Virtual Return H 50007 X6!
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Setting Audio Levels
The audio conversions in table 2 are the same for all signal level blocks. However, the 
minimum and maximum levels differ depending upon the individual level control. The 
following table can be used to determine those minimum and maximum levels for the 
individual controls. Once they are known, Table 2 can be used to find the SIS value for the 
desired dB level within that range.

SIS Title Function Range

X6! Mic/line gain (a) Attenuation/Gain –18.0 to +80.0 dB

Pre-mixer gain (b) Attenuation/Gain –100.0 to +12.0 dB

Virtual return gain (c) Attenuation/Gain –100.0 to +12.0 dB

Post-mixer trim (d) Attenuation/Gain –12.0 to +12.0 dB

Output volume (e) Attenuation –100.0 to +0.0 dB
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HTML Operation

This section describes HTML operation and control of the DMP 128, including:

•	 Download the Startup Page

•	 Status Tab

•	 Configuration Tab

•	 File Management Tab

•	 Special Characters

The DMP 128 can be controlled and operated through its Ethernet port, connected via a 
LAN or WAN, using a web browser such as the Microsoft® Internet Explorer. The browser 
display of device status or operation has the appearance of web pages. This chapter 
describes the factory-installed HTML pages, which are always available and cannot be 
erased or overwritten.

NOTE:	 If the Ethernet connection to the device is unstable, try turning off the proxy 
server in the Web browser. In Microsoft Internet Explorer, click  
Tools > Internet Options > Connections > LAN Settings, uncheck the "Use 
a proxy server..." box, and then click OK.

Download the Startup Page
Access the device using HTML pages as follows:

1.	 Start the Web browser program.

2.	 Click in the browser Address field.

3.	 Enter the device IP address directly into the address field.

NOTE:	 If the local system administrators have not changed the value, the 
factory‑specified default IP address is 192.168.254.254.

4.	 If a custom display page is available, enter a slash (/) and the file name to open.

NOTE:	 The browser address field should display the address in the following 
format: xxx.xxx.xxx.xxx/{optional_file_name.HTML}. The following 
characters are invalid in file names: 
{space}  + ~ , @ = ‘ [ ] { } < > ’ " ; : > \ ?
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5.	 Press the keyboard <enter> key. The device checks to see if it is password 
protected.

a.	 If the device is not password protected, it checks and downloads the HTML 
pages (proceed to step 7).

b.	 If the device is password protected, the device downloads the Connect To page 
(see figure 67).

Figure 67.	 Connect To Page

6.	 Click in the Password field and type in the appropriate administrator or user 
password. Click the OK button.

NOTE:	 A User Name entry is not required.

7.	 The device checks several possibilities, in the following order, and then responds 
accordingly:

a.	 Does the address include a specific file name, such as 10.13.156.10/file_
name.HTML?  If true, the device downloads that HTML page.

b.	 Is there a file in the device memory named "index.HTML"? 
If true, the device downloads "index.HTML" as the default startup page.

c.	 If neither of the above conditions is true, the device downloads 
the factory‑installed default startup page, "nortxe_index.HTML" (see 
figure 68 on the next page), also known as the System Status page.
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Status Tab

System Status Page
The System Status page (see figure 68) provides an overall view of the status of the 
device, including system information, power supply status, and serial port settings. The 
System Status page is the default page when establishing a connection to the device. 
Access the System Status page from other pages by clicking the Status tab.

Figure 68.	 System Status Page
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Configuration Tab

System Settings Page
Click the Configuration tab to download the System Settings page (see figure 69). 
The screen consists of fields to view and edit IP administration and system settings. 
Passwords and Firmware Upgrade pages are accessed by clicking the appropriate link 
on the left. See “Ethernet (LAN) Port” on page 114, for basic information about IP 
addresses and subnetting.

Figure 69.	 System Settings Page

On password-protected connections, there are two levels of protection: administrator and 
user. Administrators have full access to the Passwords and Firmware Upgrades pages. 
Users have view only access.

•	 Ethernet connection to the device, either entering SIS commands  
(see “SIS Programming and Control” on page 113) or using the Extron 
DSP Configurator Program, (see “DSP Configurator Program Basics” on 
page 18), is password protected.

•	 Connection via any RS-232 port is not password protected.

IP Settings Fields

The IP settings fields provide a location for viewing and editing settings unique to the 
Ethernet interface. After editing any of the settings on this page, click the Submit button 
at the bottom of the section.

Unit Name Field

The unit name field contains the name of the device. This name field can be changed to 
any valid name, up to 24 alphanumeric characters.

NOTE:	 The following characters are invalid in the matrix name: 
+  ~  ,  @  =  ‘  [  ]  {  }  <  >  ’  "  ;  :  >  \  and ?.

DHCP Radio Buttons

The DHCP On radio button directs the device to ignore any entered IP addresses and to 
obtain its IP address from a Dynamic Host Configuration Protocol (DHCP) server (if the 
network is DHCP capable). The DHCP Off radio button turns DHCP off. Contact the local 
system administrator for additional information on your network.
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IP Address Field

The IP address field contains the IP address encoded in the flash memory of the 
connected device. 

Valid IP addresses consist of four 1-, 2-, or 3-digit numeric subfields separated by dots 
(periods). Each field can be numbered from 000 through 255. Leading zeroes, up to 
3 digits total per field, are optional. Values of 256 and above are invalid.

The factory-installed default address is 192.168.254.254, but if this conflicts with other 
equipment at the installation site, change the IP address to any valid value.

NOTE:	 IP address changes can cause conflicts with other equipment. Only local 
system administrators should change IP addresses.

Gateway IP Address Field

The Gateway IP Address field identifies the address of the gateway to the mail server to 
be used if the device and the mail server are not on the same subnet.

The gateway IP address has the same validity rules as the system IP address.

Subnet Mask Field

The Subnet Mask field is used to determine whether the device is on the same subnet as 
the mail server when you are subnetting. 

MAC Address Field

The Media Access Control (MAC) address is hardcoded in the device and cannot be 
changed.

Firmware Field

The firmware field displays the current firmware version being used by the device.

Model Field

The model field displays the Extron model number of the device.

Part Number Field

The part number field displays the Extron Electronics part number of the device.
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Date/Time Settings Fields

The Date/Time settings fields (see figure 70) provide a location for viewing and setting the 
time functions.

Figure 70.	 Date/Time Settings Fields

Change the date and time settings as follows:

1.	 Click the desired variable box. Adjustable settings include month, day, year, hours, 
minutes, AM/PM, and (time) zone. A drop-down list box appears (the year drop box is 
shown selected in figure 70).

2.	 If all variable selections are not visible, click and drag the slider or click the scroll up  
button or scroll down  button until the desired variable is visible.

3.	 Click the desired variable.

NOTE:	 When setting the time, set the local time. The Zone variable allows you 
to then select the offset from Greenwich Mean Time (GMT). 

	 The Zone field identifies the standard time zone selected and displays 
the amount of time, in hours and minutes, the local time varies from GMT 
international time reference.

4.	 Repeat steps 1 through 3 for other variables that need to be changed.

5.	 If appropriate, click in the Daylight Savings radio button to turn on the daylight 
savings time feature.

NOTE:	 When Daylight Saving Time is on, the device automatically updates its 
internal clock between Standard Time and Daylight Saving Time in the spring 
and fall on the date the time change occurs in the country or region selected. 
When Daylight Saving Time is turned off, the device does not adjust its time 
reference.

6.	 Click the Submit button.
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Passwords Page
Access the passwords page (see figure 71) by clicking the Passwords link on the system 
settings page.

Figure 71.	 Passwords Page

The fields on the passwords page are for entering and verifying administrator and user 
passwords. Passwords are case sensitive and are limited to 12 upper case and lower 
case alphanumeric characters. Each password must be entered twice; once in the 
password field and then again in the Re-enter Password field. Characters in these fields 
are masked by asterisks (*****). If password protection is not desired, leave the password 
field and the Re-Enter password field blank. After entering the desired password in both 
fields, click the Submit button.

NOTE:	 An administrator password must be created before a user password can be 
created.

Change a Password

To change a password, type the new password in the password and re-enter password 
fields and click the Submit button.

Clear a Password

To clear an existing password so that no password is required, enter a single space in the 
password and re-enter password fields and click the Submit button.
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Firmware Upgrade Page
The Firmware Upgrade page provides a way to verify the current firmware version and 
to replace the firmware without taking the device out of service. Access the Firmware 
Upgrade page (see figure 72) by clicking the Firmware Upgrade link on the System 
Configuration page.

The current firmware version is displayed above the upload box for reference.

Figure 72.	 Firmware Upgrade Page

Update the device firmware as follows:

NOTE:	 The Firmware Upgrade page is only for replacing the firmware that controls 
device operation. To insert custom HTML pages, see “File Management Page” 
on page 148.
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1.	 Visit the Extron Web site, www.extron.com, and click the Download Center tab.

2.	 Click the Firmware link (see figure 73 below).

3.	 Select the appropriate firmware file to download and click Download.

4.	 Enter the requested information.

5.	 Click Download to copy the firmware to your computer.

2

1

5

4

3

NOTE: The version, release date,
 and size shown are example
 values only.

Download DMP128_FW1x02.exe

DMP 128 Digital Matrix Processor
Firmware for DMP 128

19-2247-50       V1.02 August 10, 2012 2.4 MB  

DMP 128 FW1x02.exe

Download

Firmware

Figure 73.	 Location of Firmware Upgrade Files on the Web Site
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1.	 Select Run twice (f in figure 74). The PC downloads the firmware update from the 
Extron Web site and starts the installation program to extract the firmware file.

Folder where
firmware is
installed

NOTE: The version shown is 
a sample value only.

Name:  DMP128_FW1x01.exe

Type:  Application, 2.26 MB

From:  www.extron.com

Name:  FirmwareInstall-DMP128_Upgrade

Publisher:  Extron Electronics

6

6

7

8

Welcome to the Extron Installation Program for
the DMP128 Firmware Upgrade v1.01

The Extron Installation Program will install the updated
�rmware on your computer.  To continue, click Next.

The InstallShield Wizard has successfully installed the

Firmware Update.  The release notes can be found at

C:\Program Files\Extron\Firmware\DMP 128\v1.01

Figure 74.	 Downloading Firmware Upgrade Files
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2.	 Click Next (g in figure 74 on the previous page). The program extracts and places the 
firmware files in a folder identified in the InstallShield Wizard dialog box.

NOTE:	 Write down the folder where the firmware file is saved.

3.	 Click Finish (h in figure 74) to exit the program.

4.	 Connect the PC to the device via the Ethernet port.

5.	 Access the device using the HTML pages (see “Download the Startup Page” on 
page 137).

6.	 Click the Configuration tab.

7.	 Click the Firmware Upgrade link.

8.	 Click the Browse button. An open file dialog box appears.

9.	 Navigate to the folder where the firmware upgrade file was saved. Select the file.

NOTE:	 Valid firmware files must have the file extension ‘.S19’. Any other file 
extension is not a firmware upgrade. The original factory-installed firmware is 
permanently available on the device. If the attempted firmware upload fails for 
any reason, the device automatically reverts to the factory-installed firmware.

10.	Click the Open button.

11.	Click the Upload button. The firmware upload to the device may take a few minutes.

 

DMP 128 • HTML Operation 147



File Management Tab

File Management Page
To delete files such as HTML pages from the connected device or to upload custom files 
to the device, click the File Management tab. The device downloads the file management 
HTML page (see figure 75).

Figure 75.	 File Management Page

NOTE:	 The files listed in figure 75 are shown for example only.

To delete a file, click the Delete button at the right of that file.

Upload your own files as follows:

NOTE:	 The following characters are invalid in file names: 
{space}  +  ~  ,  @  =  ‘  [  ]  {  }  <  >  ’  "  ;  :  >  \  ?

1.	 Click the Browse button.

2.	 Browse through the system and select the desired file(s).

NOTE:	 If you want one of the pages that you create and upload to be the 
default startup page, name that file "index.HTML".

3.	 Click the Upload File button. The selected file(s) appear in the list.

Special Characters
The HTML language reserves certain characters for specific functions. The device will not 
accept these characters as part of preset names, the name of the device, passwords, or 
locally created file names.

The device rejects the following characters: 
{space}  +  ~  ,  @  =  ‘  [  ]  {  }  <  >  ’  “  ;  :  >  \  ?
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Reference 
Information

This section contains reference information for the DMP 128, including:

•	 Part Numbers and Accessories

•	 Firmware Loader

•	 Hardware Reset Modes

•	 Mounting the DMP 128

Part Numbers and Accessories

Included Parts
These items are included in each DMP 128 order:

Included parts Part number

DMP 128 Digital Matrix Processor 
DMP 128 C

60–1211-01 
60–1178-01

DSP Configurator Control Software (DVD) 79-530-01

3.5 mm, 3-pole captive screw connectors w/strain relief 
(21)

10-703–11LF

3.5 mm, 5-pole captive screw connectors (4) 10-703–12LF

Rack Ears 990681-1

Power Cord 10 A/125 VAC, 7.5’ 

Male to Male RJ-45 Cat 6e cable, 1’ (1)

Rubber Feet (4)

Nylon tie wraps (25)

Tweeker

DMP 128 Set up Guide
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Accessories
These items can be ordered separately:

Adapters, rack mounts Part number

USB A Male to USB Mini B Male Configuration Cable 26-654-06

CSR 6, Captive Screw to RCA Female Audio Adapter 26-575-01

MBU 149 1U Full Rack Low Profile Mount Kit 70-222-01

MBD 149, Through-Desk Mount Kit 70-077-03

RSB 129, Basic Rack Shelf Kit for 9.5” deep products 60-604-02

RSU 129, Universal Rack Shelf Kit for 9.5” deep 
products

60-190-01
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3.	 From the toolbar, select File > Open.

4.	 Locate the downloaded firmware file and click on it.

5.	 Click Begin on the main screen. The total progress bar tracks the 
loading progress.

6.	 When the upload is finished, exit the program by selecting 
File>Exit.

The firmware upload is complete.

Firmware Loader
The DSP Configurator program includes a firmware 
loader program which allows replacing the firmware 
without taking the DMP 128 out of service. 
Download the desired firmware file from the Extron 
website, (see “Firmware Upgrade Page” on 
page 144).

To access the firmware loader:

1.	 From the DSP Configurator toolbar, select Tools, 
then Firmware Loader.

2.	 The Add Device dialog box appears. Type the IP 
address of the DMP 128, then press OK.

NOTE:	 If the IP has not been changed, the 
default IP address is: 192.168.255.255

The Firmware Loader screen appears. 
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DMP 128 Hardware Reset Modes
DMP 128 Reset Mode Summary

Mode Mode Activation Result Purpose/Notes

U
se

 F
ac

to
ry

 F
ir

m
w

ar
e

1 Hold the reset button while applying 
power.

NOTE:	 After a mode 1 reset, update the 
DMP 128 firmware to the latest version. 
DO NOT operate the firmware version that 
results from this mode reset.

The DMP 128 reverts to the factory 
default firmware.

Event scripting does not start if 
the DMP 128 is powered on in this 
mode. All user files and settings 
(drivers, IP settings, and similar 
items) are maintained.

NOTE:	 If you do not want to update the 
firmware or perform a mode 1 reset by 
mistake, cycle power to the DMP 128 to 
return to the firmware version running prior 
to the reset.

This mode reverts to the 
factory default firmware 
version if incompatibility 
issues arise with user-
loaded firmware.

NOTE:	 User-defined Web pages 
may not work correctly if using 
an earlier firmware version.

R
un

/S
to

p
 

E
ve

nt
s

3 With power on, press and hold the 
Reset button until the Power LED 
blinks once (3 sec.), then release 
and within 1 second press Reset 
momentarily (<1 sec).

NOTE:	 The mode will not be entered unless 
the momentary press occurs within one 
second.

Mode 3 toggles events on or off. 
Front panel level indicators blink 
twice to indicate events has toggled 
on, or three times to indicate event 
logging has toggled off.

Useful for troubleshooting

R
es

et
 a

ll 
IP

 S
et

ti
ng

s

4 Press and hold the Reset button for 
about 6 sec. until the Power LED 
blinks twice (once at 3 sec., again 
at 6 sec.), then release and within 
1 second press Reset momentarily 
(< 1 sec.).

NOTE:	 The mode will not be entered unless 
the momentary press occurs within one 
second.

Mode 4:

•	 Enables ARP capability.

•	 Set the IP address to default.

•	 Sets the subnet to default.

•	 Sets the gateway address to 
default.

•	 Sets port mapping back to 
default.

•	 Turns DHCP off.

•	 Turns events off.

Enables resetting IP 
address information using 
ARP and MAC address.

R
es

et
 t

o
 

Fa
ct

o
ry

 D
ef

au
lt

s

5 Press and hold the Reset button for 
about 9 sec. until the Power LED 
blinks three times (once at 3 sec., 
again at 6 sec., again at 9 sec.), 
then release and within 1 second 
press Reset momentarily (< 1 sec.). 

NOTE:	 The mode will not be entered unless 
the momentary press occurs within one 
second.

Mode 5 performs a complete 
reset to factory defaults, except 
for firmware:

•	 Does everything mode 4 reset 
does.

•	 All mix‑points are muted and 
set to 0 dB.

•	 All outputs are unmuted and 
set to 0 dB.

•	 DSP Processing returned to 
defaults and bypassed.

•	 All inputs are muted and set to 
0 dB.

•	 All presets and group master 
memory cleared.

Useful to start over with 
configuration or uploading, 
and to replace events.
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Mounting the DMP 128
The 1U high, full rack width, 8.5 inch deep DMP 128 Digital Matrix Processor can be:

•	 Set on a table, 

•	 Mounted on a rack shelf, 

•	 Mounted under a desk or tabletop.

Tabletop Use
Each DMP 128 comes with rubber feet (not installed). For tabletop use, attach a 
self‑adhesive rubber foot to each corner of the bottom of the unit.

UL Rack Mounting Guidelines
The following Underwriters Laboratories (UL) guidelines pertain to the safe installation of 
the DMP 128 in a rack.

1.	 Elevated operating ambient temperature — If installed in a closed or multi-unit 
rack assembly, the operating ambient temperature of the rack environment may be 
greater than room ambient temperature. Therefore, install the unit in an environment 
compatible with the maximum ambient temperature (Tma = +122 °F, +50 °C) 
specified by Extron. 

2.	 Reduced air flow — Install the equipment in a rack so that the amount of air flow 
required for safe operation of the equipment is not compromised. 

3.	 Mechanical loading — Mount the equipment in the rack so that a hazardous 
condition is not achieved due to uneven mechanical loading.

4.	 Circuit overloading — Connect the equipment to the supply circuit and consider the 
effect that circuit overloading might have on overcurrent protection and supply wiring. 
Appropriate consideration of equipment nameplate ratings should be used when 
addressing this concern.

5.	 Reliable earthing (grounding) — Maintain reliable grounding of rack-mounted 
equipment. Pay particular attention to supply connections other than direct 
connections to the branch circuit (such as the use of power strips).  
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Rack Mounting
The DMP 128 is delivered with rack mounting brackets attached. For rack mounting, 
do not install the rubber feet. Use the rack ears to mount the DMP 128 in a standard 
equipment rack. The DMP 128 can be mounted on a 19" Universal 1U or Basic rack shelf 
(Extron RSU 129, part #60–190-01; or Extron RSB 129, part #60-604-02). 

To rack mount the DMP 128 on a rack shelf:

1.	 If rubber feet are installed on the bottom of the DMP 128, remove them.

2.	 Mount the DMP 128 on the rack shelf, using two 4-40 x 3/16 inch screws in opposite 
(diagonal) corners to secure the unit to the shelf. In a standard equipment rack, mount 
the DMP 128 using the installed rack mounting brackets.

MBU 149
Mounting Bracket

#8 Screw
(4) Places
Each Side

Supplied Rack Mounting Bracket

Mounting Screws
(2) Places
Each Side

or

Figure 76.	 Mounting the DMP 128 on a Universal Rack Shelf

3.	 Install blank panels or other units on the rack shelf.

Table or Wall Mounting
The table or wall mounting brackets extend approximately 1/4 inch (6.4 mm) above the 
top surface of the enclosure. This design allows for an air space between the enclosure 
and the surface to which it is mounted. 

Table or wall mount the DMP 128 as follows:

1.	 Remove the rack mounting brackets and attach the MBU 149 brackets in their place.

2.	 Hold the unit with the attached brackets against the underside of the table or other 
furniture, or against the wall. Mark the location of the screw holes of the bracket on 
the mounting surface.

3.	 Drill 3/32 inch (2 mm) diameter pilot holes, 1/4 inch (6.4 mm) deep in the mounting 
surface at the marked screw locations.

4.	 Insert #8 wood screws into the four pilot holes. Tighten each screw into the mounting 
surface until just less than 1/4 inch of the screw’s head protrudes.

5.	 Align the mounting screws with the slots in the brackets and place the unit against the 
surface, with the screws through the bracket slots.

6.	 Slide the unit slightly forward or back, then tighten all four screws to secure it in place.
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Extron Headquarters
+1.800.633.9876 (Inside USA/Canada Only)

Extron USA - West	 Extron USA - East 
+1.714.491.1500	 +1.919.850.1000 
+1.714.491.1517 FAX	 +1.919.850.1001 FAX

Extron Europe
+800.3987.6673 
(Inside Europe Only)

+31.33.453.4040	
+31.33.453.4050 FAX

Extron Asia
+800.7339.8766  
(Inside Asia Only)

+65.6383.4400
+65.6383.4664 FAX

Extron Japan
+81.3.3511.7655
+81.3.3511.7656 FAX

Extron China

+4000.398766  
Inside China Only

+86.21.3760.1568 
+86.21.3760.1566 FAX

Extron Middle East
+971.4.2991800
+971.4.2991880 FAX

Extron Korea
+82.2.3444.1571
+82.2.3444.1575 FAX

Extron India
1800.3070.3777 
Inside India Only

+91.80.3055.3777 
+91.80.3055.3737 FAX

© 2012 Extron Electronics   All rights reserved.   www.extron.com

Contact Information

Extron Warranty

Extron Electronics warrants this product against defects in materials and workmanship for a period of three years 
from the date of purchase. In the event of malfunction during the warranty period attributable directly to faulty 
workmanship and/or materials, Extron Electronics will, at its option, repair or replace said products or components, 
to whatever extent it shall deem necessary to restore said product to proper operating condition, provided that it is 
returned within the warranty period, with proof of purchase and description of malfunction to:

USA, Canada, South America, 
and Central America: 
Extron Electronics 
1001 East Ball Road 
Anaheim, CA 92805 
U.S.A.

 
Japan: 
Extron Electronics, Japan 
Kyodo Building, 16 Ichibancho 
Chiyoda-ku, Tokyo 102-0082 
Japan

Europe and Africa: 
Extron Europe 
Hanzeboulevard 10 
3825 PH Amersfoort 
The Netherlands

China: 
Extron China 
686 Ronghua Road 
Songjiang District 
Shanghai 201611 
China

Asia: 
Extron Asia 
135 Joo Seng Road, #04-01 
PM Industrial Bldg. 
Singapore 368363 
Singapore

Middle East: 
Extron Middle East 
Dubai Airport Free Zone 
F12, PO Box 293666 
United Arab Emirates, Dubai

This Limited Warranty does not apply if the fault has been caused by misuse, improper handling care, electrical 
or mechanical abuse, abnormal operating conditions, or if modifications were made to the product that were not 
authorized by Extron.

NOTE:	 If a product is defective, please call Extron and ask for an Application Engineer to receive an RA (Return 
Authorization) number. This will begin the repair process. 
 
USA:	 714.491.1500 or 800.633.9876		  Europe:	 31.33.453.4040  
Asia:	 65.6383.4400		  Japan:	 81.3.3511.7655 

Units must be returned insured, with shipping charges prepaid. If not insured, you assume the risk of loss or damage 
during shipment. Returned units must include the serial number and a description of the problem, as well as the 
name of the person to contact in case there are any questions. 

Extron Electronics makes no further warranties either expressed or implied with respect to the product and its quality, 
performance, merchantability, or fitness for any particular use. In no event will Extron Electronics be liable for direct, 
indirect, or consequential damages resulting from any defect in this product even if Extron Electronics has been 
advised of such damage.

Please note that laws vary from state to state and country to country, and that some provisions of this warranty may 
not apply to you.

http://www,extron.com
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